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1. Safety precautions

» Observe these precautions carefully to ensure safety.

» After reading this manual, pass the manual on to the end user to retain for future
reference.

» The user should keep this manual for future reference and refer to it as necessary. This
manual should be made available to those who repair or relocate the units. Make sure
that the manual is passed on to any future air conditioning system user.

: indicates a hazardous situation which, if not avoided, could result in
A WARNING death or serious injury.

: indicates a hazardous situation which, if not avoided, could result in
A CAUTION minor or moderate injury.
CAUTION : addresses practices not related to personal injury, such as product

and/or property damage.

1-1. General precautions

Do not install the controller in areas where large amounts of oil, steam, organic solvents,
or corrosive gases (such as ammonia, sulfuric compounds, or acids), or areas where
acidic/alkaline solutions or special chemical sprays are used frequently. These substances
may significantly reduce the performance and corrode the internal parts, resulting in
electric shock, malfunction, smoke, or fire.

To reduce the risk of short circuits, current leakage, electric shock, malfunction, smoke, or
fire, do not wash the controller with water or any other liquid.

To reduce the risk of electric shock, malfunction, smoke, or fire, do not touch the electrical
parts, USB memory, or touch panel with wet fingers.

To reduce the risk of injury or electric shock, before spraying a chemical around the
controller, stop the operation and cover the controller.

To reduce the risk of injury, keep children away while installing, inspecting, or repairing the
controller.

If you notice any abnormality (e.g., burning smell), stop the operation, turn off the
controller, and consult your dealer. Continuing the operation may result in electric shock,
malfunction, or fire.

Properly install all required covers to keep moisture and dust out of the controller. Dust
accumulation and the presence of water may result in electric shock, smoke, or fire.

To reduce the risk of fire or explosion, do not place flammable materials or use flammable
sprays around the controller.

To reduce the risk of electric shock or malfunction, do not touch the touch panel, switches,
or buttons with a sharp object.

To avoid injury from broken glass, do not apply excessive force to the glass parts.

To reduce the risk of injury, electric shock, or malfunction, avoid contact with the sharp
edges of certain parts.
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Consult your dealer for the proper disposal of the controller. Improper disposal will pose a
risk of environmental pollution.

1-2. Precautions for relocating or repairing the unit

The controller must be repaired or moved only by qualified personnel. Do not disassemble
or modify the controller. Improper installation or repair may result in injury, electric shock,
or fire.

1-3. Additional precautions

CAUTION

To avoid discoloration, do not use benzene, thinner, or chemical rag to clean the controller.
When the controller is heavily soiled, wipe the controller with a well-wrung cloth that has
been soaked in water with mild detergent, and then wipe off with a dry cloth.

This appliance is not intended for use by persons (including children) with reduced
physical, sensory or mental capabilities, or lack of experience and knowledge, unless they
have been given supervision or instruction concerning use of the appliance by a person
responsible for their safety. Children should be supervised to ensure that they do not play
with the appliance.
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2.

Introduction

AE-200A/AE-50A/AE-200E/AE-50E is a centralized controller.

EW-50A/EW-50E is an LCD-less total management system.

Any connected air conditioning systems can be operated or monitored on the AE-200A/AE-50A/AE-200E/AE-50E’s
LCD or the Web browser.

Each AE-200A/AE-50A/EW-50A/AE-200E/AE-50E/EW-50E can control up to a total of 50 indoor units and other
equipment. By connecting AE-200A/AE-200E (main controller) and AE-50A/AE-50E/EW-50A/EW-50E (sub
controllers), up to 200 indoor units and other equipment can be controlled.

Additionally, by integrating AE-200A/AE-50A/EW-50A/AE-200E/AE-50E/EW-50E using the Integrated Centralized
Control Web, up to 2,000 indoor units can be controlled.

Note: When connecting HWHP (QAHV) units or chiller units, the following restrictions must be observed.
* Count each HWHP (QAHV) unit as two air conditioning units, and make sure the number of units that are equivalent to the
number of air conditioning units will not exceed 50 units.
* When connecting chiller units and other units together, count each chiller unit as three air conditioning units, and make
sure the number of units that are equivalent to the number of air conditioning units will not exceed 50 units.
* When connecting chiller units only, up to 24 chiller units can be connected.

This manual explains methods for configuring the necessary initial settings for when using the Air Conditioning
Control System.
Flow of the initial settings and trial run are shown in section 2-2 “Flow of the initial settings and trial run”.

Note: Integrated centralized control software (PAC-TG2000A), Electric amount count software (PAC-YG11, 12, 13ATM), and PLC
software for demand input (PAC-YG41, 42, 43ATM, PAC-YG91, 92, 93ATM) were discontinued in 2016 and are currently
unavailable for purchase. PLC software for general equipment cannot be directly connected to AE-200A/AE-200E/AE-50A/
AE-50E/EW-50A/EW-50E.

The following restrictions apply to the naming settings, such as group name settings, where any characters can be
entered.

» Some characters may not be entered from the LCD.

Enter such characters from the Initial Setting Tool, and check that they are displayed on the LCD properly.

» The maximum number of characters entered from the LCD may be reduced depending on the characters used.
The maximum number of characters varies depending on the characters used on the Integrated Centralized
Control Web and the Initial Setting Tool.

Check that the characters you entered are displayed properly on the LCD or the Initial Setting Tool.

« If the characters entered on the Initial Setting Tool reach the maximum character limit, they may not be displayed
correctly depending on the characters used.

In such a case, reduce the number of characters entered to see if they are displayed on the screen properly.

2-1. Terms used in this manual

“Microsoft® Windows® 8.1” is referred to as “Windows 8.1”, “Microsoft® Windows® 10” is referred to as
“Windows 10”, and “Microsoft® Windows® 11” is referred to as “Windows 11”.

“Centralized Controller AE-200A/AE-200E/TE-200A” is referred to as “AE-200”.

“Centralized Controller AE-50A/AE-50E/TE-50A” is referred to as “AE-50".

“Centralized Controller EW-50A/EW-50E/TW-50A” is referred to as “EW-50".

“DIDO controller (PAC-YGE66DCA)” is referred to as “DIDO controller”.

“PI controller (PAC-YGB0OMCA)” is referred to as “Pl controller”.

“Al controller (PAC-YGB3MCA)” is referred to as “Al controller”.

“City Multi Y, HP, R2, WY, WR2, S” is referred to as “VRF”.

“Hybrid City Multi” is referred to as “HVRF”.

“Hydro branch controller (HBC)” and “Hydro unit” are referred to as “Pump unit”.

“OA Processing unit (LOSSNAY with heater and humidifier)” is referred to as “OA Processing unit”.
“Booster unit” and “Water HEX unit” are referred to as “Air To Water (PWFY) unit”.

“Advanced HVYAC CONTROLLER” is referred to as “AHC”.

“Hot Water Heat Pump unit” is referred to as “HWHP (CAHV, CRHV, QAHV) unit”.

“e-Series chiller unit (EAHV, EACV)” is referred to as “Chiller unit”.

“Chiller unit of MEHITS” is referred to as “MEHT-CH&HP unit.”

Indoor units whose model names end with “-E-OA” are referred to as “outlet air temperature control unit.”
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2-2. Flow of the initial settings and trial run
This explains one example of settings procedures.

| Preparation of the PC

WV

Settings with each centralized controller
[AE-200’s LCD or Initial Setting Tool]
* Unit Info./Basic Settings (including Date and Time settings)
» Network (IP address registration for each centralized controller)

WV

AE-200/AE-50/EW-50 update

Managing up to 200 units
with one AE-200 and one
or more AE-50/EW-50 respectively

Managing up to 50 units
with each AE-200/EW-50

AE-200’s LCD
Unit Info.: [System Exp] “Expand”

AE-200’s LCD

Unit Info.: [System Exp] “Do not expand”
No settings with AE-50/EW-50

A4

AE-200’s LCD
Network: Controller [Exp1-Exp4] selection
: Destination IP address setting

Vv A4

License registration:

[Initial Setting Tool, AE-200’s LCD, or Integrated Centralized Control Web]

A\

Unit Settings
[Initial Setting Tool or AE-200’s LCD]
* Groups * HW Supply (AE-200’s LCD) - Interlocked LOSSNAY - Blocks
» Energy Management Block (Initial Setting Tool or AE-200’s LCD)

« PI Controller/Al Controller (Settings in “Measurement” screen on the AE-200’s

LCD)
Not use Integrated Centralized Control Use Integrated Centralized Control
Web Web
A4

[Initial Setting Tool]

Set the [Managed centralized controller] setting to
“Manage” for each centralized controller.

Floor for Integrated Centralized Control Web (in Floor Settings):

\2

Function Settings
[AE-200’s LCD (for each centralized controller), Initial Setting Tool,
or Integrated Centralized Control Web]
» Peak Cut and Interlock control will be available with a license registration

respectively.

[Initial Setting Tool]

billing function settings are available only on the Initial Setting Tool.
[Integrated Centralized Control Web]

the Integrated Centralized Control Web.

* The refrigerant system settings, interlocking control setting, system-changeover,

» E-mail, Set Temperature Range Limit, Night Mode Schedule are available only on

| Trial run

i

| Settings back-up

\)

| Completed

* For dealers and contractors

Prepare a PC with which to use the Initial Setting
Tool.
(See section 10-1.)

(Common: See sections 4-2 and 4-3.
LCD: See sections 5-1-3, 5-1-4, and 5-1-5.
Initial Setting Tool: See section 6-3-2.)

Update the AE-200/AE-50/EW-50, and ensure the
software version matches.
(See section 4-4.)

Configure the [System Exp] setting on the AE-200’s
LCD.
(See section 5-1-4.)

Register the license for the AE-200/AE-50/EW-50.
(See section 4-5.)

Configure unit settings for the AE-200/AE-50/
EW-50.
(See sections 5-1 and 5-2.)

(See section 6-5-3.)

(LCD: See sections 5-2 to 5-4.
Initial Setting Tool: See sections 6-7 to 6-8.
Integrated Centralized Control Web: See section 8.)

* Items that can be set will differ depending on
settings methods. Refer to section 2-3 and
configure, ensuring that no items are omitted.

Carry out a trial run in order to check that the
AE-200/AE-50/EW-50 are operating in accordance
with settings.

Backup settings, and retain the settings data so

that it can be used for recovery in the event of

malfunction.

(LCD: See section 8-1.

Integrated Centralized Control Web: See section
8-2.)

Properly carry out initial settings and trial runs, and take care to ensure that no settings have been omitted or configured incorrectly.
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Initial settings for AE-200/AE-50/EW-50 can be configured on the LCD, Initial Setting Tool, and Integrated
Centralized Control Web.

Each has specific characteristics as below.

+LCD
Method for setting the AE-200/AE-50/EW-50 from the AE-200’s LCD.
Configuration of initial settings for single AE-200 systems is possible.
Methods of setting from the LCD are explained in section 5 “Settings on the LCD”.

Note: Configure the expansion controller connection settings from the AE-200’s LCD.
Note: The EW-50 does not have an LCD, therefore it is necessary to configure settings from the Initial Setting Tool or
Integrated Centralized Control Web.

* Initial Setting Tool
The Initial Setting Tool is used for configuring settings from a PC.
This allows configuration of initial settings for multiple AE-200/EW-50 systems, and allows batch configuration
of initial settings for up to a total of 40 AE-200/AE-50/EW-50 units.
A check sheet can be output to be used for trial runs.
The settings data created using the Initial Setting Tool is written from the PC to the AE-200/AE-50/EW-50 over
a LAN connection. Additionally, settings data can be created beforehand at another location such as an office.
Methods of setting from the Initial Setting Tool are explained in section 6 “Settings using Initial Setting Tool”.

Note: It is necessary to set the apportioned electricity billing function initial settings and Integrated Centralized Control Web
function initial settings from the Initial Setting Tool.
Note: It is necessary to set the BACnet® connection function initial settings from the BACnet® Setting Tool.

* Integrated Centralized Control Web
The Integrated Centralized Control Web is used for configuring settings from a PC Web browser.
This allows separate logins to a single Integrated Centralized Control Web, and configuration of initial settings.
Methods of setting from the Integrated Centralized Control Web are explained in section 7 “Settings using
Integrated Centralized Control Web”.
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The settings ranges for each of these settings are as below.

m—
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-
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2-3. Functions that can be set
The functions that can be set by using the LCD, Initial Setting Tool, and Integrated Centralized Control Web are

different.

See the table below to check the functions to be used, and configure the settings combining multiple initial
settings methods.

Functions that can be set are as follows.

Initial Integrated
Setting item Description LCD } Centralized
Setting Tool Control Web
Date and time settings The current date/time and daylight savings time v v
can be set.
License registration Llcgnses for optional functions can be Vv V19 v
registered.
Unit information Basic settings can be made. \Y V™o
Language The language to be used for display can be set. V
M-NET Whether or not to use an AE-200 M-NET can v
be selected.
Expansion controller Whether or not to use an expansion controller Vv
_ P (AE-50/EW-50) can be selected.
Bat?;: Billing function Whether or not to use an AE-200 apportioned V2
setlings 9 electricity billing function can be selected.
“Time Master/Sub”, “Schedule: Season setting”,
Advanced settings and “Old model compatibility mode” settings V \%
can be made.
Network settings Settings for the network-related items can be Vv v *10
made.
IP address of
- - - *10
AE-200/AE-50/EW-50 *3 IP address of AE-200/AE-50/EW-50 can be set. \Y \Y
IP address of expansion Destination IP address of an expansion
controller P controller (AE-50/EW-50) can be set with \Y
AE-200.
Air conditioning units, Air To Water (PWFY)
units, LOSSNAY units, HWHP (CAHV, CRHV)
. units, chiller units, MEHT-CH&HP units, general .
Group settings . V V8
equipment, remote controllers, sub system
controllers, and AHC can be registered to a
Unit setti 9group.
nit setlings ) HWHP (QAHV) units can be registered to a
HW Supply settings V
group.
Refrigerant system settings . —_ .
) . Refrigerant system connection information
(for apportioned electricity . T .
- ) can be set for the apportioned electricity billing V2
billing function and System- )
function and System-changeover.
changeover)
Interlocked LOSSNAY The operation of indoor units and LOSSNAY Vv Vv
settings units can be interlocked.
BIO(.:k (operation block) The groups can be registered to a block. V \%
settings
Energy management block | The groups can be registered to an energy Vv v
settings management block.
P1 controller or Pulse Input (PI) settings such as
Functi PI controller settings “electricity meter” or “water supply meter” can \% \%
s:tr’:;;c;n be made.
Al controller settings Al cont’I"oIIer. temperature sensor” and “humidity Vv Vv
sensor” settings can be made.
E-mail (Out-of-limit alarm) The. d.estlnatlon address and title of e-mail (Out- Vv
of-limit alarm) can be set.
E-Mail Errqr notification e-mail and e-mail alarm V10
settings can be made.
Peak Cut Peak Cut method and Peak Cut control details v 4 V"4 10
for each control level can be set.
WTO07627X17

11




Initial

Integrated

conditioner ON/OFF trial run

unit trial run can be output.

Setting item Description LCD ’ Centralized
Setting Tool Control Web
Energy Management Set to use the energy management function to vV v *10
settings display graphs.
Set Temperature Range Set to restrict the local remote controller set V10
Limit temperature range.
Night Mode (quiet operation) | Set to switch outdoor units to quiet operation .
) ) ) V10
Schedule for a certain period of time.
Set to automatically switch indoor unit operation
System-changeover mode (heating and cooling) based upon room Vv *10
temperature and set temperatures.
) External Temperature Set to interlock the temperature differential
Function Interlock P between the set temperature and the outdoor \Y v *10
settings air temperature to use automatic adjustment.
Night Setback Control Set to automatically copl or heat if the |ndqor v V10
temperature goes outside a set range at night.
Set interlock restrictions for interlock operation N
Interlock control " AN
when conditions have been met.
AHC Port Name settings Advanced HVAC CONTROLLER (AHC) port v *10
name can be set.
Night purge :ift night purge to bring in cooler outside night v v *10
BACnet® *6 BACnet® objects can be set.
Floor settings Sgt monitoring by displaying the floor layout Vv Vv
) using the LCD.
Floor settings - — - -
Floor settings for Integrated | Set monitoring by displaying the floor layout Vv
Centralized Control Web using the Integrated Centralized Control Web.
Billing Function settings Apportioned electricity billing function settings V2
can be made.
Outdoor Unit settings Set ou_tdoor unit parameters for electric energy V2
. apportionment.
Billing Set indoor unit parameters for electric ener
function Indoor Unit settings ) P 9y V2
settings apportionment.
) Set connection relationship for electric energy .
Measurement settings ) . . . V2
apportionment metering devices and units.
Charges settings Time period setting for the seasonal charges V2
can be made.
Set functions and passwords that can be used
User settings for LCD with the LCD. (Maintenance user/building \Y
User settings manager)
User settings for Integrated | Set general user and tenant manager settings
Centralized Control Web *7 | for Integrated Centralized Control Web.
Save settings data to a USB memory
) device. Also, this can write settings data 11
Data back-upfimport saved on a USB memory device to the v v
Maintenance AE-200/AE-50/EW-50 to restore status.
Software update Update AE-200/AE-50/EW-50 software. \%
Check sheet for air- A check sheet to be used for air conditioning
Others \Y

*1 The following two methods can be used to register licenses: registering individually, and registering collectively using a CSV file that contains
license information.

*2 For details, refer to the Instruction Book (Apportioned Electricity Billing Function).
*3 LAN2 IP address (IPv4) for BACnet® can be set. IP address (IPv6) can be set only from the BACnet® Setting Tool.
*4 “Energy Management License Pack” is required. (AE-200E/AE-50E/EW-50E only)

*5 “Interlock control” license is required. On version 7.50 and later, make the settings from the Initial Setting Tool.

*6 Make the settings on the BACnet® Setting Tool. Refer to the Instruction Book (BACnet® Setting Tool).
*7 Make the settings on the Integrated Centralized Control Web. Refer to the Instruction Book (Integrated Centralized Control Web).
*8 MEHT-CH&HP units cannot be set on the Initial Setting Tool.

*9 Available on Ver. 7.6 or later (Initial Setting Tool Ver. 1.4 or later).
*10 Available on Ver. 7.7 or later (Initial Setting Tool Ver. 1.6 or later).
*11 Can be performed for each centralized controller.
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3. Parts to be used

This section explains parts required for initial settings.
Refer to the Installation Manual for parts required for installation of AE-200/AE-50/EW-50.

3-1. Separately sold parts

Item Qty Description

Required to operate functions that require a license.

License Required number | o ister for each of AE-200/AE-50/EW-50.
AE-200 update file *1 1 ) )
Required to update AE-200/AE-50/EW-50 versions.
;‘A']E-*510/ EW-50 update 1 If AE-200/AE-50/EW-50 versions do not match, then they will not operate.
ile

Use to carry out initial settings.

Required when using Integrated Centralized Control Web and apportioned
Initial Setting Tool *1 1 electricity billing functions.

Depending on the version of AE-200/AE-50/EW-50, the version of the Initial
Setting Tool that can be used will differ. *2

*1 Contact your dealer regarding the update files.
*2  When performing initial settings using the Initial Setting Tool, it is necessary to ensure that all AE-200/AE-50/EW-50 versions are the same.
Depending on the version of AE-200/AE-50/EW-50, the version of the Initial Setting Tool that can be used will differ as shown in the table

below.
Initial Setting Tool version AE-200/AE-50/EW-50 version .NET Framework version
Ver.1.9/2.0 Ver. 7.2-7.98 Ver. 4.8 or later
Ver. 1.8 Ver. 7.2-7.85 Ver. 4.8 or later
Ver. 1.7 Ver. 7.2-7.8 Ver. 4.8 or later
Ver. 1.61 Ver. 7.2-7.7 Ver. 4.8 or later
Ver. 1.5 Ver. 7.2-7.68 Ver. 4.8 or later
Ver. 1.4 Ver. 7.2-7.64 Ver. 4.8 or later
Ver. 1.3 Ver. 7.2-7.5 Ver. 4.8 or later
Ver. 1.2 Ver. 7.2-7.4 Ver. 4.8 or later
Ver. 1.1 Ver. 7.2-7.3 Ver. 4.8 or later
Ver. 1.0 Ver. 7.2 Ver. 4.8 or later
Cannot be used. Ver. 7.1 -

3-2. Commercially available parts

Item Qty Description
PC 1 PC with which to use the Initial Setting Tool and Integrated Centralized Control
Web
USB memory 1 Required for backup of settings data.
LAN cable Required number ) )
— - Required for connection of AE-200/AE-50/EW-50 and PC.
Switching HUB Required number

Use a USB memory device that meets the following conditions.

* Supports USB 2.0 (Must be USB 2.0-compatible when using a USB 3.0)

» Formatted with FAT32 or FAT (FAT16)

» Without a security function (locked by a password or encrypted) that prevents the data files from being written
to or the function is unused. When using a USB memory device with a security function, its function must be
disabled.

(USB memory device with a fingerprint authentication function may be used.)
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3-3. PC requirements
The operating environment for the PC with which to use the Initial Setting Tool and Integrated Centralized Control
Web is as below.

As of February 2022
Item Requirements
CPU 1 GHz or faster (at least 2 GHz recommended)
Memory 1 GB (2 GB or more for Integrated Centralized Control Web)
Screen resolution 1024 x 768 or better (at least 1366 x 768 recommended)
Microsoft® Windows® 11 (64 bit) *1
oS Microsoft® Windows® 10 (64 bit) *1

Microsoft® Windows® 8.1 (64 bit) *1

Minimum system requirements for Windows® 8.1, Windows® 10, or Windows® 11
must be met.
.NET Framework 4.8 or later "2

* Required when Microsoft® Excel 2013 (32 bit) /2016 (32 bit) /2019 (32 bit) trial run check
sheet is used.

Operating environment
(only required for Initial Setting Tool)

Browser Microsoft® Edge® 96
(only required for Integrated Google Chrome™ Ver. 96
Centralized Control Web) Safari® 15

Internal LAN port or LAN card 100 BASE-TX or better
Pointing device Mouse, etc.

USB Minimum 1 port

*1) Verified to work on the Pro edition

*2) When installing the Initial Setting Tool, the page will jump to the download site if .NET Framework 4.8 or later is not installed.

Note: Microsoft Corporation will end its support for Microsoft® Internet Explorer® 11 in June 2022. Use a browser other than Microsoft®
Internet Explorer®.

Note: The use of the latest version of the OS is recommended.
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4. Preparation

4-1. Logging in to the Integrated Centralized Control Web

(1) Enter the web page address in the address field of the Web browser as follows:

http:

/I[IP address of the login destination AE-200/EW-50]/control/index.html

(2) Alogin screen will appear.
Model name, serial number, and software version information of the login destination AE-200/EW-50 will
appear on Ver. 7.98 and later.

Serial number —]

Note:
Note:
Note:

Note:
Note:

Note:

R

Enter user name and password.

User name

Password

Login Software version

Model name P 1c 200

Copyight(C) 2015(2022) MITSUBISHI ELECTRIC CORPORATION
Al Rights Rese

If the IP address of the AE-200/EW-50 is [192.168.1.1], the web page address is [http: //192.168.1.1/control/index.html].
Use an Initial Setting Tool to configure the login destination centralized controller settings.

The web page will be displayed in the same language as the operating system on the PC.

The web page can be displayed in other languages by entering the web page address as follows:

Chinese http://[IP address of AE-200/EW-50]/control/index.html?zh
English http://[IP address of AE-200/EW-50]/control/index.html?en
French http://[IP address of AE-200/EW-50]/control/index.html?fr
German http://[IP address of AE-200/EW-50]/control/index.html|?de
Italian http://[IP address of AE-200/EW-50]/control/index.html?it

Japanese http://[IP address of AE-200/EW-50]/control/index.html?ja
Portuguese http://[IP address of AE-200/EW-50]/control/index.htmI?pt

Russian http://[IP address of AE-200/EW-50]/control/index.html|?ru
Spanish http://[IP address of AE-200/EW-50]/control/index.html|?es
Turkish http://[IP address of AE-200/EW-50]/control/index.html?tr

You can add the web page address to your Favorites on the login screen for easy access in the future.

When using the Integrated Centralized Control Web on a tablet, depending on the tablet used, the bottom of the operation
screen may be cut off. In the event of this, create a shortcut on the Home screen from which to start the application.

Refer to the Instruction Book (Integrated Centralized Control Web) for details on how to add a shortcut to the Home screen.
Depending on the PC display used, the bottom of the operation screen may be cut off. In the event of this, switch the
browser to full screen mode.

(3) Enter the user name and the password in the login screen, and click [Login]. A screen that shows the operation
status of the air conditioning units will appear.
Note: The user name and password used for the Integrated Centralized Control Web are different from the ones used for the

LCD.

Note: It is recommended to change the default user name and password so that the users other than the building managers

will not be able to change the settings.

Note: If the default user name and password of building manager were changed, the changed user name and the password

will remain active after the controller is updated to a newer version.
Also, if you import the backup data of the changed settings to another AE-200/EW-50, the changed user name and the
password will remain active.

AE-200E/EW-50E

For

users in the UK

Ver. 7.99 and earlier

User Default user name Default password

Building manager administrator admin

WT07627X17
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Ver. 8.00 and later

Example default password
(DP: ABCDEFGH™3)
Building manager administrator ad “DP” adABCDEFGH
*1 Default password for AE-200E/EW-50E updated to Ver. 8.00 or later from Ver. 7.99 or earlier
See table for AE-200E/EW-50E (Ver. 7.99 and earlier).

*2 Default password for AE-200E/EW-50E to which the backup data from Ver. 8.00 or later was imported
If the settings data are backed up from the AE-200E/EW-50E that was logged in with the default password and are imported to the
AE-200E/EW-50E Ver. 8.00 or later, the new password will be DP of the AE-200E/EW-50E to which the data was imported.

User Default user name Default password*1*2

AE-200E/EW-50E AE-200E/EW-50E
Software version: 8.00 Software version: 8.00
DP: ABCDEFGH DP: HGFEDCBA
Password of building manager: adABCDEFGH Password of building manager: adHGFEDCBA
Export Import
T backup data backup data E

) I

*3 DP can be found on the back cover of the following manuals.
AE-200E : the Instruction Book (supplied with the controller)
EW-50E : the Installation and Instructions Manual (supplied with the controller)

For users outside the UK

All versions
User Default user name Default password
Building manager administrator admin

AE-200A/EW-50A
Ver. 7.97 and earlier

User Default user name Default password
Building manager administrator admin

Ver. 7.98 and later

. Example default password
m 4*5
User Default user name Default password (Serial number: 19672-123"6)
Building manager administrator ad “Serial number” ad19672123

*4  Default password for AE-200A/EW-50A updated to Ver. 7.98 or later from Ver. 7.97 or earlier
The default password varies with the version immediately before the update.
Default password for AE-200A/EW-50A when updated from a version earlier than Ver. 7.98

Version before the update Default password after the system has been updated to Ver. 7.98 or later
Ver. 7.10-7.12 ad “Serial number”
Ver. 7.23-7.97 admin

*5 Default password for AE-200A/EW-50A to which the backup data from Ver. 7.98 or later was imported
If the settings data are backed up from the AE-200A/EW-50A that was logged in with the default password and are imported to the
AE-200A/EW-50A Ver. 7.98 or later, the new password will be the serial number of the AE-200A/EW-50A to which the data was

imported.
AE-200A/EW-50A AE-200A/EW-50A
Software version: 7.98 Software version: 7.98
Serial number: 31C71-101 Serial number: 19272-124
Password of building manager: ad31C71101 Password of building manager: ad19272124

Export Import
backup data backup data

) I

L]
444

*6 On Ver. 7.98 and later, serial number can be found on the login screen of the Integrated Centralized Control Web.
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4-2. IP address settings

Set AE-200/AE-50/EW-50 IP addresses, and configure the expansion controller connection settings on the AE-200’s

LCD.

For an AE-200 system, set using the following procedure.

Expansion controller
connected

WV

| IP address setting of AE-50/EW-50

WV

No expansion controller
connected

| M-NET setting

WV

| Expansion controller setting

V

| IP address setting of AE-200

Expansion controller
connected

WV

Destination IP address setting of
expansion controller

WV

No expansion controller
connected

Completed

For an EW-50 system, set using the following procedure.

| IP address setting of EW-50

WV

| Completed

WT07627X17
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Set the IP address of AE-50 on the LCD, and set the IP
address of EW-50 on Initial Setting Tool.
(See section 4-2-1 “Setting IP addresses of AE-50/EW-50".)

Set whether or not to use an AE-200 M-NET on the AE-200’s
LCD.
(See section 4-2-2 “Setting IP addresses of AE-200”".)

Set whether or not to use an expansion controller on the
AE-200’s LCD.
(See section 4-2-2 “Setting IP addresses of AE-200".)

Set the IP addresses of AE-200 on the AE-200’s LCD or
Initial Setting Tool.
(See section 4-2-2 “Setting IP addresses of AE-200".)

Set the connecting IP addresses of expansion controllers on
the AE-200’s LCD.

(See sections 4-2-2 “Setting IP addresses of AE-200” and
5-1-5 [5] “Communication error detection”.)

Set the IP addresses of EW-50 on Initial Setting Tool.
(See section 4-2-1 “Setting IP addresses of AE-50/EW-50".)



[1] Settings for connecting the AE-200/AE-50/EW-50 to a dedicated LAN

(1) Enter the AE-200, AE-50, or EW-50’s IP address in the [IP Address] field. If the LAN has been newly set up,
allocate IP addresses to the AE-200 units in a sequential order starting with [192.168.1.1]. For example, the
first AE-200 unit will have an IP address of [192.168.1.1], the second AE-200 unit will have an IP address of
[192.168.1.2] and so on.

Allocate IP addresses to the AE-50/EW-50 units in a sequential order starting with [192.168.1.211].

Note: The recommended IP address ranges are as follows.
AE-200: Between [192.168.1.1] and [192.168.1.40]
AE-50/EW-50: Between [192.168.1.211] and [192.168.1.249]
PC: Between [192.168.1.101] and [192.168.1.150]

[IP address setting example]

Hub
100 BASE-TX LAN straight cable |
AE-200 E AE-50 E AE-50 E
| 192.168.1.1 | [192.168.1.211] [192.168.1.212 | [ 192.168.1.101

Note: Some hubs have dedicated ports for connection with another hub.
Connect the AE-200/AE-50/EW-50 and PC to the normal ports.

(2) Enter [255.255.255.0] in the [Subnet Mask] field (unless otherwise specified).

(3) When monitoring the system remotely or using e-mail function via a dial-up router, enter the router IP

address in the [Gateway] field.
Leave the [Gateway] field blank when not connecting a dial-up router.

[Remote Monitoring System example]
Telecommunication Network

Dial-up router Dial-up router, cellular phone etc.
[ IPAddress: 192.168.1.254 |

AE-200 E
IP Address: 192.168.1.1 IP Address: 192.168.1.101
Subnet Mask: 255.255.255.0 Subnet Mask: 255.255.255.0
Gateway: 192.168.1.254 Gateway: Blank

Note: [192.168.1.254] is recommended for use as the IP address of the dial-up router. Refer to the dial-up router
instruction manual for details of how to set the IP address.
Note: The use of a dial-up router with no modem requires a modem (for analog or ISDN) to be connected between the

router and the public phone line.
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Note: When LAN2 (for exclusive use for BACnet) of AE-200/AE-50/EW-50 is unused, the initial IP address of LAN2
will be 192.168.2.1. If an IP address 192.168.2.*** is used for the remote-side broadband router, connection

from the remote side will fail. If any of the networks on the remote-side broadband router has an IP address of
[192.168.2.***], take either of the measures 1 and 2 below.

(Measure 1) Change the IP address of LAN2 to an address other than [192.168.2.***] from the Initial Settings
Tool.

(Measure 2) Change the remote-side IP address (network address) of the remote-side broadband router to an
address other than [192.168.2.%**].

Remote side

Dial-up router Dial-up router, cellular phone etc.
| IPAddress: 192.168.1.254 | |

AE-200 E
(Measure 1) Change the IP address of LAN2 to (Measure 2) Change the IP address
an address other than 192.168.2.*** (network address) of the

(Ex. 192.168.3.1). remote side to a number other

than 2 (Ex. [192.168.4.250]).

[2] Settings for connecting the AE-200/AE-50/EW-50 to an existing LAN

(1) When connecting the AE-200/AE-50/EW-50 to an existing LAN, consult the system administrator to decide
the IP, subnet mask, and gateway addresses.

[Existing LAN System example]
Backbone LAN
Gateway Gateway
[ 10.1.1.250 | | 10.1.2.250 |

AE-200 12 Obtain the addresses from

= the system administrator. the system administrator.

Y\ X

IP Address: 10.1.1.1 IP Address: 10.1.1.101 IP Address: 10.1.2.51
Subnet Mask: 255.255.255.0 Subnet Mask: 255.255.255.0 Subnet Mask: 255.255.255.0
Gateway: 10.1.1.250 Gateway: 10.1.1.250 Gateway: 10.1.2.250

Obtain the addresses from
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4-2-1. Setting IP addresses of AE-50/EW-50
Set the AE-50/EW-50 IP addresses. Settings screens will differ depending on the unit model.
AE-50: AE-50’s LCD
EW-50: Initial Setting Tool

Note: Set IP address for “LAN1.”

Note: “LAN2” is exclusively used for BACnet® function. To use the BACnet® function, configure the BACnet® settings on the BACnet®
Setting Tool. Refer to the Instruction Book (BACnet® function) for the BACnet® function settings.

[1] When setting on the AE-50’s LCD

(1) After the power is turned on to the AE-50, a language selection
screen will appear.

Select the language to be used for display, and then touch [OK]. Deutsch

Note: It will take approximately one minute for the display to appear ;

after the power is turned on. AR

Note: Once the initial settings have been made, [Monitor/Operation]
screen will appear after the power is turned on.

AE-58E Ver.7.45 (1.87)

Italiano Por tugués
Tiirkge

B4

(2) The [Date and time] screen will appear. P A ronction & runctionz| - | |

| « Date and time License Unit Info. U

Day Month Year

0 0 A
/ ICH A 2015 |
V| V| V]

Hour Minute Second

im0 ml =l
V| V| V|

Daylight saving changes

Custom settings

Save Settings

(3) Touch the right triangle button to display the [Network] tab, and munc - m
touch it. |« | Unit Info. 2 Advanced > |
Referring to section 5-1-5 “Network”, set the AE-50’s IP
address, and then touch [Save Settings]. o A AET Arees
The AE-50 will reboot. EXye 00

Note: When multiple AE-50 controllers are connected, set the IP S es pee FHEE SRS
addresses on all AE-50. MAC Address SR
Note: The AE-200 and AE-50’s IP addresses must have the same 38EGBEEAT734 e e
LAN common settings
network address. Gateway /Not_in use
<Reference: Default IP address> ]

AE-200 | 192.168.1.1
AE-50 | 192.168.1.211 L N2 v | Save Settings
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[2] When setting on the Initial Setting Tool (EW-50)

(1) Start the Initial Setting Tool.
Click [New], and the Initial Setting Tool screen will be displayed with all setting items unset.

(2) Click [Basic Settings] and then [System Configuration] to open the System Configuration Settings screen.
« Settings of a centralized controller must be made in No.1.
* Click [ ¥ ] to open the model selection menu, and select [EW-50].
* Enter the IP address (default: 192.168.1.1) in the “Destination IP address” box.
* Click [Save].

MITSUBISHI Air Conditioning - Initial Setting Tool

File (F) Data acquisition (M) Send (S) Data verification (¥)  Option (0)  Help (H)

Basic Settines | Unit Settines | Floor Settings | Billine Function Settines | Interlock Gontrol Settines | Function settines |

Gentralized contraller Destination IP address Expansion controller Destination IP address:

1 [Ew-50 | 19278811 ] <

- sl

(3) Click [Data acquisition] on the tool bar and select [Acquire] to load the settings of EW-50 to the Initial Setting
Tool.

(4) Click [Basic Settings] and then [Basic System] to open the Basic System screen.

(5) Click [Unit Settings] and then [Network setting] to open the Network setting screen.

Network setting X
LANT Settings LAN2 Settings
IP Address 192.168.1.1 IP Address 192.168.1.2
Subnet Mask 266.255.266.0 Subnet Mask 266.255.266.0
Gateway 192.168.1.254
MAC Address MAC Address
Acquire Edit

(6) Click [Acquire] to load the network settings of EW-50.
The factory default IP address and subnet mask are 192.168.1.1 and 255.255.255.0 respectively.

(7) Change the IP address, subnet mask, and gateway under LAN1 settings, and click [Edit].
LAN2 settings are exclusively used for BACnet® function.
To operate EW-50 according to the settings made with the Initial Setting Tool, set the rotary switch (SW1) to
HO.Y!
Then, EW-50 will restart to apply the changes in the network settings to EW-50.

(8) After EW-50 restarted, click [Basic Settings] and then [Basic System] again to open the Basic System
screen.
Enter the IP address that has been set in step (7) in the Destination IP address box, and save it.

(9) Click [Unit Settings] and then [Network setting] to open the Network setting screen.

(10) Click [Acquire] to load the network settings of EW-50. Then, check that the changes in the network settings
have been applied.
Note: Write down the IP address of the EW-50 because it is not saved to the Initial Setting Tool.
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4-2-2. Setting IP addresses of AE-200
Set the AE-200 IP address and the expansion controller connection.

[1] AE-200 initial start-up for a system without connection to an AE-50/EW-50 controller

(1) After the power is turned on, a language selection screen will AE-286E Ver.7.45 (1. 87)
appear.

Select the language to be used for display, and then touch [OK]. Deutsch

Note: It will take approximately one minute for the display to appear
after the power is turned on.

Note: Do not touch the LCD before any settings screen appears.

Note: Once the initial settings have been made, [Monitor/Operation]
screen will appear after the power is turned on. Tiirkge

Espafiol Frangais

Italiano Portugués

B4

(2) Touch the [Unit Info.] and [Unit Info. 2] tabs. Unit Info.
Referring to section 5-1-4 “Unit Information”, make necessary A Bkiihes |
basic settings, and then touch [Save Settings]. Loijalnfo
Note: Make sure to set the [System Exp] setting for the AE-200 to [Do . TR
not expand]. Mitsubishi Electric 31/12/2015 18:00

Note: Make sure to set the [AE-200 M-NET] setting to [Use]. Unit ID SysteniEsp Temperature  Language

Pressure unit Screen lock

AE-2 m Do not use

“ Occupancy Brightness
Volume Control /8 /=
Sound Brightness

Save Settings

Unit Info. 2
itial

T X runctiont X runctionz] o | |

n Unit Info.2 Advanced Network

Air-conditioner Settings

Test run Temperature display Humidity

Room temp. OFF

Do not use (Always)

Save Settings

[2] AE-200 initial start-up for a system with connection to one or more AE-50/EW-50 controllers

(1) Atfter the power is turned on to the AE-200, a language AE-286E Ver.7.45 (1.87)
selection screen will appear.

Select the language to be used for display, and then touch [OK]. Deutsch

Note: It will take approximately one minute for the display to appear
after the power is turned on.

Note: Do not touch the LCD before any settings screen appears. Italiano Por tuguds

Note: Once the initial settings have been made, [Monitor/Operation]

screen will appear after the power is turned on. Tirkge

Frangais

B4

‘ 0K H Cancel I

WT07627X17 22



(2) Touch the [Unit Info.] and [Unit Info. 2] tabs. Unit Info.

Referring to section 5-1-4 “Unit Information”, make necessary RO X Functiont X\ F A
basic settings, and then touch [Save Settings]. Lot lote.
Note: Make sure to set the [System Exp] setting for the AE-200 to r———— rPEE————
[Expand]. Mitsubishi Electric
Note: The [AE-200 Apportion] setting will appear only when the Unit ID SEEIED Temperature  Language
“Charge” license has been registered. | Exoand |

Pressure unit Screen lock

6 f es)
AE-200 M-NET

Occupancy Brightness
Volume Control /=
Sound Brightness

Save Settings

Unit Info. 2

|
A e unction unction:

n Unit Info.2 Advanced Network

Air-conditioner Settings

Test run Temperature display Humidity

Room temp. OFF

Do not use (Always)

Save Settings

(3) Touch the right triangle button to display the [Network] tab, and A Initial K
touch it. | <« | Unit Info.2 |
Referring to section 5-1-5 “Network”, make sure that [AE200] I Rl Viiceibiah LI EEtnic
is selected as [Controller], set the AE-200’s IP address and o A AET Arees
subnet mask, and then touch [Save Settings]. S —_
The AE-200 will reboot. [ 255. 255. 255.0 |
When the reboot process is complete, log in to the Initial “A;;‘;’;;;j;m External Input Setting
Settings menu. Lé\aNtec:;n;non settings
Note: Refer to section 5-1-1 “Logging in to the Initial Settings menu” ]

for how to log in.
Note: Do not touch the LCD during the reboot.

Save Settings

(4) Inthe [Controller] section, select [1], [2], [3], or [4] to make A gnitial B
settings for each AE-50/EW-50.
Referring to section 5-1-5 “Network”, set the IP address of controfier
each AE-50/EW-50 that is connected to the AE-200, and Doin 1P adiress | MAET Address
M-NET address, and then touch [Save Settings].

Version Range of Prohibited Controllers
Ver.7.308(1. 85) SC/RC

External Input Setting

Demand (Level signal)
/Not in use

Save Settings

(5) A message “Collecting connected equipment status data.
Please wait ...” will appear.
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(6) Upon completion of collection of connected equipment status
data, a message “Saved successfully.” will appear, and the
version of the AE-50/EW-50 will appear.

When a message other than the ones listed above appears,
check the IP address setting, LAN wiring, and AE-200/AE-50/
EW-50 versions. If there is a mismatch, update the software

and match the versions, and then start over from step (4).
Note: When there is a mismatch in the versions, [Unable to send the
data due to AE-50/EW-50 communication error.] will appear.
Make sure that the versions of AE-200/AE-50/EW-50 match.

Go to the next section.

4-3. Date and time setting
Set the date and time for the AE-200/AE-50/EW-50. There are two ways to set the date and time — from the AE-200’s
LCD and Integrated Centralized Control Web.

If an expansion controller is connected in an AE-200 system, connect the AE-200 to the expansion controller over
a LAN, then set the date and time from the AE-200. Setting the date and time on the AE-200 will synchronize the
date and time on the expansion controller with the AE-200, therefore setting the date and time on the expansion
controller is not necessary.
When setting the clock on multiple centralized controllers, set the clock from the Integrated Centralized Control
Web, not from the LCD of AE-200.

Note: Set the date and time periodically. (Once every three month. Once a month recommended)

Note: The “Integrated Centralized Control Web” license is required to set the date and time for multiple centralized controllers. For
details, refer to [Settings] — [Initial settings] — [Date and Time Settings] in the Instruction Book (Integrated Centralized Control

Web).
Note: When the power is turned on for the first time, the language selection screen will appear. Select a language to use in the
system.
[1] When setting date and time on the AE-200’s LCD
(1) Touch the [Date and time] tab. ENEETETEI  Functiont 3

Referring to section 5-1-3 “Date and time”, set the current date,
current time, and daylight saving time, and then touch [Save
Settings].
Note: The AE-200’s current date and time will be synchronized to
each AE-50/EW-50 and remote controllers.
Note: In order to synchronize the date and time with the
AE-50/EW-50, it is necessary to set the date and time.
Note: The setting will not be saved until [Save Settings] is touched.
Make sure to touch [Save Settings] after the setting is e it SRing) GETEES
completed. Custom settings

Save Settings
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[2] When setting date and time on the Integrated Centralized Control Web

In [Settings] — [Initial settings] — [Date and Time Settings] in the menu, the current date and time of the login
destination centralized controller can be acquired and the current date and time can be set for all centralized
controllers.

Enter the current date and time, and click [OK] to save the settings to the centralized controllers.

Date and time of the
centralized controller
The current date Date and Time Settings

and time of the login
destination centralized Date and time of the centralized controller

controller appear. 2016/04/27 02:16:32pPM [ Refresh |

Date settings ;
Date settings Refresh

Enter the current date.

Time settings ) current date and time
Enter the current time. Time settings of the login destination
02:27:31PM centralized controller.

Daylight saving time
setting

Click to enable the Applicable country setting

daylight saving time

Cancel OK ! OK

Click to save the
settings.

Automatically adjust clock for daylight saving changes

Cancel
Click to cancel the settings and close the
date and time settings screen.

(1) Enter the current date and time.

(2) To adjust the daylight saving time automatically, check the [Automatically adjust clock for daylight saving
changes] checkbox, click [Custom settings] on the left, and select the applicable country.

If the applicable country is not there, select [Custom settings] on the right instead to open the Custom settings
screen, and configure the daylight saving time setting.

Custom settings

Daylight saving time start date/time

Month/Day Hour:Minute Hour:Minute

04/01 02:00 | 4 03:00

Daylight saving time end date/time

Month/Day Hour:Minute Hour:Minute

10/01 03:00 02:00

Cancel (0]

Note: The date and time set on this screen will be sent to all AE-200/AE-50/EW-50 controllers that are managed by the Integrated
Centralized Control Web, and be reflected to all air conditioning units connected to them.

+ Setting the time on the Date and Time settings will not change the clock on your computer. Set the time on your computer
first before setting the time on the Date and Time settings.

Note: Schedule settings are sent to the AE-200/AE-50/EW-50, based on the time of the PC that uses the Integrated Centralized
Control Web.

If the current time is moved forward on this screen and the time differs from the PC time, the operation that was scheduled to
take place during the time that was skipped will not be performed.

Note: When the daylight saving time is set, time difference may occur between the centralized controllers AE-200/AE-50/EW-50
and the PC, adversely affecting the schedule settings and energy management function. When setting the daylight saving
time, be sure to set the same time for the PC time.

Note: The Integrated Centralized Control Web will not function properly if the PC time is not synchronized with the
AE-200/AE-50/EW-50 time.
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4-4. Software Update
Refer to the AE-200/AE-50 Installation Manual for how to update the software for AE-200/AE-50.
Refer to the EW-50 Installation and Instructions Manual for how to update the software for EW-50.

WT07627X17 26



4-5. License registration for optional functions
There are three ways to register the license — from the AE-200’s LCD, the Integrated Centralized Control Web, and
the Initial Setting Tool.

Please contact your dealer as regards optional functions and purchasing license numbers.
Note: After the “Integrated Centralized Control Web” license is registered, licenses can be registered on the Integrated Centralized
Control Web. For details, refer to [Settings] — [Initial settings] — [License Registration] in the Instruction Book (Integrated
Centralized Control Web).

[1] When registering a license on the AE-200’s LCD

Touch [Initial Settings] in the menu bar, and then touch [License].
Note: The current date and time settings are required for license registration. Refer to section 5-1-3 “Date and time” for date and
time settings.
Note: The license registration is required for each AE-200/AE-50/EW-50.
Note: The [Controller] setting will appear (only on the AE-200’s LCD) when the [System Exp] setting on the [Unit Info.] screen is set
to [Expand]. Switch the [Controller] setting between [AE200] and [Exp1] through [Exp4] to register licenses for each AE-200,
AE-50, and EW-50 individually.

Important

e \When one or more AE-50/EW-50 controllers are connected, licenses for the AE-50/EW-50 must be registered with the
AE-50/EW-50 properly connected to ensure proper settings.

Controller WIRIEII 2 Firnctianl R Funetion? | b
Select [AE] to register Settings
licenses for AE-200, and N | Unit Info.
select [1], [2], [3], or [4] to
register licenses for each Control ler m Mitsubishi
AE-50/EW-50.

Selecting Optional Function

=% (b)Charge
Selecting Optional

Function Current Status

Select the optional function

to be registered. Available

= . , License number entry field
Registration of License Number

SRAT-CSRA-FGSR-BHEA-UAFE-EHQU

Current status

This indicates whether the il EA
optional function is available 81156-818
for use.

Register the license -

) N Register the license
Serial No. Touch to register the license.

(1) Inthe [Selecting Optional Function] section, select the optional function to be registered. The current
availability will appear in the [Current Status] section.

(2) Inthe “License number entry field” button, enter the license number and touch [Register the license].
In the [Current Status] section, a word [Available] will appear.
If the registration is unsuccessful, verify that the selected optional function and the license number are correct.
Note: Alphabet “O” and “I” are not used for license number.
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[2] When registering a license on the Initial Setting Tool
Licenses can be registered either individually on the Initial Setting Tool, or collectively by importing a CSV file that
contains license information.
Click [Option] in the tool bar, and then click [License registration].
Note: Contact your dealer as regards the CSV file that contains license information.

SERIAL No. Target centralized
The serial number of the Negister the license y/ controller
centralized controller will X From the list of the
appear. Target centralized controler. |1 bisubishi bulking = centralized controllers with
SERIAL N0 2164110 connection configuration
. Software Version 7.6001.079 H
Software Version — Optional Function Cument Status Registration of License Number tshet, IlSGleCt one to regISter
The software version of the - € license.
. . (b)Charge Avaiiable - - - - - |
centralized controller will ?
appear_ (c)Tenant/Personal Web Avaiiable |:| - |:| B |:| R |:| R |:| R |:| |
(d)Maintenance Tool Will be available in 1 day. |:| - |:| - |:| - |:| - |:| - j RegIStratlon Of License
License name ——7| Number
eMorterance Teol Advanced fitle S T T S A B Enter the license number.
{IPLC for General Equipments Avaiiable |:| - |:| - |:| - |:| - |:| - |:|
Current status
. . . . fh)interlack control Available - - - - -
This indicates the license
Usage status. {0utdoor Unit Status Monitor Avaiiable |:| - |:| - |:| B |:| - |:| B |:| .
/— Register
(k)Data Storage for Maintenance Avaiiable |:| - |:| - |:| - |:| - |:| - |:| Clle to register the license
Data acquisition —| | |steeeres T T s s Y for the selected centralized
Click to acquire the license '
information of the selected e e . e e e M g /— Close
centralized controller. [ e | g Click to undo the changes
l C"E"s;ﬂ"’s:‘s:‘s I l Import icense CSVfie: ] l Colective registration l Ciose I made and return to the
¢ A » previous screen.
Cglll_elt(:ttlve data at¢':1qul!5|t|on - Import license CSV file \— Collective registration
inf 1c ? acq?lrﬁ etlc?nsg Click to import the CSV Click to collectively
information of a centra“lze file that contains license register the licenses for all
controflers. information and to centralized controllers.

automatically register the
license numbers.

(A) Individually registering the licenses
(1) From the list of the centralized controllers, select one to register the license.
(2) Click [Collective data acquisition].

(3) Enter the license numbers to be registered, and click [Register].
Note: Make sure to perform [Collective data acquisition] or [Data acquisition] before registering the license.

(B) Collectively registering the licenses by importing the CSV file that contains license information
(1) Click [Collective data acquisition].
(2) Click [Import license CSV file].

(8) Check that the license numbers are displayed in the “Registration of License Number” section, and click

[Collective registration].
Note: Make sure to perform [Collective data acquisition] or [Data acquisition] before registering the license.
Note: If the CSV file that contains license information is edited using programs such as Microsoft® Excel, the file contents will
be altered and the file cannot be imported.
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[3] When registering a license on the Integrated Centralized Control Web
In [License Registration], register licenses for optional functions.
Please ask your dealer for how to purchase a license for optional functions.

Note: The license registration is required for all connected centralized controllers AE-200/AE-50/EW-50. Switch the centralized
controller in [Controller] to register the license respectively.

License registration for optional functions

Optional function Controller __— Controller

Select the optional function to be AEO1-1 1st Floor Centralized Controller Select a centralized controller to

registered. which the license is registered.
Optional function

Current status

This indicates whether the Current status
optional function is available for
use.

Available

License number

1234 - 5678 - 1234 - 5678 - AAAA - AAAA i i
Model name and software License number entry field

version . Software version
AE-200A 7.30(1.05)

Register Register

Click to register the license.

Close

(1) After logging in on the login screen, select [Settings] — [Initial settings] — [License Registration] in the menu to
display the license registration screen.

(2) In [Optional function], select the optional function to be registered.
The current availability will appear in the “Current status” section.

(3) In [License number entry field], enter the license number and click [Register].
In “Current status”, “Available” will appear.

If the registration is unsuccessful, verify that the selected optional function and the license number are correct.
Note: Alphabet “O” and “I” are not used for license number.
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5. Settings on the LCD
5-1. Initial Settings

5-1-1. Logging in to the Initial Settings menu

(1) Touch [|®]] to display the login window. BEEEA e e R
< | :

(2) Enter the user name and the password on the keyboard Software version
screen (See [1] “Keyboard screen”), and touch [Login].
[Initial Settings] menu screen will appear.

The model name and the serial number will appear in
the lower left of the window, and the software version
User name

information will appear in the lower right of the window. _

Password

Login / Panel cleaning

Serial number
Model name

Accessible users and available functions are shown in the table below.

User Available functions
Maintenance user All functions
- The items to which access rights have been given on the [User Info] screen are
Building manager available

Note: A maintenance user can specify the functions to be made available for building managers. Refer to the Instruction
Book (Initial Settings) for details.

Default maintenance/building manager user names and the passwords are shown in the tables below.
Note: It is recommended to change the default user name and password so that the users other than the maintenance users
and building managers will not be able to change the settings.
Note: If the default user name and password of maintenance user and building manager were changed, the changed user
name and the password will remain active after the controller is updated to a newer version.
Also, if you import the backup data of the changed settings to another AE-200/AE-50, the changed user name and the

password will remain active.

AE-200E/AE-50E
For users in the UK
Ver. 7.99 and earlier

User Default user name Default password
Maintenance user initial init
Building manager administrator admin
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Ver. 8.00 and later

Example default password

*1*2
User Default user name Default password (DP: ABCDEFGH"3)
Maintenance user initial in “DP” inABCDEFGH
Building manager administrator ad “DP” adABCDEFGH

*1

See table for AE-200E/AE-50E (Ver. 7.99 and earlier).

*2

Default password for AE-200E/AE-50E updated to Ver. 8.00 or later from Ver. 7.99 or earlier

Default password for AE-200E/AE-50E to which the backup data from Ver. 8.00 or later was imported

If the settings data are backed up from the AE-200E/AE-50E that was logged in with the default password and are imported to the
AE-200E/AE-50E Ver. 8.00 or later, the new password will be DP of the AE-200E/AE-50E to which the data was imported.

AE-200E/AE-50E

Software version: 8.00

DP: ABCDEFGH

Password of building manager: adABCDEFGH

L]

Export
backup data
) I

AE-200E/AE-50E

Software version: 8.00

DP: HGFEDCBA

Password of building manager: adHGFEDCBA

Import
backup data

444

*3 DP can be found on the back cover of the Instruction Book (supplied with the controller).

For users outside the UK

All versions
User Default user name Default password
Maintenance user initial init
Building manager administrator admin

AE-200A/AE-50A
Ver. 7.97 and earlier

User Default user name Default password
Maintenance user initial init
Building manager administrator admin

Ver. 7.98 and later

User

Default user name

Default password"4*5

Example default password
(Serial number: 19672-123"6)

Maintenance user

initial

in “Serial number”

in19672123

Building manager

administrator

ad “Serial number”

ad19672123

*4  Default password for AE-200A/AE-50A updated to Ver. 7.98 or later from Ver. 7.97 or earlier
The default password varies with the version immediately before the update.
Default password for AE-200A/AE-50A when updated from a version earlier than Ver. 7.98

Version before the update

User

Default user name

Default password after the system has been

updated to Ver. 7.98 or later

Maintenance user | initial in “Serial number”
Ver. 7.10-7.12 — — -
Building manager | administrator ad “Serial number”
Maintenance user | initial init
Ver. 7.23-7.97 — — -
Building manager | administrator admin

*5

Default password for AE-200A/AE-50A to which the backup data from Ver. 7.98 or later was imported

If the settings data are backed up from the AE-200A/AE-50A that was logged in with the default password and are imported to the
AE-200A/AE-50A Ver. 7.98 or later, the new password will be the serial number of the AE-200A/AE-50A to which the data was

imported.
AE-200A/AE-50A

Software version: 7.98
Serial number: 31C71-101
Password of building manager: ad31C71101

444

Export
backup data
) I

AE-200A/AE-50A

Software version: 7.98
Serial number: 19272-124
Password of building manager: ad19272124

Import
backup data

444

*6 Serial number can be found on the login window of the LCD.
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[1] Keyboard screen

The entered characters will

appear here.

Arrow
Touch to move the cursor.

e
TR E1

aflofclallefNsNoflnfliflsfcilifio]
nflofoNallrHsNefullviull<Jlsf-]

Delete

Touch to delete one
character to the left of the
cursor.

OoOoEODOooOonoOoOon
|EEODOEEOoOEnnn
\OnO0nnn e |

iyl BN
Touch to display the

keyboard for entering lower- OK

case alphabetic characters. Touch to save the entered
characters and return to the
previous screen.

Touch to display the
keyboard for entering capital

alphabetic characters. Cancel

Touch to undo the changes
made and return to the
previous screen.

Touch to display the keyboard for
entering numeric characters and
symbols.

5-1-2. Locking the screen
Locking the screen prevents unauthorized users from accessing.

(1) To activate the screen lock function, set the [Screen
lock] setting to [Use] on the [Unit Info.] screen under the
[Initial Settings] menu.

If the screen lock function is activated, the screen locks
when the backlight turns off (after three minutes of not

touching the screen).
Note: The default setting is [Do not use].
Note: The screen lock function will not be activated when any
screen under the [Initial Settings] menu is open.

Disnlay Format
Date

31/12/2815
Temperature Language

Engl ish

Pressure unit|Screen lock

Time
18:00

(2) Touch [M]] on the login screen to lock the screen
immediately.

To unlock the screen, enter the same user name and
password used to log in.

Login / Panel cleaning

User name

Password

o : XXX
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5-1-3. Date and time

Touch [Initial Settings] in the menu bar, and then touch [Date and time].
Set the current date and time, and then touch [Save Settings].

Note:
Note:

Note:
Note:
Note:

Note:
Note:

Note:
Note:

Note

The date and time settings may not be accessible if logged in as a building manager.

The date and time settings made on this screen will be reflected on all the units in the M-NET system, all connected
AE-50/EW-50 units, and the AE-200 units whose [Time Master/Sub] setting is set to [Sub].

The date and time cannot be set on this screen if the [Time Master/Sub] setting is set to [Sub].

The daylight saving time setting is required only on the AE-200.

The date and time settings made on the AE-50/EW-50 unit whose [Time Master/Sub] setting is set to [Sub] will not be sent to
the other AE-50/EW-50 units.

If the current time is moved forward while the scheduled operation is performed, the operation that was scheduled to take
place during the time that was skipped will not be performed.

Changing the date and/or time when the charging function is in use can affect the calculation of the charges.

If the system is connected to a TG-2000A, make or change the settings from the TG-2000A.

When AE-50/EW-50 controller, DIDO controller (PAC-YG66DCA), Al controller (PAC-YGB63MCA), or Pl controller (PAC-
YG60MCA) is added to the system, set the current date and time on this screen to synchronize the date and time on the
added controller.

: Although date and time settings can be made on each AE-50/EW-50, the date and time synchronization from AE-200 is

performed once a day. Make the date and time settings on the AE-50/EW-50 only after the AE-50/EW-50 is replaced.

Important

e When one or more AE-50/EW-50 controllers are connected, the date and time settings must be made with the AE-50/EW-50
properly connected to ensure proper settings.

Current date and time
Set the current date and

Daylight saving time

time.

Touch to set the country
to automatically adjust the
daylight saving time.

Daylight saving changes

Custom settings

(1) Set the current date and time.

Edit

Save Settings

Edit

Touch to manually configure
the daylight saving time
setting.

Save Settings
Touch to save the changes
made.

(2) To automatically adjust the daylight saving time, touch the “Daylight saving time” button. Touch the applicable
country, and then touch [OK].

Note: When not using the daylight saving time function, touch “----.

Note: If the applicable country is not found, touch [Custom settings] at the bottom, and touch [OK]. Then, touch [Edit] to open
the screen below, and manually configure the daylight saving time setting.
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Note

e Message that will appear when the date and time have been reset
If the power supply is cut off for a long time due to power failure or other reasons, the date and time will be reset, and the

following popup message will appear when the power is turned on next. If this message appears, set the date and time
again.

Date and Time

tim

* This message will appear periodically until the date and time setting is made.
* If the controller is used without the date and time being set, the Schedule function or the Night Setback Control will not work properly.

* If the [Time Master/Sub] setting for the given controller is set to [Sub], temporarily change the setting to [Master], set the current date and
time, and then set the setting back to [Sub].
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5-1-4. Unit Information

Touch [Initial Settings] in the menu bar, and then touch [Unit Info.] or [Unit Info. 2].

Make necessary basic system settings such as unit settings, display format, sound/brightness settings, use or non-
use of test run, and display or non-display of room temperature/humidity, and then touch [Save Settings].

Note: The Unit Information settings may not be accessible if logged in as a building manager.

Unit Info.

Unit Information
Set the unit name and unit
ID.

Sound and brightness
Set the sound and
brightness levels.

Unit Info. 2

Air-conditioner Settings
Set the test run setting
and display option of room
temperature/humidity.

[1] Unit Information
Follow the instructions below to set the unit name, unit ID, and System Expansion setting.

A Initial [SESTNT)
Settings

Unit Information
Name

Mitsubishi Electric

Unit ID
6006081

(6 f
AE-288 M-NET

Volume Control
Sound

Unit Info.

System Exp
Expand

Brightness
100 %

Initial :
ENRITHEIIN A Functiont

Display Format
Date

Language

Temperature
°c

Pressure unit Screen lock

Brightness

Occupancy

Save Settings

Time

1

Unit Info.2

Air-conditioner Settings

Unit Info.2

Test run
Do not use

Advanced

Temperature display

Room temp.
(Always)

Humidity

Save Settings

OFF

Display Format
Set the screen display items.

Save Settings
Touch to save the changes
made.

Save Settings
Touch to save the changes
made.

(1) Touch the [Name] button to display the keyboard. Enter the unit name in 40 alphanumeric or symbol characters
or less. The name entered here will be used on the screen of the software that controls multiple AE-200 units

and will also be used as a sender name in the error notification e-mail and e-mail alarm.
Note: The following characters cannot be used: <, >, &, “, or*
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(2) Touch the [Unit ID] button to display the keyboard. Enter the unit ID in 6 figures. Use this setting to manage
the multiple unit IDs. The unit ID entered here will be used on the screen of the software that controls multiple
AE-200 units and will also be used as a sender ID in the error notification e-mail and e-mail alarm.

(3) When connecting one or more AE-50/EW-50 controllers, set the [System Exp] setting to [Expand].
Note: The [System Exp] section does not appear on this screen on the AE-50.
Note: When the [System Exp] setting is set to [Expand], make sure to make network settings for the AE-50/EW-50 controllers
on the [Network] screen. (Refer to section 5-1-5 “Network” for details.)

(4) When using an AE-200 apportioned electricity billing function or when not using an AE-200 M-NET, set the

[AE-200 M-NET] setting to [Do not use].
Note: When [Do not use] is selected, up to four AE-50/EW-50 controllers can be connected.
Note: The [AE-200 M-NET] section does not appear on this screen on the AE-50.
Note: The [AE-200 Apportion] section appears when “Charge” license is registered. To use an electricity charge apportioning
function of TG-2000A, set the [AE-200 Apportion] setting to [Do not use].

Initial Fu
VT X Pt X Fonctionz |
|« | Unit Info. Unit Info.
Unit Information Display Format
Name Date Time

Mitsubishi Electric 31/12/2015 18:00

Unit ID Sae B Temperature  Language

Pressure unit Screen lock

(6
AE-200 AE-208 Apportion m

Volume Contro 8/8 /=
Sound Brightness

Save Settings

[2] Sound and brightness

(1) Inthe [Sound] section, select the volume (Level 0-3) of the buzzer that sounds when the screen is touched.

(Level 0: No sound)
Note: Although the change will be reflected right away, it will not be saved until [Save Settings] is touched.

(2) Inthe [Brightness] section, select the brightness (70%, 80%, 90%, 100%) of the screen. (The greater the

value, the brighter the brightness.)
Note: Although the change will be reflected right away, it will not be saved until [Save Settings] is touched.

[3] Display Format

(1) Inthe [Date] section, select the desired display format for year, month, and date.
(2) Inthe [Time] section, select the desired display of time format.

(3) Inthe [Temperature] section, select the desired temperature unit [°C] or [°F].

(4) Inthe [Language] section, select the desired display language.

(5) Inthe [Pressure unit] section, select [MPa], [PSI], or [kgf/lcm?2].

(6) In the [Screen lock] section, select [Use] or [Do not use]. Select [Use] to activate the screen lock function. (Refer
to section 5-1-2 “Locking the screen” for details.)

(7) In the [Occupancy] section, make the Show/Hide setting for the occupancy/vacancy status that is detected
by the built-in occupancy sensor on the ME remote controller (North America: PAR-U01MEDU, Europe: PAR-
UO2MEDA).
Select [Hide] not to display the occupancy/vacancy status on the [Floor] or [Block] display.
Select [ & ] (blue) to display the occupancy icon when the sensor on the remote controller detects occupancy.
Select [ & ] (gray) to display the vacancy icon when the sensor on the remote controller detects vacancy.
Select[ & .~ & ] (blue/gray) to display the occupancy or vacancy icon according to the occupancy status of
the room.

Note: If the ME remote controller has no built-in occupancy sensor, the occupancy/vacancy icons will not be displayed on the
[Floor] or [Block] display.
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(8) In the [Brightness] section, make the Show/Hide setting for the brightness/darkness status that is detected
by the built-in brightness sensor on the ME remote controller (North America: PAR-UO1MEDU, Europe: PAR-
UO2MEDA).

Select [Hide] not to display the brightness/darkness icons on the [Floor] or [Block] display.
Select[ = ] (yellow) to display the brightness icon when the brightness level in the room reaches the
predetermined brightness level.
Select[ = ](gray) to display the darkness icon when the darkness level in the room reaches the
predetermined darkness level.
Select[ = = ](yellow/gray) to display the brightness or darkness icon according to the brightness/
darkness level of the room.
Note: If the ME remote controller has no built-in brightness sensor, the brightness/darkness icons will not be displayed on the
[Floor] or [Block] display.
Note: The brightness/darkness detection thresholds are set on the ME remote controller (North America: PAR-UO1MEDU,
Europe: PAR-U0O2MEDA)

[4] Air-conditioner Settings

(1) Inthe [Test run] section, select [Use] or [Do not use]. Select [Use] when performing a test run from the
operation settings screen, or when editing the electricity meter reading value on the [Measurement] display.

Editing measurement values

Moni t y 2
D feration il il 7
T Floor | oo TR O »)

Controller Exp1 RSN

Measurement value edit

\\

369, gokih 459324, 6kih

NORTH

EEER

694283, 91kih

1. Touch the “Measurement value edit” button to open the screen below.
Note: The “Measurement value edit” button will appear only when the [Test run] setting is set to [Use].

Mnnltor/
Operat ion

____Floor | Block If |

Edit the adjusted Edit the offset value

Offset
measurement value

Corrected Measurement value Offset

123457. 78 OISR NG EaN 123456, 78 NN

2. Touch the “Edit the adjusted measurement value” button. Enter the current electricity meter reading value,
and then touch [OK].

Note: Set the setting back to [Do not use] after completing a test run.

Note: The setting will go back to [Do not use] when the AE-200/AE-50 is turned off or restarted, or when the time on the
AE-200/AE-50 reaches 0:00 in the morning.

Note: Only the electric energy values on the [Measurement] display will change. This setting will not affect the energy-
control-related screens.

Note: To reset the adjusted measurement value to the original cumulative value, touch the “Edit the offset value” button
and set to “0”.
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(2) Inthe [Temperature display] section, select the desired display option for the room temperature or the set
temperature to be used on the [Floor] or [Block] display.
Select [Room temp. (Always)] to display the room temperature at all times, [Room temp. (During operation)]
to display the room temperature only during operation, [Set temp.] to display the set temperature at all times,
[Room temp.(Always)/Set temp.] to display both the room temperature and set temperature at all times, [Room
temp.(During op.)/Set temp.] to display the room temperature only during operation and to display the set
temperature at all times, and [Hide] not to display the room temperature or the set temperature.
Note: This setting is effective only on the LCD and will not be reflected to the Integrated Centralized Control Web.
Note: The room temperature shown may be higher than the actual temperature especially when the unit is stopped during
the Heat mode. Therefore, selecting [Room temp. (During operation)] is recommended when displaying the room

temperature.
Note: The outlet air temperature is displayed for the room temperature of outlet air temperature control units.

(3) In the [Humidity] section, make the Show/Hide setting for the humidity reading of the built-in humidity sensor
on the ME remote controller (North America: PAR-UO1MEDU, Europe: PAR-U02MEDA).
Select [ON] to display the humidity reading on the [Floor] or [Block] display.

Note: The table below summarizes the items that are displayed on the Monitor/Operation screen according to the combination
of the settings for “Temperature display” and “Humidity.”

Temperature display
Room temp.(Always)/
Room temp. (Always [
Humidity [ opr (Always)] Set temp ] _
[Room temp. (During [Set temp.] or Hide
operation)] [Room temp.(During op.)/
Set temp.]
OFF Upper: Room temp. Upper: Set temp. Upper: Room temp. Upper: N/A
Lower: N/A Lower: N/A Lower: Set temp. Lower: N/A
ON Upper: Room temp. Upper: Set temp. Upper: Room temp. Upper: N/A
Lower: Humidity Lower: Humidity Lower: Set temp. Lower: Humidity
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5-1-5. Network
Touch [Initial Settings] in the menu bar, and then touch [Network].
Make necessary basic system settings such as LAN settings, M-NET settings, and external input settings for each
AE-200, AE-50, and EW-50, and then touch [Save Settings]. A message will appear asking whether or not to restart
the controller. Touch [OK] to restart the AE-200/AE-50 to reflect the changes.
Note: The Network settings may not be accessible if logged in as a building manager.
Note: The [Controller] setting will appear (only on the AE-200’s LCD) when the [System Exp] setting on the [Unit Info.] screen is set
to [Expand]. Switch the [Controller] setting between [AE200] and [Exp1] through [Exp4] to make settings for each AE-200,
AE-50, and EW-50 individually.

Important

o Network settings for the AE-50/EW-50 must be made with the AE-50/EW-50 properly connected to ensure proper settings.
Those settings made without the connection of AE-50/EW-50 will not be reflected.

1st page
Controller
Select [AE] to make .
. M-NET Settings
settings for AE-200, and Control ler L¥LLR Mitsubishi Electric Set the M-NET address
select [1], [2], [3], or [4] and range of prohibited
to make settings for each LAN1 Settings M-NET Settings controllers.
AE-50/EW-50. IP Address M-NET Address
LAN1 Settings 192.168. 1.1
Set the IP address, subnet .
mask, and gateway address. Subnet Mask Range of Prohibited Control lers External Input Setting
Set the external signal input

MAC Address mode.
618283846586 External Input Setting

LAN common settings ON/OFF/Prohibit/Permit
Gateway (Pulse signal)

u n Save Settings
Touch to go to the next Save Settings

page. Touch to save the changes
made.

2nd page
Initial 5
A “Settings qunc!“’“l
<« | Unit Info.2 Advanced
Control ler LG Mitsubishi Electric
LANZ Settings
LAN2 Settings - d 18 21
Exclusively used for - - -
BACnet® function *1. Subnet Mask

255, 255. 255. 8
MAC Address
816263048586

LAN common settings
Gateway

u n Save Settings

Touch to go to the previous
page.

*1 BACnet® s a registered trademark of ASHRAE (American Society of Heating, Refrigerating and Air-Conditioning Engineers, INC.).
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(When connecting one or more expansion controllers)

q\ Initial
Settings

Groups

Control ler m Mitsubishi

Communication error detection Detect communication
IP address ‘ IP Ac Commun | ca Fror error
192.168.1. 1 Detect

192.168.1. 2 Do not detect

Save Settings

Touch to go to the previous Save Settings
page. Touch to save the changes
made.

[1] LAN1 Settings

LAN1 settings vary depending on whether the AE-200/AE-50 is connected to a dedicated LAN or an existing LAN.
See the sections below for how to set the AE-200/AE-50 IP addresses, subnet mask, and gateway addresses.
Although the settings for LAN1 and LANZ2 will appear on the screen, only the settings for LAN1 is required if the
BACnet® function is not used. Before making the settings, make sure that the LAN cable is connected to LAN1 port.

LAN1 Settings
IP Address
192.168.1.1

Subnet Mask

MAC Address

A182038485086

LAN common settings
Gateway

(1) LAN1 settings for connecting the AE-200/AE-50/EW-50 to a dedicated LAN

Settings for an AE-200
Note: See the procedures below when making LAN1 settings on the AE-50.

(1) Make sure that [AE200] is selected in the [Controller] section.

(2) Enter the AE-200’s IP address in the [IP Address] field. If the LAN has been newly set up, allocate IP
addresses to the AE-200 units in a sequential order starting with [192.168.1.1]. For example, the first
AE-200 unit will have an IP address of [192.168.1.1], the second AE-200 unit will have an IP address of
[192.168.1.2] and so on. (The same IP addresses cannot be used.)

Allocate IP addresses to the AE-50/EW-50 units in a sequential order starting with [192.168.1.211].

Note: The recommended IP address ranges are as follows.
AE-200: Between [192.168.1.1] and [192.168.1.40]
AE-50/EW-50: Between [192.168.1.211] and [192.168.1.249]
PC: Between [192.168.1.101] and [192.168.1.150]

Note: After the AE-200 IP address is changed, the AE-50/EW-50 power will be reset.

Note: A communication error “6920” will be detected by the AE-50/EW-50 when the AE-200’s IP address is changed
with the AE-50/EW-50 connected. In the [Communication error detection] section in the [Network] screen,
change the communication error detection setting for the previous IP address from “Detect” to “Do not detect.”

(3) Enter [255.255.255.0] in the [Subnet Mask] field (only when the IP address is [192.168.1.7]).
Note: If [255.255.255.0] is entered, set the IP addresses of all AE-50 units to [192.168.1.].
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(4) When monitoring the system remotely or using e-mail function via a dial-up router, enter the router IP
address in the [Gateway] field.
Leave the [Gateway] field blank when not connecting a dial-up router.
[192.168.1.254] is recommended for use as the IP address of the dial-up router. Refer to the dial-up router
instruction manual for details of how to set the IP address.
Note: [192.168.1.254] is recommended for use as the IP address of the dial-up router. Refer to the dial-up router
instruction manual for details of how to set the IP address.

Note: The use of a dial-up router with no modem requires a modem (for analog or ISDN) to be connected between the
router and the public phone line.

Settings for when connecting one or more AE-50/EW-50 controllers

LAN Settings
Dstn IP address

192.168. 1. 211

Version
Ver. X. XX (X.XX)

(1) Select [1], [2], [3], or [4] in the [Controller] section to make settings for each AE-50/EW-50.

(2) Enter the IP address of the AE-50/EW-50 that is connected to the AE-200 in the [Dstn IP address] field.
A message that indicates that the connection information of the AE-50/EW-50 is being collected will appear
for a few minutes.
Note: AE-50/EW-50 will not operate properly and the AE-50/EW-50 software version will not appear if the entered IP
address does not match the ones that have been set on the AE-50/EW-50.
Note: AE-50/EW-50 will not operate properly and the AE-50/EW-50 software version will not appear if the versions of
AE-200 and AE-50/EW-50 do not match regardless of the correctness of the entered IP address. Update the
software so that the versions match.

(2) LAN1 settings for connecting the AE-200/AE-50 to an existing LAN

(1) When connecting the AE-200/AE-50 to an existing LAN, consult the system administrator to decide the IP
addresses, subnet mask, and gateway addresses.

(3) LAN2 settings for connecting the AE-200/AE-50 to a dedicated LAN

(1) Do not use the LAN2 port.
Note: Change the LAN2 IP address only when the LAN1 IP address is required to be set to [192.168.2.1].

(4) LAN2 settings for connecting the AE-200/AE-50 to an existing LAN

(1) Do not use the LAN2 port.
Note: Change the LAN2 IP address only when the LAN1 IP address is required to be set to [192.168.2.1].

[2] LAN2 Settings
LANZ2 port is exclusively used for BACnet® function.

For how to make BACnet® function settings, refer to the Instruction Book (BACnet® function).
Note: An IP address set using LAN1 should not be used as a LAN2 IP address.

[3] M-NET Settings
Note: Make the M-NET settings only on the AE-200.

M-NET Settings
M-NET Address

Range of Prohibited Controllers
SC/RC

(1) Switch the [Controller] setting between [AE200] and [Exp1] through [Exp4] to make settings for each AE-200,
AE-50, and EW-50 individually.

(2) Enter [0] in the [M-NET Address] field (unless otherwise specified).
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(3) Select [SC/RC] to prohibit the operation from both the sub system controllers and the remote controllers.
Select [RC Only] to prohibit the operation only from the remote controllers.

[4] External Input Setting

Using the external signal input function, the following types of collective operations can be performed for all
connected air conditioning units: Demand level, Emergency stop, ON/OFF operation, and Prohibit/Permit local
remote controller operation.

A separately-sold external input/output adapter (PAC-YG10HA-E) is required.

Note: Make the M-NET settings only on the AE-200.

Note: A separate license is required to activate the Peak Cut control using the external input function. Make sure that the required
license has properly been registered on the [License] screen. (Refer to section 4-5 “License registration for optional
functions” for details.)

External Input Setting

ON/OFF/Prohibit/Permit
(Pulse signal)

(1) Switch the [Controller] setting between [AE200] and [Exp1] through [Exp4] to make settings for each AE-200,
AE-50, and EW-50 individually.

(2) Select [Demand (Level signal)/Not in use], [Emergency Stop (Level signal)], [ON/OFF (Level signal)], or [ON/
OFF/Prohibit/Permit (Pulse signal)]. Refer to the Technical Manual for details.

[5] Communication error detection
By switching the communication error detection setting, communication error between AE-200 and AE-50/EW-50

(6920) can either be detected or not detected by the AE-50/EW-50.
Note: This settings screen will appear when making the settings for AE-50/EW-50 on the AE-200’s LCD, or when making the
settings on the AE-50’s LCD.
Note: When the IP address of AE-200 is changed, make sure to set the communication error detection setting for the IP address
of the AE-200 before change to “Do not detect.” If not set, AE-50/EW-50 will detect a “6920” error for the IP address of the
AE-200 before change.

Initial ;
A Settings = Function?

Advanced Network Groups

Control ler m Mitsubishi

Communication error detection Detect communication
IP address of AE-200 IP A Communica " error
192.168. 1. 1 Detect t Select whether “Detect

| Detect ] or Do not detect

communication error for
192.168.1. 2 Do not detect each IP address.

Save Settings

Touch to go to the previous Save Settings
page. Touch to save the changes
made.

(1) Select whether “Detect” or “Do not detect” communication error for each IP address.
Select “Detect” for the IP address of the AE-200 that is connected.
Select “Do not detect” for the IP address of the AE-200 that is not currently connected.

WT07627X17 42



5-1-6. Groups
Touch [Initial Settings] in the menu bar, and then touch [Groups].
Register the groups of air conditioning units (including outlet air temperature control units), LOSSNAY units
(ventilators), Air To Water (PWFY) units, AHC, HWHP (CAHV, CRHV) units, chiller units, MEHT-CH&HP units, or
general equipment to be connected to the AE-200/AE-50/EW-50, and then touch [Save Settings].
Note: Register HWHP (QAHV) units by following the procedure in section 5-1-7 “HW Supply”.
Note: Some settings may not be accessible if logged in as a building manager.
Note: If the system is connected to a TG-2000A, make or change the settings from the TG-2000A.
Note: The [Controller] setting will appear (only on the AE-200’s LCD) when the [System Exp] setting on the [Unit Info.] screen is set
to [Expand]. Switch the [Controller] setting between [AE200] and [Exp1] through [Exp4] to make settings for each AE-200,
AE-50, and EW-50 individually.
Note: When registering LOSSNAY units or OA Processing units, do not combine the units that support Night Purge function and
the units that do not in one group.

Important

e Group settings for the AE-50/EW-50 must be made with the AE-50/EW-50 properly connected to ensure proper settings.
Those settings made without the connection of AE-50/EW-50 will not be reflected.
e The units connected to AE-200 cannot be grouped together with the units connected to AE-50/EW-50.

Initial -
b i !lunc!nonl
etk

Controller

Select [AE] to make Controller [0l Mitsubishi AHC registration
settings for AE-200, and
select [1], [2], [3], or [4] Entrance 1 Remote controller
to make settings for each m registration
AE-50/EW-50.
Group No. 2202

System controller
1082 registration

Group name

Unit selection g 203

w7 = 163

Save Settings

Save Settings
Touch to save the changes
made.

[1] Setting group names

(1) Touch the “Group name” button to display the keyboard. Enter the group name in 20 alphanumeric or symbol

characters or less.
Note: The following characters cannot be used: <, >, &, “, or*
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[2] Registering air conditioners, Air To Water (PWFY) units, LOSSNAY units, HWHP (CAHV, CRHV)
units, chiller units, or MEHT-CH&HP units to a group

(1) To register air conditioners, Air To Water (PWFY) units, Group Entrance 1
LOSSNAY units, HWHP (CAHV, CRHV) units, chiller units, [gmay TR
and MEHT-CH&HP units to each group, touch the “Unit [1] B
selection” button under the target group name. A screen to |tz
select the units will appear. =]

Select the group type in the [Model] section, and select 48 Jf 49 |f 50 |
the address numbers of the units to be registered.
The selected unit addresses will appear with an orange

frame. Touch again to deselect. o

Note: Each group of air conditioners, Air To Water (PWFY) units,
LOSSNAY units, and HWHP (CAHV, CRHV) units can
contain up to 16 units.

Note: Each group of chiller units can contain up to 6 units.
Register chiller units EACV-P900*** and
EACV-P1500/1800*** to different groups. As for
EACV-P1500/1800*** units, register system leader units
and simultaneous operation units to different groups.

Note: Each group of MEHT-CH&HP units can contain up to 1
unit.

Note: Units other than general equipment cannot be combined
with general equipment in one group. To register general
equipment to a group to which units other than general
equipment are already registered, delete the existing
registration first before registering general equipment to it.

Note: Units other than outlet air temperature control units cannot
be combined with outlet air temperature control units in
one group.

Note: The addresses of the units that have been registered
to other groups will appear with a gray background and
cannot be selected.

Note: When connecting chiller units and other units together,
count each chiller unit and MEHT-CH&HP unit as three air
conditioning units, and make sure the number of units that
are equivalent to the number of air conditioning units will
not exceed 50 units.

(2) To change the unit icon to be used, touch the icon. A
screen to select an icon will appear. Select an icon to be
used, and touch [OK].

Group1 Entrance 1
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[3] Registering remote controllers to a group

(1) To register remote controllers to a group, touch the
“Remote controller registration” button under the target
group name. A screen to select the units will appear. HemutepConiioliley

Groun1 Entrance 1

Select the address numbers of the remote controllers to
be registered.

The selected unit addresses will appear with an orange
frame. Touch again to deselect.

Note: Each group can contain up to two remote controllers.

Note: Each group can contain up to four remote and system
controllers combined.

Note: MA remote controllers do not need to be registered to a

group.

[4] Registering system controllers to a group

(1) To register system controllers to a group, touch the
“System controller registration” button under the target
group name. A screen to select the units will appear. ) Bl

Groun1 Entrance 1

Select the address numbers of the system controllers to
be registered.

The selected unit addresses will appear with an orange
frame. Touch again to deselect.

Note: Each group can contain up to four remote and system
controllers combined.

[5] Registering AHC to a group

(1) To register AHC to a group, touch the “AHC registration”
button under the target group name. A screen to select the
unit will appear.

Group1 Entrance 1

(201 202 20 34 205 20620 20 09 210
Select the address number of the AHC to be registered. 211)[212][213) 215) 216 [218]{219 {220
The selected unit address will appear with an orange 221222223 | 224 | 225 || 226 || 227 || 228 | 229 | 230|
frame. Touch again to deselect. 231l 232} 233} 235 236 238|239
241 Jf2u2 1243 204 205 | 246 249 ][ 250)

Note: Each group can contain one AHC.
Note: AHC must be registered to a group in which air
C |
conditioners are registered. Do not register AHC to a group “

in which units other than air conditioners are registered.
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[6] Registering general equipment to a group

(1) To register general equipment to a group, touch the “Unit
selection” button under the target group name. A screen to
select the units will appear.

Select [General Equipment (via PAC-YG66DCA)] in the
[Model] section, and select the unit address of the DIDO
controller (PAC-YG66DCA) that is connected to the
general equipment to be registered.

The selected number will appear with an yellow-green
frame.

Then, select contact points to which the general equipment
are connected, and touch the address assigned to another
unit to register the first selected item to the group. The
yellow-green frame will change to an orange frame. (The
item with a yellow-green frame is the currently selected
unit, and the ones with an orange frame are the units that
are already registered to a group.)

Touch again to deselect.

Each contact of DIDO controller counts as one unit.
Each group can contain up to 16 general equipment.

Up to six general equipment can be registered for each
DIDO controller.

Units other than general equipment cannot be combined
with general equipment in one group. To register general
equipment to a group to which units other than general
equipment are already registered, delete the existing
registration first before registering general equipment to it.
General equipment groups cannot include remote
controllers or system controllers.

Note:
Note:
Note:

Note:

Note:

(2) To change the unit icon to be used, touch the icon under
the [Icon] section. A screen to select an icon will appear.
Select an icon to be used, and then touch [OK].

@)

Groun4 Meettina room

[Model |
General Eaquipment
(via PAC-YG66DCA)

|Unit Address

71

Er— 11 12 [ 13 12 [f 15 16 § 17 ]

(3¢
(38 3 | 46 |
45 [ 46 [ a7 [ a3 [ 49 | 58

No operations
(Monitor only)

Honitor | Contact Points

Output status I 2

In the [Allow Operations] section, make the setting to allow or disallow operation.

Select [In batch and on individual group] to allow the operator to turn on or off the general equipment

collectively or by the groups.

Select [On individual group] to allow the operator to turn on or off the general equipment by the groups.
Select [No operations (Monitor only)] to disallow the operator to turn on or off the general equipment.

(4)

the [Monitor/Operation] menu screen.

In the [Monitor] section, select which status will be used to reflect the units’ ON/OFF status to the unit icons on

Select [Output status] to use the status that is sent to the general equipment, and [Input status] to use the

status that is sent from the general equipment.
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5-1-7. HW Supply
Touch [Initial Settings] in the menu bar, and then touch [HW Supply].
Set the address, group names, and detail settings for each group of HWHP (QAHV) unit that is connected to
AE-200/AE-50/EW-50. Touch [Save Settings] when done.
Note: Group settings for HWHP (QAHV) units can only be set on the AE-200/AE-50’s LCD.
Note: The HW Supply settings may not be accessible if logged in as a building manager.
Note: The [Controller] setting will appear (only on the AE-200’s LCD) when the [System Exp] setting on the [Unit Info.] screen is set
to [Expand]. Switch the [Controller] setting between [AE200] and [Exp1] through [Exp4] to make settings for each AE-200,
AE-50, and EW-50 individually.

Important

e Settings must be made while communication between HWHP (QAHV) and AE-200/AE-50/EW-50 is established. HWHP
(QAHYV) units cannot be connected in the EW-50 system.

e Group settings for the AE-50/EW-50 must be made with the AE-50/EW-50 properly connected to ensure proper settings.
Those settings made without the connection of AE-50/EW-50 will not be reflected.

e The units connected to AE-200 cannot be grouped together with the units connected to AE-50/EW-50.

Initial :
‘\ Settings : Functionl

Inter lock HW Supply

Controller
Select [AE] to make Control ler m Mitsubishi Unit selecti
settings for AE-200, and nit selection
select [1], [2], [3], or [4]
to make settings for each

AE-50/EW-50. Detail settings

Group name

Group icon

Indicates group’s operation
status (normal/error).

A question mark indicates
that the initial startup
procedure has not been
completed.

Save Settings 4-— Save Settings
Touch to save the changes
made.

[1] Setting group names

(1) Touch the “Group name” button to display the keyboard. Enter the group name in 20 alphanumeric or symbol

characters or less.
Note: The following characters cannot be used: <, >, &, “, or*

[2] Registering HWHP (QAHV) units to a group

(1) To register HWHP (QAHV) units to each group, touch the  [FaT RN,
“Unit selection” button located at the right of the target
group name.

A screen to select the units will appear.

Select the address numbers of the units to be registered.
The selected unit addresses will appear with an orange
frame. Touch again to deselect.

31 [32)f33

Note: Up to 16 HWHP (QAHV) units can be registered to each o || cancel
group, and up to 24 systems can be registered to each
AE-200/AE-50/EW-50.

Note: When controlling HWHP (QAHV) units, air conditioning
units, and other equipment under the same AE-200/AE-50/
EW-50, count each HW Supply units as equivalent to two
air conditioning units, and make sure the number of units
that are equivalent to the number of air conditioning units
will not exceed 50 units.

Note: HWHP (QAHV) units and other models of units cannot be
registered to the same group.
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(2) To change the unit icon to be used, touch the icon.
A screen to select an icon will appear. Select an icon to be
used, and touch [OK].

Hot Water Supply1

[3] Initial startup of HWHP (QAHV)

(1) When done registering all HW Supply unit groups, touch
[Save Settings].
Initial startup procedure for HW Supply units will start.
When the process is completed, the icon will change to
indicate its completion.

Note: Initial startup procedure will take 2 to 5 minutes.
Note: If an error occurs during the initial startup procedure,
check HWHP (QAHV) units for proper connections.

Initial startup procedure | Initial startup procedure
not complete complete

& | &

[4] Detail settings for HWHP (QAHV) units

Error

(1) Inthe [HW Supply] screen, touch the “Detail settings” |
Hot Water Supply1
button.
The detail settings window will appear. Hodsiset o f | o s
Note: Only the “Detail settings” buttons for the HW Supply m i m .

groups whose initial startup procedure has been

Completed are aVailabIe for SeleCtion. Op. OFF sensor Op. ON dif |

(2) Set the settings that are related to operation modes under wode S 0o, 0N sensor 00, OFF senser 0o, O differential
“Mode setting.”
Set the number corresponding to the sensor to be used to Control setting
determine the “Thermo-ON” status under “Operation ON *
sensor.”

Set the number corresponding to the sensor to be used

to determine the “Thermo-OFF” status under “Operation
OFF sensor.”

Set “Operation ON differential” to a temperature between
0.5°C (1°F) and 23.0°C (46°F).

Units will start operating when the differential between the
set temperature and the temperature setting for “Operation
ON sensor” exceeds the value set for “Operation ON
differential.”

40.0 °C
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Note: Specify the “Operation ON sensor” with a number equal to or smaller than that of the “Operation OFF sensor.”
Note: Operation will be carried out as shown in the figure below when “Sensor 1” is set for “Operation ON sensor” and “Sensor
3" is set for “Operation OFF sensor” in [Mode setting] for 3-sensor-type model of units.

Operation starts when the formula “Sensor 1 temperature
< (Set temperature - Operation ON differential)” is
satisfied.

Outlet HW temperature

|

Outlet HW temperature

-]

Operation ends when the formula “Sensor
3 temperature > Set temperature” is
satisfied.

Sensor 1

Sensor 1

Sensor 2

Sensor 2

Sensor 3

Note: Operation will be carried out as shown in the figure below when “Sensor 1” is set for “Operation ON sensor” and “Sensor
6" is set for “Operation OFF sensor” in [Mode setting] for 6-sensor-type model of units.

Operation starts when the formula “Sensor 1 temperature
< (Set temperature - Operation ON differential)” is
satisfied.

Outlet HW temperature

Sensor 4

Sensor 5

Tank 2

e

Outlet HW temperature

Sensor 4

Sensor 5

——

Sensor 6

Operation ends when the formula “Sensor
6 temperature > Set temperature” is
satisfied.

(3) Set “Outlet HW ” to a temperature between 40.0°C (104°F) and 90.0°C (194°F).
(4) Touch [OK] to enable the settings.

[5] Completing the settings for HWHP (QAHV) units

(1) When done setting the detail settings for all HW Supply unit groups, touch [Save Settings].
Note: It takes 2 to 5 minutes to transmit the settings.
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5-1-8. Interlocked LOSSNAY
The ON/OFF status of the LOSSNAY unit can be interlocked with the operation of indoor units.
Touch [Initial Settings] in the menu bar, and then touch [Interlock]. Set the interlocking conditions for each AE-200,

AE-50, and EW-50, and then touch [Save Settings].
Note: The Interlocked LOSSNAY settings may not be accessible if logged in as a building manager.
Note: If the system is connected to a TG-2000A, make or change the settings from the TG-2000A.
Note: The ON/OFF status of the indoor units are not interlocked with the ON/OFF status of the LOSSNAY unit.
Note: The [Controller] setting will appear (only on the AE-200’s LCD) when the [System Exp] setting on the [Unit Info.] screen is set
to [Expand]. Switch the [Controller] setting between [AE200] and [Exp1] through [Exp4] to make settings for each AE-200,
AE-50, and EW-50 individually.

Important

e Interlock settings for the AE-50/EW-50 must be made with the AE-50/EW-50 properly connected to ensure proper settings.
Those settings made without the connection of AE-50/EW-50 will not be reflected.

e The interlock LOSSNAY settings between the units connected to the AE-200 and the AE-50/EW-50 cannot be made on this
screen, but can be made on the Interlock Control settings screen. (Refer to section 6-7 “Interlock Control” for details.)

,\ Initial A
Settings
Controller n Interlock Blocks

Select [AE] to make
settings for AE-200, and Control ler Exp1 RYHRENHELT Interlocked indoor unit

select [1], [2], [3], or [4] — registration
to make settings for each — — 1 4 5 & 3 Touch to display the screen
Interlocked LOSSNAY unit < - conditioners.
nterlocke uni - —

Touch to display the screen

for registering the LOSSNAY =
unit. = _—
[ BT
& 8

Save Settings

Save Settings
Touch to save the changes
made.

(1) Touch the “Interlocked LOSSNAY unit registration” button.
A screen to select the units will appear.
Select the address number of the LOSSNAY unit to be Inferlockeaib IS
registered. The selected unit address will appear with an (3l 4 ]
orange frame.
Touch again to deselect.

(2) Touch the “Interlocked indoor unit registration” button. A
screen to select the units will appear.
Select the address numbers of the indoor units to which nefotle I o5
the selected LOSSNAY unit will be interlocked. The @n@

[«][s]
selected unit addresses will appear with an orange frame. --
24 1 25 |

Touch again to deselect. 21 [ 22 ] 23
Note: Each LOSSNAY unit can be interlocked with up to 16 air
conditioners.
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5-1-9. Blocks

By making block settings, multiple groups in a given block can be collectively monitored or operated.
Touch [Initial Settings] in the menu bar, and then touch [Blocks]. Register the groups to each block, and then touch
[Save Settings].
Note: Some settings may not be accessible if logged in as a building manager.
Note: If the system is connected to a TG-2000A, make or change the settings from the TG-2000A.
Note: The [Controller] setting will appear (only on the AE-200’s LCD) when the [System Exp] setting on the [Unit Info.] screen is set
to [Expand]. Switch the [Controller] setting between [AE200] and [Exp1] through [Exp4] to make settings for each AE-200,
AE-50, and EW-50 individually.
Note: The ventilation will stop when the Peak Cut control runs for the LOSSNAY units or OA Processing units that perform Night
purge operation. For this reason, do not register the LOSSNAY units and OA Processing units that perform Night purge
operation in the same block.

Important

e Block settings for the AE-50/EW-50 must be made with the AE-50/EW-50 properly connected to ensure proper settings.
Those settings made without the connection of AE-50/EW-50 will not be reflected.

,\ Initial
Settings

Controller n Interlock

Select [AE] to make ~
settings for[AE-]ZOO, and Controller m Mitsubishi
select [1], [2], [3], or [4]
to make settings for each Entrance
AE-50/EW-50. 1 Entrance 1 6 Waiting room
Block No.

Lobby
Block name Group name
2 %2 Lobby A

Group No.
“AE-50 No. - Group No.” Lobby
S8 3 Lobby B
,’

will appear if one or more
AE-50/EW-50 controllers are
connected.

Group registration

Save Settings

Save Settings
Touch to save the changes
made.

(1) Touch the “Block name” button to display the keyboard. Enter the group name in 20 alphanumeric or symbol
characters or less.
Note: The following characters cannot be used: <, >, &, “, or

(2) Touch the “Group registration” button of the target block. A
screen to select the groups will appear.
Touch the group numbers to be registered. (The name of Group2 Lobby (South)
the group that was touched last will appear.) @@@

The selected group numbers will appear with an orange

frame. Touch again to deselect.
Note: HWHP (CAHV, CRHV, QAHV) unit groups, chiller unit
groups, and MEHT-CH&HP unit groups cannot be
registered to a block.

| 3 | 5 [l |

‘ 0K I| Cancel I
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5-1-10. EM Blocks

Carrying out EM block (energy management block) settings enables batch status monitoring and operation of

multiple blocks covering AE-200/AE-50/EW-50.

Touch [Initial Settings] in the menu bar, and then touch [EM Blocks]. Register the blocks to each EM block, and then

touch [Save Settings].

Note: Some settings may not be accessible if logged in as a building manager.

IELH?,',QS : Functionl t Function2

EM Block Floor Layout

EM block No. Entrance

1 Entrance 4 Meeting room

Lobby
2 Lobby A 3 Lobby B

EM block name _
registration Tenant

5 Tenant A 6 Tenant B

EM block registration
Meeting room

8 Meeting room 9 Meeting room

System View

7 Tenant C

Save Settings

(1) Touch the “EM block registration” button of the target EM
block. A screen to select the blocks will appear.

Block No.

“AE-50 No. - Block No.”

will appear if one or more
AE-50/EW-50 controllers are
connected.

Block name

Save Settings
Touch to save the changes
made.

EM Block1 Entrance

Block
Block1 Entrance

‘ 0K H Cancel |

(2) Switch to the controllers ([AE200], [Exp1] through [Exp4]) to which the blocks to register belong.

(3) Touch the block numbers to be registered. (The name of the block that was touched last will appear.)

The selected block numbers will appear with an orange frame. Touch again to deselect.

Note: To select a LOSSNAY unit that is interlocked with indoor units, touch the El button and select an address number.

(4) Touch the “EM block name registration” button to display the keyboard. Enter the EM block name in 20

alphanumeric or symbol characters or less.
Note: The following characters cannot be used: <, >, &, “, or*
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5-1-11. Floor Layout
The floor layout on the [Floor] display under the [Monitor/Operation] menu can be changed, and the display position
of the groups on the floor can be changed.
Touch [Initial Settings] in the menu bar, and then touch [Floor Layout]. All unit groups that are under the control of
both AE-200 and AE-50 can be displayed on the Floor Layout screen of the AE-200.
Note: Some settings may not be accessible if logged in as a building manager.
Note: Up to 30 groups can be assigned to each area.
Note: Groups of air conditioners, Air To Water (PWFY)) units, LOSSNAY units, and general equipment can be assigned to the floor
layout.

Important

e Although the Floor Layout settings can also be made on the AE-50’s LCD, only the unit groups that are under the control of
AE-50 controllers can be set on the AE-50’s LCD.

e In independent EW-50 systems, setting of the floor layout using the Initial Setting Tool is possible. (Refer to section 6-5 “Floor
Settings” for details.)

nitial
Settings

Floor selection

Area selection
1F Lobby

Unassigned groups — I:H:H:l
Touch to display the groups &7
that have not been assigned

to an area. P
A o A

Basic floor settings :
Save Settings

Save Settings
Touch to save the changes
made.

Cut
Paste

[1] Basic floor settings

(1) Touch the “Basic floor settings” button to display the
basic floor settings screen.

Total Floors oor Name

0 .
Floor Lavout F Tenant floor
v

Floor plan (988 x 1898 dots)

Read from USB Memory

Gridline HWidth of movement

=
A

(2) Touch [A][¥] to set the total number of floors, and select Total Floors
the floor layout to be used. u
Note: If the total number of floors is set to “--,” none of the
floor layouts can be selected. n
Note: Up to ten floors can be registerted. Floor Layout
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@)

(4)

®)

(6)

The display range of the area on the [Floor Layout] screen vary, depending on the selected floor layout.

Floor layout Display area Floor layout Display area

I
ol

Touch the “Floor level name” button to display the
keyboard. Enter the floor level name in 3 alphanumeric
or symbol characters or less.

Then, touch the “Floor name” button to display the
keyboard. Enter the floor name in 20 alphanumeric or
symbol characters or less.

To read floor plan files from the USB memory, touch
[Read from USB Memory]. Refer to [2] below for the
restrictions on the floor plan files to be read.

To set the width of the gridlines on the floor layout
screen, touch [Gridline], and switch between [Do not
show] and [Show].

To change the icon movement width when moving icons
on the floor layout screen, touch [Width of movement],
and switch between [Small], [Middle], and [Large].

Small Middle

Floor level name

Floor name

Floor plan (988 x 1898 dots)
Read from USB Memory

Gridline HWidth of movement

Show Middle

Gridl ine HWidth of movement

Show Middle

[2] Restrictions on the floor plan files to be read

File size 630 dots
—>

450 dots $ H

900 (height) x 1890 (width) dots for each floor plan
Note: The file size must be 900 (height) x 1890 (width) dots regardless of the display range of the area. (Even
when the floor layout shows only one display area, the file size must be 900 (height) x 1890 (width)
dots. In this case, create a file plan only in the left top area.)

]}300 dots

1890 dots

File format

gif

cannot be read.

Note: Files that contain extension data (metadata such as XMP, transparent GIF, interlace GIF, animated GIF)
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Floor *1 File name Floor *1 File name
1 floor_01.gif 6 floor_06.gif
2 floor_02.gif 7 floor_07.gif
3 floor_03.gif 8 floor_08.gif
File name 4 floor_04.gif 9 floor_09.gif
5 floor_05.gif 10 floor_10.gif
*1 The floor numbers in the table are not the actual floor level name, but the number counted from the bottom on the [Floor
Layout] screen. Even if the floor level name is set to “15F,” the file name will be “floor_01.gif” when the floor is the first
floor in the setting.
File location In the root folder of the USB memory
R G B R G B R G B R G B
224 71 72 101 112 150 130 150 153 176 255 185
221 151 152 126 137 176 105 134 135 238 255 240
81 66 81 142 149 175 37 96 86 154 255 163
105 89 105 175 180 199 204 214 211 198 255 203
17 16 17 33 77 225 48 64 59 106 255 116
51 42 52 37 83 234 250 255 253 137 255 144
27 23 30 39 86 240 227 255 243 226 252 227
165 145 185 41 89 245 241 255 248 124 233 125
33 37 57 42 92 249 237 249 243 250 255 250
2 17 85 46 93 246 67 97 79 167 229 166
6 35 160 23 47 124 59 78 66 107 145 104
6 28 122 63 104 238 61 116 80 182 211 180
9 40 168 77 116 241 85 128 100 23 95 15
12 45 176 99 137 255 154 177 162 149 211 141
154 162 194 126 146 214 14 45 24 128 140 126
211 214 227 149 170 235 59 93 70 95 202 74
15 49 182 70 79 108 178 187 181 194 231 186
17 53 188 179 189 222 46 181 88 147 169 142
20 57 195 191 202 230 59 157 90 41 177 3
24 64 205 192 210 241 90 213 129 166 203 154
17 46 149 163 170 180 214 255 225 208 224 202
21 52 163 236 242 250 224 239 228 219 235 211
28 70 215 159 185 210 129 155 135 172 187 164
32 64 178 144 154 162 178 194 182 203 211 197
45 80 204 204 228 245 115 255 143 241 244 238
44 75 190 112 183 219 99 193 117 199 201 195
55 90 213 126 139 145 182 201 185 110 114 98
69 99 205 214 241 251 59 255 88 127 129 119
99 122 202 159 240 253 19 255 48 210 211 196
Available colors
(RGB) to be R G B R G B R G B R G B
/ ) 255 253 185 179 159 1 225 148 50 195 195 195
used in the file 193 193 150 172 169 147 214 159 89 193 193 193
255 255 221 187 185 169 77 76 75 191 191 191
121 121 106 179 177 162 230 211 206 189 189 189
162 162 147 205 203 187 207 203 202 185 185 185
142 142 129 224 222 206 225 197 192 179 179 179
94 94 89 212 201 139 225 8 8 173 173 173
212 212 203 136 134 122 221 179 179 171 171 171
235 235 227 158 156 143 152 151 151 169 169 169
213 213 207 217 215 202 255 255 255 166 166 166
203 203 198 230 228 216 250 250 250 161 161 161
137 137 134 142 128 71 249 249 249 154 154 154
116 116 114 254 246 220 246 246 246 148 148 148
245 245 242 244 237 215 243 243 243 143 143 143
85 85 84 33 25 2 241 241 241 133 133 133
121 121 120 111 110 107 239 239 239 129 129 129
253 253 252 63 43 4 236 236 236 103 103 103
119 117 23 106 104 100 232 232 232 82 82 82
255 253 143 133 132 130 228 228 228 70 70 70
253 241 7 116 79 14 225 225 225 64 64 64
174 173 157 254 251 246 220 220 220 58 58 58
208 195 0 255 151 0 217 217 217 51 51 51
220 210 64 93 61 13 215 215 215 44 44 44
156 153 113 254 221 171 211 211 211 41 41 41
201 199 175 157 97 18 209 209 209 34 34 34
151 150 136 211 205 197 207 207 207 4 4 4
187 175 71 205 128 31 205 205 205 0 0 0
195 193 175 187 116 28 202 202 202 255 170 63
198 197 187 219 138 35 198 198 198 255 203 131
* Use the colors in the table above, otherwise the floor plan will appear in different colors.
* The default background color is RGB [103, 103, 103].
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[3] Moving a group to other areas

(1) On the [Floor Layout] screen, touch the group icon to
be moved. The selected group icon will appear with an
orange frame.

Note: When the “Unassigned groups” button is touched,
groups that have not been assigned to any area will
appear in the order of their group numbers. (Up to 30
groups will appear in an area.)

(2) Touch [Cut].
The orange frame will change to a pale orange frame.

(3) With the pale orange frame being displayed, select the
area to move the group to, and touch [Paste] to move
the selected group to the selected area.

Note: A popup message will appear when you touch the item
in the menu bar or sub menu bar to see other screens
without the changes being saved. Note that the changes
will NOT be saved unless the [Save Settings] button is
pressed.
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(4) Touch [Save Settings].
Note: To move the pasted group icon within the area, refer to [4]
“Moving a group within the area” below.

[4] Moving a group within the area

Note: It is recommended to use a commercially available touch pen.

(1) On the [Floor Layout] screen, touch the group icon to
be moved. The selected group icon will appear with an
orange frame.

(2) Touch and hold the group icon for one second. The

orange frame will change to an yellow-green frame.
Note: The group icons cannot be moved on the screen that
appears when the “Unassigned groups” button.

(3) Drug and drop the icon to move anywhere within the
area.

(4) Touch [Save Settings].
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5-1-12. System View
Refrigerant system information (connection information of outdoor and indoor units) can be checked for each AE-200,
AE-50, and EW-50.
Touch [Initial Settings] in the menu bar, and then touch [System View].

Note: This screen shows the information of the units that have been registered to a group and have started up successfully.

Note: The [Controller] setting will appear (only on the AE-200’s LCD) when the [System Exp] setting on the [Unit Info.] screen is set
to [Expand]. Switch the [Controller] setting between [AE200] and [Exp1] through [Exp4] to display the information for each
AE-200, AE-50, and EW-50 individually.

Initial ' ®
A ki

EM Block Floor Layout System View
Indoor unit address

Control ler m Mitsubishi
Unit address of the indoor

or Unit (Sub unit) Indaor Umt:z-‘/ units that are connected to

the outdoor unit will appear.
1.2 &8 218 Air to Water (PWFY) units
will appear, and LOSSNAY,
HWHP (CAHV, CRHY,
QAHV) units, chiller units,
and MEHT-CH&HP units will
not appear.

Controller

Select [AE] to display the
information for AE-200, and
select [1], [2], [3], or [4] to
display the information for
each AE-50/EW-50.

11 12 13 14 15 16
Outdoor unit address J

“Unit address of the main 67 17
unit (Unit address of the sub
unit)” will appear.

18

(1) Switch the [Controller] setting between [AE200] and [Exp1] through [Exp4] to check the system information for
each AE-200, AE-50, and EW-50 individually. (Only on the AE-200’s LCD)
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5-1-13. Advanced settings
Touch [Initial Settings] in the menu bar, and then touch [Advanced].

Make necessary settings, and then touch [Save Settings].
Note: The Advanced settings may not be accessible if logged in as a building manager.

q\ Initial ;
Settings

n Advanced Network Groups

. Advanced Setting
Time Master/Sub Time Master/Sub

Master
Old model compatibility

mode k 0ld model compatibility mode Hold type
OFF

Schedule: Season setting
Available

Hold type

Schedule: Season setting

Save Settings

Save Settings
Touch to save the changes
made.

[1] Time Master/Sub

The default setting is [Master].

This setting is required to change only for a system with multiple AE-200 controllers connected to an AE-50
controller (System configuration (1) below).

System configuration

—— : Time setting flow

: [Time Master/Sub] setting

(1) System with multiple AE-200 controllers connected to an AE-50 controller

Set to [Master] on only one of the AE-200 controllers in a system.

AE-200 ] > ; —
|:|, AE-50 Outdoor unit Indoor unit
AE-200
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(2) System with an AE-200 controller connected to AE-50 controllers

Leave the default setting [Master] as it is.

| —> — -
- e —
AE-200 - AE-50 QOutdoor unit Indoor unit
— — %
AE-50 Outdoor unit Indoor unit

(3) System with a high-level system (i.e., TG-2000A) connected to AE-200 controllers

Leave the default setting [Master] as it is.

Master|
B e

TG-2000A AE-200 Outdoor unit Indoor unit

Master|
el il

AE-200 Qutdoor unit Indoor unit

[2] Old model compatibility mode

In the [Old model compatibility mode] section, select [ON] or [OFF].

Selecting [ON] will exclude the functions that require the indoor units to support the auto dual set point mode. This
function is useful when new and old indoor units that support or do not support the auto dual set point mode exist in
a given system, or when connecting a high-level building management system that does not support the auto dual
set point mode is connected via the BACnet® function.

When [ON] is selected, the Dual set point function and Prohibit Remote Controller function (Timer, Air Direction, Fan
Speed) cannot be used.

The following functions are available.

O : Available
Setting Old model compatibility mode OFF ON
Model New indoor unit | Old indoor unit | New indoor unit | Old indoor unit
Set temperature Auto dual set point mode O |
Auto single set point mode O O
Prohibit remote ON/OFF O O O
controller Operation mode O O O
Set temperature O O O
Filter sign reset O O O
Air direction O
Fan speed O
Timer O

Note: If the setting is changed, the controller will reboot.
Note: When changing the old model compatibility mode while this mode is used, note the following.
* The set temperature will go back to the default setting value. Write down the current set temperature of each group to
reconfigure the set temperature settings later.
* The set temperature for the schedule settings will be cleared. Write down the current set temperature of each group for
schedule settings to reconfigure the set temperature settings later.
« Some equipment whose operation is to be interlocked with another equipment support the dual set point function in the
Auto mode. Reconfigure the Interlock Control setting if it is affected by the change of the old model compatibility mode.
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[3] Hold type

The Hold function is a function to disable the operations that were scheduled for air conditioning unit groups.

If the setting for [Hold] is set to [ON] on the operation settings screen under the [Monitor/Operation] menu and the
[Hold type] on the screen above is set to [Forced], the [Hold] setting can be cancelled only from the AE-200/AE-50.
If the [Hold type] is set to [Normal], the [Hold] setting can be cancelled from AE-200/AE-50, other system controllers,
or remote controllers.

Note: The Hold function can be used on the AE-200A/AE-50A, but not on the AE-200E/AE-50E.

Note: The Hold function cannot be used on general equipments.

Note: The setting [Forced] will not be effective on Air To Water (PWFY) unit groups, LOSSNAY unit groups, HWHP (CAHV, CRHV)
unit groups, general equipment groups, and air conditioning unit groups that do not support the Hold function (i.e., Mr. Slim
M-Series/P-Series indoor units). If the setting for [Hold] is set to [ON] on those unit groups on the operation settings screen
and the [Hold type] on the screen above is set to [Forced], the setting [Normal] will be effective.

[4] Schedule: Season setting

In the [Schedule: Season setting] section, select [Available] to enable the seasonal settings of the weekly schedules
and [Not Available] to disable. Unless otherwise specified, leave the default setting [Available] as it is.
Note: The settings made on this screen on the AE-200 will be reflected on this screen on the AE-50.
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5-2. Function1

5-2-1. Peak Cut (Energy-save control function)
According to the selected Peak Cut method, the AE-200/AE-50/EW-50 obtains the demand level or the electric
energy values to determine the control level, and operates outdoor units and blocks of indoor units below the
specified maximum capacity that corresponds to the control level.
Touch [Functions 1] in the menu bar, and then touch [Peak Cut] to access the Peak Cut control settings screen.
Make necessary settings, and then touch [Save Settings].

Important

e The amount of electricity that is actually used may exceed the maximum power demand due to unexpected problems
such as controller malfunctions or broken transmission cables. Mitsubishi Electric will not be responsible for exceeding the
maximum power demand.

e An energy-save control can be performed, regardless of the electric energy consumption status. To perform an energy-
save control at the same level (control level 0) at all times, make the control settings for control level O for given outdoor and
indoor units. (In this case, Peak Cut method setting is not necessary.)

Note: Peak Cut settings using the LCD are possible on the AE-200/AE-50 from Ver. 7.23 onwards.

Note: After completing the settings, perform a test run and confirm proper connections of equipment before using the Peak Cut
function.

Note: A separate license is required to use the Peak Cut function. Make sure that the required license has properly been registered
on the [License] screen. (Refer to section 4-5 “License registration for optional functions” for details.) If the license is not
registered, the settings can be saved, but the function will not be available until the license is registered. When the license is
not registered, a message “License not registered” will appear at the left bottom of the screen.

Note: Some settings may not be accessible if logged in as a building manager.

Note: Peak Cut control cannot be performed on DIDO controller (PAC-YG66DCA), AHC, Air To Water (PWFY)) unit, HWHP (CAHV,
CRHYV, QAHV) unit, chiller unit, or MEHT-CH&HP unit.

Note: The Peak Cut control of indoor units is performed per block. Be sure to make block settings to use the Peak Cut function.

Note: The Peak Cut control settings between the outdoor and indoor units connected to the AE-200, AE-50, and EW-50, as well as
between the units connected to different AE-50/EW-50 controllers, cannot be made.

Note: Do not make the Peak Cut control settings for heat pump models of outdoor units or some types of outdoor units. For details,
refer to section 5-2-1-2 (2) “Control details for outdoor units (All Peak Cut methods)”.

Controller Peak Cut Settings LG
Select [AE200] to make n : :
settings for AE-200, and Control ler G Mitsubishi Electric
select [1], [2], [3], or [4] =
to make settings for each el U Ui
AE-50/EW-50. PI Controller
Peak Cut method Wartthour meter

int and inlet.

Save Settings

Save Settings
Touch to save the changes
made.
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5-2-1-1. Peak Cut method

Touch the [Settings] tab in the Peak Cut control settings screen.

[PLC Software for Demand Input]

[Electric Amount Count Software]

<When a PI controller (PAC-YG60MCA) is used>

Reads electric
energy values.

— | |AE-200[

Reads control
level.

AE-50 [¥

Peak Cut method [Remote AE]

Maximum 10
AE-200/AE-50/EW-50 units

PI controller Pulse-watt-
hour meter

4 4
Demand level is Reads electric
Demand level energy values.
signal is sent.
T .
=mel: Electric Amount Pulse-watt-
Demand-Input Count PLC h
i Demand J our meter
‘ N PLC controller '
o] =E
Maximum 10 Maximum 14
z <) AE-200/AE-50/EW-50 units i —! ) AE-200/AE-50/EW-50 units
\ = \.
[PI Controller]
—

<When a built-in Pulse Input (PI) is used>

— | |AE-200}:

(Built-in Pulse Input (PI)) Pulse-watt-
hour meter
- N
fReads control

| _— level.

AE-50 |3

Peak Cut method [Remote AE]

Maximum 10
AE-200/AE-50/EW-50 units

[External Contact point input] (1)

External input/output
adapter (PAC-YG10HA-E)

LAN \
—» | [AE-200}:

Reads control
level.

Demand level is
input.

Demand
controller

L\ |

Maximum 10

AE-200/AE-50/EW-50 units
=

Peak Cut method [Remote AE]

g

WT07627X17

[External Contact point input] (2)

External input/output
adapter (PAC-YG10HA-E)

Demand level is
input.

AE-200(:

‘ Demand
AE-50 |2 controller

AE-50 |1

AE-50 [

R
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[From external system]
e N

Demand level
signal is sent.

AE

Pulse-watt-

AE-50 [F hour meter

Maximum ten
AE-200/AE-50/EW-50 units

4_
AE-50 |3 €—
<

AE-50 [
. J

Note: After setting the energy-save control and peak-cut control settings, make sure the AE-200/AE-50/EW-50 have received
the Demand level signal (electric energy values) and are operating as intended on the LCD of AE-200 (AE-50) and the
Integrated Centralized Control Web (WEB).

Note: The following settings need to be set when updating the system from an AG-150A + PAC-YG50ECA system.
Although the control level input and the connection settings only need to be set for AG-150A in an AG-150A + PAC-YG50ECA
system, in an AE-200 + AE-50 (EW-50) system, the Demand level signal (electric energy values) input and peak-cut
methods need to be set for both AE-200 and AE-50 (EW-50).
If it is not feasible to change the system configuration and it is not possible to input the Demand level signal (electric energy
values) to AE-50 (EW-50), select [Remote AE] from the peak-cut method selection for AE-50 (EW-50).
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(A) When the Peak Cut method [PLC Software for Demand Input] is selected
1st page

Peak Cut

Control ler i Mitsubishi Electric
Peak Cut method

Peak !

PLC Software for Demand Input
IF addre PLC
192.168. 1. 191

Initialize

IP address of PLC =

Temperature difference e re diffe oint and inlet.
between set point and

Save Settings
inlet

Save Settings

2nd page

Peak Cut
Control ler WLl Mitsubishi Electric

IP address of controller

1 192.168.1.1
s 192.168.1. 3
L 192.168.1. 5 ]
y  192.168.1.7 ]

'N 192.168.1.9 10

Save Settings 4-— Save Settings

(1) Inthe [IP address of PLC] field, enter the IP address of the Demand-Input PLC.

(2) When using the Demand-Input PLC for the first time, initialize its internal memory.

Note: Do not initialize the Demand-Input PLC after the operation has begun, for it will reset all settings to the default settings
and will not properly perform the Peak Cut control.

(3) In the [Temperature difference between set point and inlet] section, a temperature differential can be set to
between 3 and 9 as necessary. The Peak Cut control setting that corresponds to the control level 0 will be
disregarded for the indoor unit groups in which the temperature difference between the set temperature and
the room temperature is greater than the specified temperature differential.

Note: This setting is not effective for the outlet air temperature control units.

Note: The Peak Cut control setting that corresponds to the control levels 1 to 4 will be effective regardless of the temperature
differential setting.

(4) Inthe [IP address of controller] field, enter the IP addresses of the AE-200/AE-50/EW-50 units to which the
demand level signal is sent. Up to 10 IP addresses can be registered.

Note: Control targets and the IP addresses can be displayed or set only while the communication with the demand PLC is
established.
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(B) When the Peak Cut method [Electric Amount Count Software] is selected
1st page

Peak Cut
Peak Cut method Control ler ULl Mitsubishi Electric

4
IP address of PLC Electric Amount Count Software

Initialize
DI Board IP addre PLC -
192.168. 1. 151
DL 1 Pul it
1.60 kih / pulse
Pulse Unit

Save Settings

Temperature difference
between set point and
inlet

Save Settings

2nd page
Peak Cut Settinos I 0
Control ler LY Mitsubishi Electric
Pealk Cut method
Control levels Electric Amount Count Software

Save Settings 4-— Save Settings

(1) Inthe [IP address of PLC] field, enter the IP address of the Electric Amount Count PLC.
Note: Each PLC can be registered to up to ten AE-200/AE-50 units.
Note: This setting is required for each AE-200/AE-50.

(2) When using the Electric Amount Count PLC for the first time, initialize the internal memory.
Note: Do not initialize the Electric Amount Count PLC after the operation has begun, for it will reset all settings to the default
settings and will not properly perform the Peak Cut control.
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(3) Touch the [DI Board] or [Pulse Unit] button to open the window to select the DI board number to which the watt-
hour meter is connected, and the terminal number. If the watt-hour meter is connected to terminal 2 on a DI

board 1, select 1-2.
Note: Select a DI board number 1 or 2, and select a terminal number/code between 0 and F.

Peak Cut

Board number
Board number

| .
Terminal number

OdBEnDED R
(sl oflnflef[coflefr]

Terminal number

(4) Inthe [Pulse Unit] field, enter the pulse value that the watt-hour meter outputs. Set the pulse value according to
the watt-hour meter to be used.

Important: Check the watt-hour meter readings several times on the hour and the half-hour. Then, be sure to check
that the increase in the watt-hour meter reading for each 30-minute period and the average electric power
consumption in the same period that the Peak Cut function is used are the same amount.
The average electric power for the period that the Peak Cut function is used can be checked on the [Peakcut]
screen.

(5) Inthe [Control levels] section, the range of the electric power must be set for each control level. For control
level 4, enter the value that is 10% to 15% below the maximum power demand (average electric energy that
cannot be exceeded in any 30-minute period). For control levels 3 to 0, enter the value that is decreased by
about 10% from the set value of the previous control level. (The screenshot above shows the setting example
of the maximum demand of 200 kW.)

Note: The optimum setting depends on the system configuration of the electric equipment and on the indoor environment in
each building. Determine the appropriate values accordingly.

(6) Inthe [Temperature difference between set point and inlet] section, a temperature differential can be set to
between 3 and 9 as necessary. The Peak Cut control setting that corresponds to the control level 0 will be
disregarded for the indoor unit groups in which the temperature difference between the set temperature and
the room temperature is greater than the specified temperature differential.

Note: This setting is not effective for the outlet air temperature control units.
Note: The Peak Cut control setting that corresponds to the control levels 1 to 4 will be effective regardless of the temperature

differential setting.
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(C) When the Peak Cut method [Pl Controller] is selected
1st page

Peak Cut
Peak Cut method | Controller TN Mitsubishi Electric

Watthour meter

Save Settings

Temperature difference
between set point and

inlet Save Settings
2nd page
Peak Cut Settinos Y 00
Control ler LR Mitsubishi Electric
Peale Cut method
Control levels PI Controller

Save Settings 41— Save Settings
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(1) Touch the [Watthour meter] button to open the window to select the Pl controller to which the watt-hour meter
used for the Peak Cut function is connected.

Watthour meter

Note: Only the watt-hour meters that have been registered on the [Measurement] screen are selectable. (Refer to section 5-2-
2 “Measurement” for how to register metering devices.)

Note: When a built-in Pulse Input (PI) is used, [Channel No. + (space) + Metering device name] will appear. (For example, if
the watt-hour meter used for the Peak Cut function is connected to channel 3 of CN7 of AE-200 and the metering device
name is “For Peak Cut function,” [3 For Peak Cut function] will appear.)

When a PI controller (PAC-YG60MCA) is used, [PI controller address + “-” + Channel No. + (space) + Metering device
name] will appear. (For example, if the watt-hour meter used for the Peak Cut function is connected to channel 2 of a PI
controller (address 10) and the metering device name is not registered, [10-2] will appear.)

Note: To deselect the selection, select [-- --].

(2) In the [Temperature difference between set point and inlet] section, a temperature differential can be set to
between 3 and 9 as necessary. The Peak Cut control setting that corresponds to the control level 0 will be
disregarded for the indoor unit groups in which the temperature difference between the set temperature and

the room temperature is greater than the specified temperature differential.
Note: This setting is not effective for the outlet air temperature control units.
Note: The Peak Cut control setting that corresponds to the control levels 1 to 4 will be effective regardless of the temperature
differential setting.

(3) Inthe [Control levels] section, the range of the electric power must be set for each control level. For control
level 4, enter the value that is 10% to 15% below the maximum power demand (average electric energy that
cannot be exceeded in any 30-minute period). For control levels 3 to 0, enter the value that is decreased by
about 10% from the set value of the previous control level. (The screenshot above shows the setting example
of the maximum demand of 200 kW.)

Note: The optimum setting depends on the system configuration of the electric equipment and on the indoor environment in
each building. Determine the appropriate values accordingly.
Note: Other than the AE-200/AE-50/EW-50 units that use a built-in Pulse Input (PI) or a PI controller (PAC-YGE0MCA), up

to three more AE-200/AE-50/EW-50 units can be controlled. Refer to (D) “When the Peak Cut method [Remote AE] is
selected” below for details.

(D) When the Peak Cut method [Remote AE] is selected

Peak Cut Settings
AE288 | 'H ishi i
Peak Cut method Control ler Mitsubishi Electric
Pealc Cut method
Remote AE
IP Address

p

192.168.1. 2

Temperature difference
between set point and
inlet

oirt and inlet.

Save Settings 4-— Save Settings
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(1) Inthe [IP address] field, enter the IP address of the AE-200/AE-50/EW-50 that uses one of the following.
- Built-in Pulse Input (PI)
- PI controller (PAC-YG60MCA)
- External contact input (Refer to (E) “When the Peak Cut method [External Contact point input] is selected”
for details.)

Note: As the control level is obtained every minute from the AE-200/AE-50/EW-50 that uses a built-in Pulse Input (PI) or a PI
controller (PAC-YGG60MCA), the control will be late for up to one minute on the AE-200/AE-50 whose Peak Cut method
setting is [Remote AE].

Note: Up to ten AE-200/AE-50/EW-50 units can be connected to the AE-200/AE-50/EW-50 unit that uses a built-in Pulse
Input (PI) or a PI controller (PAC-YGG60MCA). When eleven or more AE-200/AE-50/EW-50 units are connected, add the
settings in (C) “When the Peak Cut method [Pl Controller] is selected” or (E) “When the Peak Cut method [External Contact
point input] is selected”. Increase the number of AE-200/AE-50/EW-50 units to which pulse signals of watt-hour meters, Pl
controllers, or external contact inputs are connected.

(2) Inthe [Temperature difference between set point and inlet] section, a temperature differential can be set to
between 3 and 9 as necessary. The Peak Cut control setting that corresponds to the control level 0 will be
disregarded for the indoor unit groups in which the temperature difference between the set temperature and
the room temperature is greater than the specified temperature differential.

Note: This setting is not effective for the outlet air temperature control units.

Note: The Peak Cut control setting that corresponds to the control levels 1 to 4 will be effective regardless of the temperature
differential setting.

(E) When the Peak Cut method [External Contact point input] is selected

Note: The external signal can be input to AE-200, AE-50, and EW-50, so that all outdoor units and blocks of indoor units can be

selected.
Peak Cut Settings TN
Peak Cut method Control ler LI LER Mitsubishi Electric

Peak Cut method

External Contact point Input

Temperature difference
between set point and
inlet

Temperature diffe

o u With
n c n indoor u

Save Settings 4—-— Save Settings

(1) Inthe [Temperature difference between set point and inlet] section, a temperature differential can be set to
between 3 and 9 as necessary. The Peak Cut control setting that corresponds to the control level 0 will be
disregarded for the indoor unit groups in which the temperature difference between the set temperature and
the room temperature is greater than the specified temperature differential.

Note: This setting is not effective for the outlet air temperature control units.

Note: The Peak Cut control setting that corresponds to the control levels 1 to 4 will be effective regardless of the temperature
differential setting.
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(F) When the Peak Cut method [From external system] is selected

| S runction

Peak Cut Settings
Control ler L LR Mitsubishi Electric

Peak Cut method

Peak Cut method

From external system

Temperature difference
between set point and
inlet

oirt and inlet.

Save Settings 4—-— Save Settings

(1) Inthe [Temperature difference between set point and inlet] section, a temperature differential can be set to
between 3 and 9 as necessary. The Peak Cut control setting that corresponds to the control level 0 will be
disregarded for the indoor unit groups in which the temperature difference between the set temperature and
the room temperature is greater than the specified temperature differential.

Note: This setting is not effective for the outlet air temperature control units.
Note: The Peak Cut control setting that corresponds to the control levels 1 to 4 will be effective regardless of the temperature

differential setting.
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5-2-1-2. Unit settings
Touch the [Air-con] tab in the Peak Cut control settings screen.

(1) Control details for blocks of indoor units

Follow the instructions below to make the Peak Cut control settings for each control level for given blocks of
indoor units.
If the block settings have not been made, refer to section 5-1-9 “Blocks” for how to make the block settings.

Important

e An energy-save control at the same level (control level 0) can be performed at all times regardless of the electric energy
consumption status.

1st page (Indoor unit settings)

Peak Cut Air-con

Control ler il Mitsubishi Electric

e Batch Operations

ontrol Time

Batch Operations
Copy

Paste

Control Method Control Time

Control levels

- nnn-m\
3 Lo |0 ][5 |[ss ]
BEOaEa

"®__ Touch to switch the blocks.

Touch to go to the next page
(outdoor unit settings).

(1) Touch E or E to display the block whose settings are to be made. To make settings for all blocks at once,
check the [Batch Operations] checkbox.
Then, select the control method for each control level, referring to the table below.
Note: Only the control method “OFF” is effective for Air To Water (PWFY) units. Other methods can be selected, but are not
effective.

Table: Indoor Unit Control Method

Control Method Control details
None Peak Cut control will not be performed.

During the Peak Cut control, the set temperature in the Cool or Dry mode will be offset by +2°C (+4°F),
and the set temperature in the Heat mode will be offset by -2°C (-4°F).
Note: Peak Cut control will not be performed during the Fan or Auto mode.
Note: When the unit of temperature is Fahrenheit, the set temperature may not be offset by +4°F exactly
+2°C (+4°F) because 2°C is used for the calculation first, and then the temperature in Celsius is converted into
the temperature in Fahrenheit.
Note: The set temperature will be adjusted within the set temperature restrictions settings made on the Set
Temperature Range Limit screen (accessible via the Integrated Centralized Control Web). Refer to
section 7-1-3 “Set Temperature Range Limit” for details.

During the Peak Cut control, free-plan indoor units and A-control Mr. Slim indoor units (M-Series/P-Series
indoor units) will go in to the Thermo-OFF state, and the units older than free-plan units will operate

in the Fan mode. (When the units are in the Thermo-OFF state, the operation mode on the remote
controller LCD will not change.)

Fan *1

During the Peak Cut control, the units will stop.
OFF ™1 Note: If the control method is set to [OFF] and the Control Time is set to [30] minutes, the groups that are
operated in the Peak Cut control cannot be operated from any controller.

*1  When the indoor unit Peak Cut control function is used during the heating operation, it takes a while to resume operation to prevent cold air
draft. This may negatively affect the performance of the unit for a certain period of time after the operation is resumed. To ensure maximum
performance, it is recommended to use an outdoor unit capacity-save control function (that will not stop the compressor operation) during the
heating operation. If the indoor unit Peak Cut control function is still used, selecting [3] minutes in the Control Time section is recommended.
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(2) For each control level, set the total time in which When [6] minutes is selected I Control time
the Peak Cut control is performed during every 30

minutes. & &0

3 5 8 10 1315 18 20 23 25 28 30 min

Each Peak Cut control is performed for three Group 1
minutes. If [6] minutes is selected, three-minute &

Peak Cut control will be performed twice during Group 2
every 30 minutes.

It any time other than [30] minutes is selected, the | et A=

Group 3

indoor units will operate in rotation so that they will
not perform the Peak Cut control at the same time.

(3) To copy the settings of a block to the settings for other blocks, display the block whose settings are to be copied
and touch [Copy], then display the block to which the copied settings are to be pasted and touch [Paste]. The
rectangular icons next to the selected buttons will appear in yellow-green.

(2) Control details for outdoor units (All Peak Cut methods)

Follow the instructions below to make the Peak Cut control settings for each control level for given outdoor units.
Note: If the outdoor unit is a City Multi unit, the M-NET address will appear. If the outdoor unit is an A-control (Mr. Slim) unit, the
M-NET address and group name will appear.
Note: As for A-control outdoor units, only the inverter models can perform Peak Cut control. The Peak Cut control settings for
constant-speed models can not be made.
Note: Do not make the Peak Cut control settings for heat pump models of outdoor units or some types of outdoor units.

2nd page (Outdoor unit settings)

B R
‘ Peak Cut Air-con Measureme
Batch Operations
Control ler WLl Mitsubishi Electric
Copy

0 s Batch Operations Copy | Paste
Maximum Capacity i o T

Control Time
Cantrol Time

Control levels H n n m

BEnOoEa
3 Lo Lo J[15 ]3]
B0 Ea

"_ Touch to switch the outdoor
unit addresses.

Save Settings

Touch to go to the previous Save Settings

page (indoor unit settings).

(1) Touch [A] or [¥] to display the address of the Capacity
outdoor unit whose settings are to be made. A
To make settings for all outdoor units at once,
check the [Batch Operations] checkbox.
Then, set the maximum operating capacity for 80% [-=-=-=-------m--- =
each control level.
The smaller the maximum operating capacity,
the more energy will be saved.

Note: Energy-saving effects cannot be expected

during low-load operation with the capacity
below the selected maximum capacity.

e.g., Maximum capacity at 80%

- ’]: Energy saved

Operating
Capacity

No energy-saving effects Energy-saving effects

> Time
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Note: For heat pump outdoor units and City Multi S series (PUMY) outdoor units, leave the default setting [100%)] as it is not to
activate the capacity-save control.
However, [50%] though [100%] can be set on the following models.
PUMY-P**KM or later
PUMY-P**KM-A or later
PUMY-P**HMC-S or later
PUMY-P**HMC-C or later
PUMY-P**KMC-C or later
PUMY-P**YKM.TH(-T) or later
Note: AE-200/AE-50/EW-50 that support Maximum Capacity [50%] are from Ver. 7.23 or later.

(2) For each control level, set the total time in which the Peak Cut control is performed during every 30 minutes.
Setting the time to [30] minutes is preferable, for shorter control time is not likely to bring much benefit.
If any time other than [30] minutes is selected, the outdoor units will operate in rotation so that they will not
perform the Peak Cut control at the same time.

(3) To copy the settings of an outdoor unit to the settings for other outdoor units, display the outdoor unit whose
settings are to be copied and touch [Copy], then display the outdoor unit to which the copied settings are to be
pasted and touch [Paste]. The rectangular icons next to the selected buttons will appear in yellow-green.
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5-2-2. Measurement
Measurement settings must be made to use temperature sensors, humidity sensors, and metering devices.
Touch [Function1] in the menu bar, and then touch [Measurement]. Set the measurement settings for each AE-200
and AE-50, and then touch [Save Settings].
Note: The measurement settings may not be accessible if logged in as a building manager.
Note: If the system is connected to a TG-2000A, make or change the settings from the TG-2000A.
Note: The [Controller] setting will appear (only on the AE-200’s LCD) when the [System Exp] setting on the [Unit Info.] screen is set

to [Expand]. Switch the [Controller] setting between [AE200] and [Exp1] through [Exp4] to make settings for each AE-200,
AE-50, and EW-50 individually.

Important

e Measurement settings for the AE-50/EW-50 must be made with the AE-50/EW-50 properly connected to ensure proper
settings. Those settings made without the connection of AE-50/EW-50 will not be reflected.

. Settings
<

Controller Peak Cut
Select [AE] to make 3
settings for AE-200, and Controller m Mitsubishi

select [1], [2], [3], or [4]
to make settings for each

1 SSAIREE el x— Touch to show the address
AE-50/EW-50. Exhibition hall (T) .07 8" i to which the Al or PI
1

controller will be connected.
M-NET address of Al or PI W 25.0°c ‘J},—za. o'c =00 ac ‘+1@. 8°C

controller
Exhibition hall (H)
2

& 650z ‘Oa.a% — 100 o ‘HB.B%

Selection of Al or Pl

controller ) .
Setting details

Save Settings

Save Settings
Touch to save the changes
made.

[1] Registering Al controllers and temperature/humidity sensors
Follow the instructions below to make the system settings for measurement sensors. Up to two measurement
sensors can be connected to an Al controller (PAC-YG63MCA).

Upper/lower ON- and OFF-
threshold settings for
e-mail alarm function

Sensor name Measurable range

=

Oft

N e/ 0F Fet U
Exhibition hatim | |
1

B-—c ‘gw.a"c =) sa0c |+wa.@°c \

48
Exhibition hall (H)
2

& ‘02@.@% — 100, 5% |+wa.a%

Al controller icon Upper limit

(ON-threshold)
Upper limit
(OFF-threshold)

Lower limit
(OFF-threshold)

Lower limit
(ON-threshold)

Setting details of sensor 1

Setting details of sensor 2

Temperature or humidity Offset value

sensor settings

(1) Touch [4] or [¥] to select the address to which the Al controller (PAC-YG63MCA) will be connected.
(2) Select the Al controller icon ( '—E é).

Note: Touch again to deselect.
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(3) Touch the “Sensor name” button to display the keyboard. Enter the name of the sensor in 20 characters or
less.
Note: The following characters cannot be used: <, >, &, “, or*

(4) Touch the “Temperature or humidity sensor settings” Selection of temperature or humidity
button to display the sensor settings screen. sensor icon

Select the temperature sensor icon (&J) or the humidity

sensor icon (@).

5ensor Range
Bottom

I

0f fset
Corrected Sensor value

1€8°C = 98 °C

Measurable range Offset value

(5) Touch the [Bottom] and [Top] buttons to display the
keypad. Enter the measurable range of the sensor, and
then touch [OK].

Note: The settable range for temperature sensor is between
-100.0°C (-148.0°F) and +100.0°C (+212.0°F), and for
the humidity sensor is between 0.0% and +100.0%.

Note: When the Pt100 sensor is connected, the range must be
between -30°C (-22°F) and +60°C (+140°F).

When the sensors other than the Pt100 sensors are
connected, enter the ranges that are described in the
operation manuals of the sensor.

(6) To set the offset value for the measured values, touch the [Offset] button to display the keypad. Enter the offset
value, and then touch [OK].

Note: The settable offset value range for temperature sensor is between -10.0°C (-18.0°F) and +10.0°C (+18.0°F), and for the
humidity sensor is between -10.0% and +10.0%.

(7) To receive an e-mail alarm when the temperature or the Upper limit (ON-threshold)
humidity exceeds certain predetermined values, set the Upper limit (OFF-threshold)
ON- and OFF-thresholds for both the upper and lower
limit temperatures.

Touch the “Upper/lower ON- and OFF-threshold settings
for e-mail alarm function” section to display the settings
screen.

Touch the [U alarm ONJ/[L alarm ON] and [U alarm OFF}/
[L alarm OFF] buttons to display the keypad. Enter the
ON- and OFF-thresholds for the upper and lower limit
temperatures, and then touch [OK].

Uprler/Lower limit temp. settings

Note: To clear the ON- and OFF-thresholds for the upper limit

temperatures, touch [U clear]. To clear the ON- and Lower limit (ON-threshold)
OFF-thresholds for the lower limit temperatures, touch [L Lower limit (OFF-threshold)
clear].

Note: To avoid frequent ON/OFF cycling, the minimum
differential between the ON- and OFF-threshold values
should be 1°C (2°F).

(8) Touch [Save Settings].
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[2] Registering Pl controllers and metering devices

Important

e The built-in Pulse Input (PI) settings cannot be made on the TG-2000A.
e The built-in Pulse Input (PI) cannot be used for the electricity charge apportioning function of TG-2000A.

Follow the instructions below to make the system settings of the metering devices. Up to four metering devices can
be connected to a PI controller (PAC-YG60MCA) or CN7 of AE-200/AE-50/EW-50.
Note: Although the maximum settable total number of built-in Pulse Input (PI) and PI controllers (PAC-YG60MCA) for each
AE-200/AE-50/EW-50 is 15, the number of them in a system with connection to one or more AE-50/EW-50 controllers must
be 20 or less. (Each built-in Pulse Input (PI) counts as one unit.)

<When a built-in Pulse Input (PI) is used>

Mame Pulse beiaht

Pulse value

i EAST

Built-in Pulse Input (PI) N WEST

icon
=N SOUTH

/8 NORTH

Measurement unit

Metering device name

<When a PI controller (PAC-YG60MCA) is used>

Pulse value

‘N Whn (1F)

v4 Whm (2F) . Measurement unit

49
=1 Whn (3F)

Metering device name "8 Whm (Peakcut)

Pl controller icon

(1) Touch [4] or [¥] to display the address to which the PI controller (PAC-YG60MCA) will be connected or to
display the settings area for a built-in Pulse Input (PI) at the top.

(2) Select the PI controller icon (;'H)

When a built-in Pulse Input (PI) is used, the top row shows the setting area for the built-in Pulse Input (PI) and
there is no need to select an icon.
Note: Touch again to deselect.

(3) Touch the “Metering device name” button to display the keyboard. Enter the name of the metering device in 20
characters or less.
Note: The following characters cannot be used: <, >, &, “, or*

(4) Touch the “Pulse value” button to display the keypad. Enter
the pulse value of the metering device, and touch [OK].
Note: The settable range is between 0.01 and +100.
Note: If the pulse value field is left blank, the reading of the
metering device cannot be properly obtained. Be sure to set
the pulse value.
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(5) Touch the “Measurement unit” button to select the measurement unit.
Note: The measurement unit can be selected from [kWh], [m3], [MJ], [--(no unit)], or [(blank)]. Select the blank when not using
a metering device.
Note: The measurement values for which “--(no unit)” has been selected will not be plotted on a graph on the Energy Use
Status screen.

Important

e Set the pulse value according to the metering device to be used. To ensure proper settings, first check the value
measured by the metering device and the value counted by the built-in Pulse Input (PI) or the PI controller (PAC-
YGG60MCA). Then, after a certain time, check that both values have increased by equal values. (The values that
the built-in Pulse Input (PI) or the PI controller (PAC-YGB60MCA) counts can be checked on the [Measurement]
display under the [Monitor/Operation] menu.)

(6) Touch [Save Settings].
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5-2-3. Energy Management
On the Energy Management screen, make the settings for the energy-control-related items that appear on
the screens under the [Energy Mgmt] menu, such as temperature sensor to measure the outdoor temperature
with, electricity meters that are used for acquiring the data to display the trend graph of indoor unit electricity
consumption, and also the mode that are used for apportioning indoor unit electricity consumption.
Touch [Function1] in the menu bar, and then touch [Energy Management].
Note: Electricity consumption is apportioned based on the electricity consumed by outdoor units. The electricity consumed by

indoor units is not considered.
Note: HWHP (CAHV, CRHV, QAHV) units, chiller units, and MEHT-CH&HP units do not support this function.

Important

e Al and PI controller settings are required beforehand to make energy management settings. Refer to section 5-2-2
“Measurement” for details.

e The energy management settings must be made after all units have been started up. The settings that have been saved
while one or more units are starting up may be lost.

\ “Settinas 4 Functionl [&

Energy Management

Temperature sensor Controller LIFLER Mitsubishi Electric
Select a temperature sensor

to measure the outdc_)or SEM R @ 49-1 Outside temp
temperature with.

Indoot unit operation apportioning mode

Indoor unit operation FAN operation time Thermo-ON time Capaclty save amount
apportioning mode
= Electricity meter
P riae kel Indoor unit electricity

Group1 1 EAST meter
Entrance 2 47-1 1F

Entrance 3 47-1 1F

Entrance 4 471-1 1F n

Save Settings

Save Settings
Touch to save the changes
made.

(1) Touch the “Temperature Sensor” button. The name of the  [JZ .
temperature sensor that is connected to the Al controller or
the AHC will appear. I—l
Select a temperature sensor to measure the outdoor o
temperature with, and then touch [OK].
Note: To deselect the selection, select [-- --].

Note: This setting is not required when not showing the outdoor
temperature in a line graph on the [Energy Use Status]

screen.
Note: This setting is interlocked with the temperature sensor
setting on the [External Temperature Interlock] screen. |

(2) Touch the [Indoor unit operation apportioning mode] button.
Select the way indoor units’ operation time is counted that is used to apportion the electricity consumption,
which appears on the screens under the [Energy Mgmt] menu.
Select [Fan operation time] to apportion the electricity consumption based on the fan operation time, and select
[Thermo-ON time] to apportion the electricity consumption based on the Thermo-ON time of the indoor units.
Select [Capacity save amount] to apportion the electricity consumption based on the indoor unit operation time
that was calculated based on the amount of energy saved on the indoor units.
The selected setting must meet the system requirements. Selecting [Capacity save amount] is recommended.
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Note: To deselect the selection, select [-- --].

Note: “FAN operation time” is the cumulative duration of time in which the indoor unit is powered on.

Note: “Thermo-ON time” is the cumulative duration of time in which the refrigerant is flowing into the indoor unit.

Note: “Capacity save amount” is the cumulative operation time of the outdoor unit based on its capacity.

Note: Electricity consumption is apportioned based on the electricity consumed by outdoor units. The electricity consumed by
indoor units is not considered.

Note: When an AE-200 apportioned electricity billing function is used, this setting is not effective because the billing function

settings are used to apportion the electricity consumption.

Electricity meter

(3) Touch the [Indoor unit electricity meter] button.
Select the electricity meter to be used to measure the
electricity consumption of each group of indoor units.
[‘Address”+ PI controller address + “-” + Electricity meter
number + Electricity meter name] will appear when a Pl
controller (PAC-YGB60MCA) is connected, or [‘Meter” +
Channel No. + Electricity meter name] will appear when a

metering device is directly connected to the controller.

Note: To deselect the selection, select [-- --].

Note: If the electricity meter name is long, only part of it may be
displayed.

Note: The electricity meter name will be blank if it has not been
registered.

Note: Only the electricity meters whose measurement unit setting
is set to [kWh] on the Measurement screen are available for
selection.

Note: LOSSNAY unit groups and general equipment (connected
via DIDO controller PAC-YG66DCA) groups are excluded.
(Apportioned calculation is not available for these groups.)

Note: When an AE-200 apportioned electricity billing function is
used, this setting is not effective because the billing function
settings are used to apportion the electricity consumption.

Save Settings

(4) Touch [Save Settings] to save the settings.
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5-3. Function2

5-3-1. External Temperature Interlock
Based on the temperature difference between the set temperature and the outdoor temperature, the set temperature
can be adjusted automatically. Making this control setting on the air conditioning unit at an entrance of a building
prevents extreme temperature change from distressing our bodies and sending us into shock.

Touch [Function2] in the menu bar, and then touch [Ext Temp Interlock].
Note: Either an Al controller (PAC-YG63MCA) or AHC, and an outdoor temperature sensor are required to measure the outdoor

temperature.

Note: When connecting one or more AE-50/EW-50 controllers, connect an Al controller (PAC-YG63MCA) or AHC, and outdoor
temperature sensor on each AE-50/EW-50.

Note: The External Temperature Interlock settings may not be accessible if logged in as a building manager.

Note: The External Temperature Interlock settings between the units connected to the AE-200 and the AE-50/EW-50, as well as

between the units connected to different AE-50/EW-50 controllers, cannot be made.

Note: The [Controller] setting will appear (only on the AE-200’s LCD) when the [System Exp] setting on the [Unit Info.] screen is set
to [Expand]. Switch the [Controller] setting between [AE200] and [Exp1] through [Exp4] to make settings for each AE-200,
AE-50, and EW-50 individually.

Note: This function is not available for the outlet air temperature control units.

Important

e External Temperature Interlock settings for the AE-50/EW-50 must be made with the AE-50/EW-50 properly connected to
ensure proper settings. Those settings made without the connection of AE-50/EW-50 will not be reflected.

Controller

Select [AE] to make
settings for AE-200, and
select [1], [2], [3], or [4]
to make settings for each
AE-50/EW-50.

Temperature Sensor
Select a temperature sensor
to measure the outdoor
temperature with.

Group No. and group
name

Settings N

Ext Temp Interlock

m Mitsubishi
S I T @l 47 -1 Outdoor status
/

_— Trou

Controller

Jame

Entrance 1

Lobby A

Lobby B

Meeting room

Save Settings

(1) Touch the “Temperature Sensor” button. The name of the

temperature sensor that is connected to the Al controller or
the AHC will appear.

Select a temperature sensor to measure the outdoor
temperature with, and then touch [OK].
Note: To deselect the temperature sensor, select [-- --].

Note: Connect the temperature sensor to either the Analog Input 1

or Analog Input 2 port on the AHC.
Note: This setting is interlocked with the temperature sensor
setting on the [Energy Management] screen.
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Ext Temp Sensor

Control levels

Select a maximum
temperature value to be
added to or subtracted from
the set temperature.

Save Settings
Touch to save the changes
made.

| R | 47-1 Outdoor status

471-2




(2) Inthe [Control levels] section, select a maximum temperature value for each group to be added to or
sabtracted from the set temperature.
For example, when [£4°C] (£8°F) is selected and the set temperature for the Cool or the Dry mode is set to
24°C (75°F), the set temperature will be adjusted to a maximum of 28°C (83°F) based on the temperature
difference between the set temperature and the outdoor temperature. When [+2°C] (+4°F) is selected, the set

temperature will be adjusted to maximum of 26°C (79°F).
Note: When the unit of temperature is Fahrenheit, the selected temperature value may not be added to the set temperature
accurately because 2°C is used for the calculation first, and then the temperature in Celsius is converted into the
temperature in Fahrenheit.

(3) Touch [Save Settings].
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When the External Temperature Interlock function is active, the set temperature will be adjusted as shown

below.

H “Cool” and “Dry” modes

36 ~| Outdoor temperature i

. ~N—

34 / \
%) 2:23 / Set temperature after being adjusted
o / when [Control levels] is set to [+4°C]
g 31 / (8°F)
£ / Z\
S e / L\
R 1\

26 —I

_/

e | < AN

24

23 !_S'et temperature |:

Time

Outdoor temperature conditions

Set temperature after being adjusted

Outdoor temperature =
Set temperature + 1.5°C (3°F)

Set temperature + 1°C (2°F)

Outdoor temperature =
Set temperature + 4.5°C (9°F)

Set temperature + 2°C (4°F)

Outdoor temperature =
Set temperature + 6.5°C (12°F)

Set temperature + 3°C (6°F)

Outdoor temperature =
Set temperature + 7.5°C (14°F)

Set temperature + 4°C (8°F)

M “Heat” mode

19 N
18 | ™~ L l /
17 N\ L 1/
16 N\ L I/

S 15 \ | I/

s \ 7 /

=213 Set temperature after being adjusted /

g 12 | | when [Control levels] is set to [+4°C] /

S qq | [e8F) /

€ 10 \ /
9 \ A
8 \ /A
7 N\ /| Outdoor temperature
6 N S I

Time

Outdoor temperature conditions

Set temperature after being adjusted

Outdoor temperature <
Set temperature - 4.0°C (8°F)

Set temperature - 1°C (2°F)

Outdoor temperature <
Set temperature - 6.0°C (11°F)

Set temperature - 2°C (4°F)

Outdoor temperature <
Set temperature - 8.0°C (15°F)

Set temperature - 3°C (6°F)

Outdoor temperature <
Set temperature - 10.0°C (18°F)

Set temperature - 4°C (8°F)
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5-3-2. Night Setback Control
The Night Setback Control function (hereafter abbreviated as Setback Control) prevents indoor condensation by
performing heating operation automatically when the room temperature goes outside of the specific range during
the night. Touch [Function2] in the menu bar, and then touch [Setback].
Heating operation starts when a given group is stopped and the room temperature drops below the specified

minimum temperature.

Note: The Setback Control function also prevents excessive temperature rise by performing cooling operation automatically when
the room temperature goes outside of the specific range. Cooling operation starts when a given group is stopped and the
room temperature rises above the specified maximum temperature.

Note: If the operation settings (on/off, operation mode, or set temperature) is changed from a local remote controller during the
Setback Control, the settings selected before the Setback Control will not be restored.

Note: If the room temperature is measured by the return air temperature sensor on the air conditioning unit, the measured value
may not be an accurate representation of the temperature in the room, especially when the air conditioning unit is stopped
and the room air is stagnant. When this is the case, use an external temperature sensor (PAC-SE40TSA) or remote
controller sensor to measure the room temperature.

Note: The Setback Control may not be accessible if logged in as a building manager.

Note: The [Controller] setting will appear (only on the AE-200’s LCD) when the [System Exp] setting on the [Unit Info.] screen is set
to [Expand]. Switch the [Controller] setting between [AE200] and [Exp1] through [Exp4] to make settings for each AE-200,
AE-50, and EW-50 individually.

Note: This function is not available for the outlet air temperature control units.

Important

e Setback Control settings for the AE-50/EW-50 must be made with the AE-50/EW-50 properly connected to ensure proper
settings. Those settings made without the connection of AE-50/EW-50 will not be reflected.

. A\ Settings| 3

Controller
Select [AE] to make Ext Temp Interlock
settings for AE-200, and Control ler m Mitsubishi

select [1], [2], [3], or [4]

to make settings for each i B81:80 - 69:88
AESO/EW.50. Control Time

Temperature range

Group MName Minimum Temp - Maxinum Temp

Control Time

Entrance 1 17°c - =

Lobby A 18°c - 368°C
Group No. and group
name Lobby B 25°c - 28°C

Meeting room

Save Settings

Save Settings
Touch to save the changes
made.

(1) Touch the [Control Time] button to display the settings Setback
screen.
Set the [Setback] setting to [Use], set the time period in Sl
which Setback Control is performed, and then touch [OK]. m
Note: When [00: 00 - 00: 00] is selected, Setback Control is active Setback Control Time Period

for 24 hours. Hour Minute Hour Minute

AM AM
85 08 » 55 ol
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(2) Touch the “Temperature range” button to display the

settings screen.

Set the maximum and minimum temperatures for each
group. u u
For example, if [Control Time] is set to [01:00 - 05:00] and “[: — I
“Temperature range” is set to [12°C - --°C] ([53°F - --°F]), n n
heating operation starts automatically when the room
temperature drops below the set temperature 12°C (53°F) ‘ 0K | ‘ Cancel
between 1:00 and 5:00. When the Setback Control ends at
5:00, the set temperature returns to the original setting, and
the operation stops.

Minimum Temp Maximum Temp

Note: The air conditioning units in the heating operation will stop and the set temperature will return to the original setting
when the Setback Control period is over or the room temperature rises to the minimum temperature plus 3°C (6°F).
Likewise, the air conditioning units in the cooling operation will stop and the set temperature will return to the original
setting when the Setback Control period is over or the room temperature drops to the maximum temperature minus 3°C
(6°F).

Setback
operation
Room temp. Setback ends.
21°C (69°F) — AN — - — = — — operation -/ -
starts.
19°C (66°F) = = — = = = = P — — -
Heat ON Heat OFF Heat ON Heat OFF
21°C (69°F) 19°C (66°F) 21°C (69°F)
>
¢ >
Setback Control period

When the temperature drops below the minimum temperature (heating operation)

Setback
operation
Max. temp. ends.
28°C(83°F) = = == = = = = = LA = - - — — — =
Setback
Room temp. operation
24°C (7T5°F) AN AL~ — — = — - starts. e | — — — — — —
Cool ON Cool OFF Cool ON Cool OFF
24°C (75°F) 28°C (83°F) 24°C (75°F)
¢ o o
Setback Control period

When the temperature rises above the maximum temperature (cooling operation)

(8) Touch [Save Settings].
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5-4. Ventilation setting
5-4-1. Night purge

During summer, the Night purge function draws cooler outside air into the room to suppress temperature rises at
night. This energy conservation reduces the load when air conditioning starts the next morning.
Note: During the Night purge operation, LOSSNAY units operate in the Bypass mode.

Note: Night purge setting cannot be made from AE-200 for the LOSSNAY units that are connected to the AE-50/EW-50 in
communication error.

Note: Some models of LOSSNAY units do not support the Night purge function from AE-200. (As of October 2015, only LGH-
RVX-E models support the function.)
For more details about the Night purge function, refer to the Installation Manual, Instruction Book, or technical documents
that are provided with the LOSSNAY unit.

[1] Night purge settings on the LCD
Log in to the Initial Settings menu, touch [Ventil. Settings] in the menu bar, and then touch [Night purge].
All LOSSNAY unit groups that support the Night purge function from AE-200 will appear.

(1) Touch one or more group icons whose settings are to be made, and then touch [Edit].

Ventil.
n \ Se‘ttings

Night purge

Edit

(2) Inthe [Night purge] section, select [Available] to enable the Night purge settings, make detail settings (days
of the week, start time, end time, outdoor temperature threshold, temperature difference between room
temperature and outdoor temperature, initial fan speed), and then touch [OK].

Note: When [Not Available] is selected in the [Night purge] section, the detail settings cannot be made.
Note: Touch [Cancel] to return to the previously saved settings without making any changes.

Night purge Night purge Days of the week — Days of the week
[Noﬁ/fgli?abt!?elf available || sun || Mon || Tue || wed || Thu || Fri || sat |

Start Time End Time
Not Available | El m m
Start Time Er EE = End Time

OT threshold  RoomTemp dif Init fan spd

Outdoor temperature '[: m |E| E «— Initial fan speed
threshold EI m

Temperature / | OK I | Cancel I
difference between
room temperature and
outdoor temperature
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Setting item

Setting method

Remarks

) Night purge
[Available]/[Not Available]

Touch [Available] to enable the
Night purge settings, and [Not
Available] not to.

(2) | Days of the week

Touch one or more days on
which the Night purge control is
executed at the selected Start
Time below.

<Example>
When the settings are made as follows, the
Night purge control starts at 23:00 on Monday
and ends at 6:00 on Tuesday.

Days of the week: Monday

Start Time: 23:00

End Time: 6:00

* If the [Edit] button is touched with the multiple group
icons selected, all days of the week are selected
when the settings window opens.

(3) | Start Time

Touch El El to set the time at
which the Night purge control
starts.

(4) | End Time

Touch El El to set the time at
which the Night purge control
ends.

(5) Outdoor temperature
threshold

Touch El El to set the outdoor
temperature threshold value as

a condition for activating the
Night purge operation.

Touching El or El will increase or decrease the
value in 1°C increments.

The settable temperature is between 15°C and
30°C.

Temperature difference
(6) | between room temperature
and outdoor temperature

Touch El El to set the
temperature difference as a
condition for activating the Night
purge operation.

Touching E' or El will increase or decrease the
value in 1°C increments.

The settable temperature is between 0°C and
7°C.

(7) | Initial fan speed

Touch El El to set the fan
speed to be set when the Night
purge operation activates.

—p / — I[

(Fan speed 1) (Fan speed 2) (Fan speed 3 or 4)

* The maximum number of available fan speed setting
from AE-200 is three.
Auto cannot be set for the initial fan speed even for
the units that support the Auto setting.
The initial fan speed setting will not appear for the
units with no fan speed switching function.

Note: Setting the “Night purge” setting to [Not Available] during the Night purge operation will stop the Night purge operation of the

ventilation units (LOSSNAY).

Note: The settings changed from a local remote controller will be reflected on this screen.
Note: When [Not Available] is selected in the [Night purge] section, the detail settings (days of the week, start time, end time,
outdoor temperature threshold, temperature difference between room temperature and outdoor temperature, initial fan

speed) cannot be made.
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Night purge control time chart sample
The time chart when conditions below meet is as follows.

1F
Lobby

Night purge Days of the week
| Available ' Sun || Mon || Tue || wed || Thu || Fri || sat |

" Start Time End Time
e gy =N S =)
Setting value 1 > EE EE < Setting value 2

oT threshiltli RoomTempilf Inif faq s:@
[ e g

v B Y]
g 0K I Cancel I

Setting value 3 Setting value 4

Starting condition
Condition #1: LOSSNAY units stop at 20:00.
Condition #2: Between the start time 1:00 (setting value 1) and the end time 6:00 (setting value 2)
Condition #3: LOSSNAY units detected the outdoor temperature threshold 17°C (setting value 3) or higher in
the past 24 hours.
Condition #4: The current room temperature is higher than 22°C. (The temperature 22°C cannot be set from
AE-200.)
Condition #5: The temperature difference between room temperature and outdoor temperature is greater than
the temperature difference 5°C (setting value 4).
* LOSSNAY units start the Night purge operation at 3:00 when the temperature difference between room
temperature and outdoor temperature exceeds 5°C.
» The Night purge operation is not activated at 1:00 or 2:00 because the temperature difference between room
temperature and outdoor temperature is less than 5°C.

i 12:00 16:00 20:00 1:00 3:00 6:00
: Condition #4 Condition #5
/Y\ Room temp.: 25°C Temp. difference: 6°C
7 E i S
! Condition #3 i ~io
Temperature o2oc]| Maeximumoutdoor | - <. I U L
i|  temperature: 29°C

- | 100 | 2:00 ;
= Qutdoor temp. i i i Temp. ! Tomp.
= = Room temp. —E —————————— S I difference: |i-| difference: |——_— — i L
i i i 2°C i 4°C

' Night purge
LOSSNAY ON OFF operation OFF
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5-5. User Information

5-5-1. Maintenance User
On the [Maintenance User] screen, the user names and passwords of maintenance users can be changed.

Touch [User Info] in the menu bar, and then touch [Maintenance User].
Note: The Maintenance User settings are not be accessible if logged in as a building manager.
Note: The Maintenance User settings are required for each AE-200/AE-50/EW-50.

Settinos 4, User Info

. Maintenance User Bui lding Manager
Maintenance user name

and password ' 'User name, Password
User name and password User name Password Retype password

e be cnenosd

Save Settings

Save Settings
Touch to save the changes
made.

(1) To change the maintenance user name or password, touch the [User name], [Password], and [Retype
password] buttons. Enter new information on the keyboard.
Note: The user name must contain only alphanumeric characters.
Note: The user name and password are case-sensitive.
Note: The user name must be in 20 characters or less, and the password in 3 to 10 characters.

(2) Touch [Save Settings].
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5-5-2. Building Manager
On the [Building Manager] screen, the user names and passwords of building managers can be changed, and the
available functions for building managers can be limited.
For example, you can allow building managers to change the group name settings when the tenant is changed, or
disallow them to change the basic system settings such as unit settings or network settings.

Touch [User Info] in the menu bar, and then touch [Building Manager].
Note: The Building Manager settings are required for each AE-200/AE-50.

H o W A User Info

o Maintenance User Building Manager
Building manager’s user
name and password User name, Password
User name and password User name Password Retype password

can be changed. administrator m

Available Functions

Available Functions 8 niitiia(Rsetilings
Select the available Date and time Unit Info.
functions for building
managers. Network Advanced

Groups Groups
(Group Name) (Group Structure)

HW Supply HW Supply
(Name/Advanced) (Structure)
Interlock

Save Settings

Save Settings
Touch to save the changes
made.

(1) To change the building manager’s user name or password, touch the [User name], [Password], and [Retype
password] buttons. Enter new information on the keyboard.
Note: The user name must contain only alphanumeric characters.
Note: The user name and password are case-sensitive.
Note: The user name must be in 20 characters or less, and the password in 3 to 10 characters.

(2) Touch the functions to be made available for building Available Functions

managers. The selected functions will appear with an Date and time

orange frame.

Touch again to deselect. LB

. . . G

For more information on each function, refer to the table T

below. HH Supply HH Supply
(Name/Advanced) (Structure)

Note: If the user logs in as a building manager, the currently Inter lock

available functions can be checked, but cannot be changed.
Blocks Blocks
(Block Name) (Block Structure)

EM Block EM Block
(Block Name) (Block Structure)
Floor layout Floor_ layout
(Floor Name) (Floor Structure)

-
=1
pry
&
v
m
-~

[} -+
=
"]
0w

Function
Peak Cut Peak Cut
Setting Control details!

Measurement Energy Management

Function2

Ext Temp Interlock Setback
Ventilation Settings

Night purge Setting

(3) Touch [Save Settings].
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Table. Available Function List

Function

Content

Date and time

Refer to section 5-1-3 “Date and time” for details.

Unit Info. ™1 Refer to section 5-1-4 “Unit Information” for details.
Advanced "1 Refer to section 5-1-13 “Advanced settings” for details.
Network 1 Refer to section 5-1-5 “Network” for details.
Group Name ) )
Groups - Refer to section 5-1-6 “Groups” for details.
Group Structure "1
HW Supply "1 Refer to section 5-1-7 “HW Supply” for details.
Initial Settings | Interlock *1 Refer to section 5-1-8 “Interlocked LOSSNAY” for details.
Block Name
Blocks Refer to section 5-1-9 “Blocks” for details.
Block Structure "1
Energy Name
Management Refer to section 5-1-10 “EM Blocks” for details.
Blocks Structure *1
Floor Name ) )
Floor layout - Refer to section 5-1-11 “Floor Layout” for details.
Floor Structure *1
Setting Refer to section 5-2-1 “Peak Cut (Energy-save control function)”
Peak Cut - ;
, Control details for details.
Function1 - -
Measurement Refer to section 5-2-2 “Measurement” for details.
Energy Management Refer to section 5-2-3 “Energy Management” for details.
Eunction2 Ext Temp Interlock Refer to section 5-3-1 “External Temperature Interlock” for details.
unction
Setback Refer to section 5-3-2 “Night Setback Control” for details.
\S/:trt]it:;tlon Night purge Refer to section 5-4-1 “Night purge” for details.

*1 At factory shipment, these settings by the building managers are prohibited.
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6.

Settings using Initial Setting Tool

6-1. Flow of the initial settings on Initial Setting Tool
Follow the procedures from step 3 onwards to make the initial settings for the apportioned electricity billing
function.
As shown in flow (D below, settings data can be created beforehand at another location, such as office, to send it
to the centralized controller on the day of the trial run. When changing the settings, collect the settings data from
AE-200 before the change as shown in step 3 .

On the day of \ 4 \ 4

the trial run Updating the
(on-site) AE-200 software *5

*1
*2

*3

*4
*5

*6

By the day v
before the trial Creating the settings
run (at office) data

To change the existing AE-200/AE-50/EW-50 settings, make sure to collect the settings
data from AE-200 before the change. If this process is skipped, incorrect settings data will
overwrite the existing settings.

Initial settings (new registration) (3 When changing the settings

I
d ]

(M (When making the @ (When making the
initial settings off-site) initial settings on-site)

¢ IMPORTANT

Saving the settings data

Collecting the settings data from AE-200

Settings file
(collected from AE-200)

i LAN
. . Inial Setting Tool <
Creating the settings nitial Setiing foo

i | 4

Setting the IP address of AE-200 and
registering licenses "6

Work on data Loading the settings data via LAN "3
site can be - - -
reduced Saving the settings as pre-change data ™1

Example: 20150401A.dat

I

| Changing the settings

d ’

Saving the settings data

d d

| Sending the settings data to AE-200

Saving the settings as post-change data "4
Example: 20150401B.dat
Settings file .
(new settings data) ' i

LAN

Sending the settings data to AE-200
Initial Setting Tool

Sending the settings data via LAN 3

Settings file
(Post-change data)

LAN
Initial Setting Tool —

Sending the settings data via LAN *3

To change the existing AE-200/AE-50/EW-50 settings, make sure to save the settings file (collected from AE-200) before the change.

After the settings data are loaded on the Initial Setting Tool and the changes are made, do not change the settings on the AE-200’s LCD until
you finish sending the setting changes data.

The settings data created on the Initial Settings Tool cannot be imported to or overwritten to by using a USB memory as explained in chapter
8 “Maintenance”, or to the Integrated Centralized Control Web.

Store the settings files set on the Initial Setting Tool (pre-change data and post-change data) in a safe place.

Refer to the AE-200/AE-50 Installation Manual for how to update the software for AE-200/AE-50. Refer to the EW-50 Installation and
Instructions Manual for how to update the software for EW-50.

Refer to section 4-2 “IP address settings” for how to change the IP address. Refer to section 4-5 “License registration for optional functions”
for how to register licenses.
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6-2. General descriptions of Initial Setting Tool
This section explains operation methods that are common to all setting screens of Initial Setting Tool.

6-2-1. Starting up the Initial Setting Tool

J\

AE-200 Initial Setting Tool

The screen below will appear when the Initial Setting Tool is started up.

Open
Click to open the existing
settings file

When [New] is clicked, all the settings in an unset status will be displayed.
When [Open] is clicked, the “Open” screen will be displayed. You can then select and load the settings file saved on
the PC (filename.dat) which has been created beforehand. Once the settings file are loaded, the settings screen will

™t om

| MITSUBISHI Air Conditioning Control System - Initial Setting Tool ==

B

‘COPYRIGHT (C) 2015 MITSUBISHI ELECTRIC GORPORATION ALL RIGHT RESERVED

be displayed with the settings in the file applied.

Note: When [Open] is clicked, the “Library” > “Documents” folder will be selected for the first time. Select the file saved on the

Initial Setting Tool.
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6-2-2. Screen configurations and common items

D Tool bar — P} Ger omcammts it s o T )
@ Tab (UPPer) — (o e oo peees oot sese o st s s e 1 st )
(Lower) ,_>‘Tar_qe(cenlra\|zed controller: |1 Mitsubishi building - )
® Target centralized A Group setings )
controller Group Name — System Configuration ~
=T
/' 1 EI 101 G| o
@ Setting area — o
=
2 EI 102 R
i
[ c—
3 E, 103 R
| |
| —
' E, 104 B
LI >
[ i —— 1} v )
® [Save] — © [Back]
Function Operation method Description
Tool bar Operations such as to create, save, Refer to section 6-2-3 “List of tool bar
® load and send the settings files, and to operations”.
monitor the status of the settings from the
centralized controller are possible.
Tab Click the tab to switch between setting When the “tab” of which you want to make
screens. the settings is clicked, settings screen will be
o) When the upper tabs are switched, the displayed. Enter the settings data and then
corresponding lower tabs will be displayed. | click [Save].
Click the tab of which you want to make the
settings.
Target centralized From the list of the centralized controllers Depending on the settings screen, this may
controller with connection configuration set, select not be displayed.
® one to make the settings.
Settings are required for each centralized
controller.
Setting area The area in which settings are made. Refer to sections 6-3 “Basic settings”, 6-4
@ “Unit settings”, 6-5 “Floor Settings”, 6-6 “Billing
function settings”, and 6-7 “Interlock Control”
for how to make settings.
[Save] Click to save the settings in the Initial Even when [Save] is clicked, the settings data
Setting Tool. (The settings will not be sent.) | will not be sent to the AE-200/AE-50/EW-50.
After all of the settings are completed,
click [Send] in the tool bar to send it to the
® AE-200/AE-50/EW-50. Refer to section 6-2-3
[5] “Send” for details. Note also that even when
saved, the settings are still not been saved in
a settings file. To save a settings file, click [File]
> [Save] or [Save As...] in the tool bar.
[Back] Click to display the previous settings without
©
making any changes.
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6-2-3. List of tool bar operations

MITSUBISHI Air COnditiDninE Caontrol ﬁ - Initial EE T_

File () Data acquisition (M) Send (S) Data verification (V)  Option (O) Hf\p (H)

Basic Se“\ﬂgs LAt Settines I Floor %ttmgs | Billing Fﬁctlon Settings IIn tlock Gontrol Sett"gsl

File
System Canfigykation | Bagic Sygh

Creates, opens (loads) and saves

settings files, and saves settings

files with another name.

'MITSUBISHI Air Conditi I S [11] Help
[ MITSUBISHI Air Conditioning Control System - Inital Seting 100 . . :
M [ Fic ) | oot aonistin ) Send (=) Do vrication ) Opion @) 4 (2 Displays the version of this software.
New () | Fioor Stting [ Biing Fntion Setings | trock Gontro St & MITSUBISHI Air Conditioning Control System - Inital Setting To
[2] t— Open...(Q) Syeen] =
3] save (s) File (F) Data acquisition (M) Send (5) Data verification (V)  Option (0) | Help (H)
= Save As... i
asic Settings | Unit Sattings | Floor Settings | Billing Function Settings | Interlack Contral &
[ e & Basic Settines | | Floor Settings [ Billing Function Settings | Iterlock Gontrol & o)
[12] I [vstem Gonfiston | Baz Sstam|

[4] Data acquisition Option

Acquires settings status of the Able to select the temperature display format

centralized controller. and to output trial run check sheets. [7]

verification (V) ile a n (M) s:amru mfl n (V) | Option (0) |
i Sasc Setings | Unk Setings | Foar Sctings | Blng Fanctin Sigs | ’
Spien Corburon |Baoymen] _A3° 2
1 oupu-c x
[3% )
O [1o]

[5] Send o
Sends the settings data to the centralized [6] Data verification
controller. Verifies the settings data between the Initial Setting Tool

and the centralized controller.

oning ContolSystem - il Stting Tol
" Ry 2 = Z® R MITSUBISHI A\rCﬂndiﬁminE Control ﬁ Tnitial EE T_

asic Setings Uk Stngs oo
File (F)  Data acquisition (M)  Send (S) | Data verification (V) | Option (Q)  Help (H)

I MITSUBISHI Air Cor
Fie( Data

System Corfiguration B

Onlysend he changes (B) !
Basic Settings | Uit Ssttings | Floor Settings | il “eNTy data (V) Control Settings

System Configuration | Basic System

[11 New
Click [File] > [New] in the tool bar to create a new “settings file”.

[2] Open
Click [File] > [Open] in the tool bar to load the “settings file” saved on the PC.

[3] Save

Click [File] > [Save] or [Save As...] in the tool bar to save a settings file on the PC.
Note: After the settings are completed, save the settings file and store it in a safe place.
Note: The file will not be saved on the AE-200/AE-50/EW-50.
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[4] Data acquisition
Loads the AE-200/AE-50/EW-50 settings data on the Initial Setting Tool.

(1)

()
@)

Note: When changing the AE-200/AE-50/EW-50 settings, make sure to select [Acquire data] first.

Click [Basic Settings] > [System Configuration] and enter the IP address of the AE-200/AE-50/EW-50 from
which the data is to be acquired. Then click [OK] at the bottom of the screen. (Refer to section 6-3-1 “System
Configuration settings” for details.)

Click [Data acquisition] > [Acquire data] in the tool bar.

If the settings have been changed, a “Confirmation” screen will be displayed asking you to confirm the save
operation. Select [Yes] to display the “Authentication information input” screen.

Authentication information input =

Centralized controller system Y Password input L
clerle: o oo L Enter the password for initial

) | —— settings for the centralized

11 Mitsubishi buildine 1F o
controller.
12 Mitubishi building 2F %
. i Vit b oF —~ ID in
Centralized controller name —— » put

i building 4F

Enter the ID for initial settings for
the centralized controller.

5]

i building 5F

=

22 Mitsubishi buiding 6F

=

S A B B2

5]

- Check box

Check the checkbox when the ID
and password are the same as the
ones for the centralized controller

No. 1.
(4) Enter the maintenance user ID and password of the centralized controller from which the data is to be
acquired.
If the ID and password are the same as ones for the centralized controller No. 1, check the “Same as No.1”
checkbox.
(5) Click [OK] to acquire the data of the settings on the centralized controller. The settings will then be applied
on the Initial Setting Tool.
Note: If data acquisition fails, the settings on the centralized controller registered in “System Configuration” will not be
applied to the settings on the Initial Setting Tool.
Refer to section 6-3-1 “System Configuration settings”.
[5] Send
Send the settings to the centralized controller. Select the one that suits your usage from the three options below.
Send (S) | Dataverification (V)  Option (Q)  Help (H)
Send to all controllers (S) ck Control Settings  Function settine:
| Send to a selected controller (1) 3 | Send all settings (D)
| Only send the changes (F)
(1) Initial settings
Click [Send] > [Send to all controllers] in the tool bar.

(2) Adding a unit or replacing the centralized controller due to malfunctions

Cl

ick [Send] > [Send to a selected controller] > [Send all settings] in the tool bar.

(3) Other than above

Cl
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Send target X

The settines will be sent to the following centralized controllers

Centralized controller No. Send target

I AE-200 o7 =
-1 AE-60 No3t

12 AE-60 No32

40 AE-200 NodD

40-1  AE-50 Nod0

40-4  AE-50 No38

el

When step (1) above is taken, the settings will be sent to all centralized controllers.
When step (2) or (3) above is taken, the send-target centralized controller will appear after all the centralized
controllers are scanned for. (The send-targets cannot be selected.) Click [OK] to send the setting changes to the
target centralized controllers.

Note: This sends the settings data to all the centralized controller IP addresses set in “System Configuration” at once.

Note: Before sending the settings data, check that all the required settings are correctly made. All the items that are not set yet will

be sent to the centralized controller as unset items.
Note: To change the settings, first save the acquired settings and make the setting changes before sending the settings data.

[6] Data verification
Checks whether there are mismatched data in the billing-related settings between the Initial Setting Tool and the

centralized controller.
Note: Refer to the Instruction Book (Apportioned Electricity Billing Function) for details of data verification.

, i

Qutput target; @ Sinele output

() Batch output
Gentralized controller: [1 AE-200 ‘]
Output type: [Items to be checked during the trial run v]

| oot || oo |

[7] Temperature unit
Click [Option] > [Temperature] in the tool bar to select the temperature display format on the Initial Setting Tool from
Celsius (°C) and Fahrenheit (°F).

Note: Switching between Celsius and Fahrenheit consists of changing the unit shown on the Initial Setting Tool and does not

set the unit used on each of the centralized controllers. To change the unit shown on the centralized controllers, make the
settings in “Unit of temperature” setting in [Basic Settings] > [Basic System].
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[8] Output - Check sheet for billing function trial run
Click [Option] > [Output - Check sheet for billing function trial run] in the tool bar to output the check sheet used for
billing function trial runs.

Note: The check sheet will be output based on the settings on the Initial Setting Tool.
If the settings on the AE-200/AE-50/EW-50 and the Initial Setting Tool are not the same, the billing function trial will not run
correctly. Be sure to complete [5] “Send” before starting the trial run.

(1) Click [Option] > [Output - Check sheet for billing function trial run] in the tool bar.

Output - Check sheet for billing function m_ ===
Output target
. Qutput target © Single output
Centralized controller ) Batch output
0utput type Gentralized controller: (1 aE-200

Cutput type: [ltems to be checked during the trial run

Data Output

Close
Data Output

(2) Click the pull-down menu (V) for “Centralized controller” and select the number for the centralized controller
to be output.

Note: This centralized controller number is the one set in section 6-3-1 “System Configuration settings”.
Note: To output the check sheet for all centralized controllers and all output types at once, select [Batch output] for “Output
target”.

(38) Click the pull-down menu (V) for “Output type” and select the [Items to be checked during the trial run] for
the first trial run. For the second trial run, select [Items to be checked 10 days after the trial run]. For the
third trial run, select [ltems to be checked on the next day of the closing date].

(4) Click [Data Output].

(5) Set the file name and save destination and then click [Save].
Note: Refer to the Instruction Book (Apportioned Electricity Billing Function) for details of the check sheet.

[9] Output - Check sheet for air-conditioner ON/OFF trial run
Click [Option] > [Output - Check sheet for air-conditioner ON/OFF trial run] in the tool bar to output the check sheet
used for air-conditioner ON/OFF ftrial runs.

Note: The check sheet will be output based on the settings on the Initial Setting Tool.
If the settings on the AE-200/AE-50/EW-50 and the Initial Setting Tool are not the same, the air-conditioner ON/OFF trial will
not run correctly. Be sure to complete [5] “Send” before starting the trial run.

(1) Click [Option] > [Output - Check sheet for air-conditioner ON/OFF trial run] in the tool bar.

Output - Check sheet for air-conditioner ON/OFF _ e

Output targst: @ Sinele output

Centralized controller © Bateh autput

Output target

Gentralized controller 1 AE-200 -

Data Qutput Close
N Close

Data Output

(2) Click the pull-down menu (V) for “Centralized controller” and select the number for the centralized controller

to be output.
Note: This centralized controller number is the one set in section 6-3-1 “System Configuration settings”.
Note: To output the check sheet for all centralized controllers at once, select [Batch output] for “Output target”.

(3) Click [Data Output].

(4) Set the file name and save destination and then click [Save].

Note: Refer to “Appendix 1: Air-conditioner ON/OFF trial run” for the contents of the check sheet.
Note: When the PC with Initial Setting Tool installed and the centralized controller are connected via a LAN, the license
registration status can be output in the check sheet.
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[10] Register the license
Licenses can be registered for each centralized controller individually, or collectively by importing a CSV file that
contains license information. Refer to section 4-5 “License registration for optional functions” for details.

[11] Help
Click [Help] > [About] in the tool bar to display the version of the current Initial Setting Tool.
rAbout Mw
& MITSUBISHI
ELECTRIC
ﬂ _r|\_401'£|SUEl]SHI Air Conditioning Contral System - itial Setting

Mer, ®AE

[12] Exit

Click [File] > [Exit] in the tool bar to exit the Initial Setting Tool.

WT07627X17 99



6-2-4. Unit address selection screen

On unit address selection screen and group registration screen displayed from the group settings screen, the

selectable unit addresses and groups will be displayed.

When an icon is clicked and selected, the background will change to yellow-green. To deselect an icon, click

the icon again and it will then turn into deselected status (the background will change to light gray). Click [OK]

to complete the selections and close the screen. Click [Cancel] to cancel your selections and close the screen.
Addresses and groups that have already been registered elsewhere will be in gray background and will not be able

to be selected.

On unit address selection screen displayed from the group settings screen, an icon can be changed. To change an
icon, click the icon selection button. Select the desired icon on the group icon selection screen. The selected icon
will be displayed on the AE-200/AE-50’s LCD and in the AE-200/AE-50/EW-50 web browser.

Group other than general equipment group

— —
Select Unit Addresses

=

Chillr
LOSSNAY
Frumidifer

[ Outlet temp. contol

is PAC-YG50CA)

=

System controller

Select Unit Addresses

Group Name:
Groupd!

Block settings

Select Groups

Energy management block settings

Select Blocks

==

Enerey mangement block name:

Enerey Mansgement Block001

BBl 52 ot Bt

i e o]

6-2-5. Other settings
» Up to 40 characters can be entered as the name on the basic system settings screen. Up to 20 characters

General equipment group

Icon selection

&

Select Unit Addresses

Group Name:

Groupd!

Thillr
LOSSNAY

LOSSNAY with heater /humidifier
| Equipment (via PAG-YGBEDCA)

e e
[LRINERIE  on idividualeroup
® w w ol roup

© No operations (Monitor only)
38 39 40 - Y
B 4w | Meni

© Output status

put status

Remote controller

Select Unit Addresses

Group Name:
Groupd!

o1 w2 s e w5 w6 07 e e
W s e s e 17 w6 e
o 2 w5 e
1 182 @ s a5 10 197 s 89
W s W s e W e e
LR MO A
1 82 6 6 15 180 167 68 e
W mm us e m
1 182 (63 e 195 186 167 1s8 189
to 192 e fe a5 1 167 s e

Refrigerant system (indoor unit) settings,

Interlocked LOSSNAY settings, Al controller

settings

Select Unit Addresses ==
17 e e e e e
W ow BB w oW
o [ [ [ [ [ [ [ (o (w0
ot (o2 (oo (o (o8 (o6 (o7 (o8 (58 [0
R R O A A A R

PI controller settings

Select Unit Addresses ==
Pl
ilelslelalalo ool
Mo 1 1w 15 B 7 1B 1w
ETIEIY I TRR IR T T I
s 82 8 8 % % ¥ B 8 M
LI I Tt ST B I )

can be entered as names in other setting screens.
* The following characters cannot be used for name settings: <, >, &, “, or
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Select Unit Addresses ==

Graup Name:
Groupd!

M 2 M3 s WS W6 AT B 23 200

a1 212 213 214 25 26 27 23 213 220

21 2 224 25 26 27 228 229 2w

281 2w 25 28 285 28 207 28 280 20

1 U2 B e UG S AT B Y 260

Refrigerant system (outdoor unit) settings

Select Unit Addresses ==
51 B 8 B 8 8 & 68 8 6
6 62 68 6 6 6 6 68 60 70
ELI I I TR I I T T
81 82 88 8 8 8 & 88 8 0
o @ m e % % 9 s 9 100

Metering device settings

Select Unit Addresses

DEEBREEREE

[}

B £z B8 Bt




6-2-6. Preparation and flow of the Initial Setting Tool
To change the AE-200/AE-50/EW-50 settings (for systems with initial settings already made), make sure to first
acquire data of the settings status using the Initial Setting Tool and then follow the procedure below. If you follow a
different procedure, the settings may not be correctly made.

(1) Connect the AE-200/AE-50/EW-50 to a PC (the Initial Setting Tool) via a LAN.
(2) Start up the Initial Setting Tool.

(3) Click [New] or [Open].
To load a settings file stored on the PC, select [Open].
Otherwise, select [New].

(4) Register the IP address of the AE-200/AE-50/EW-50 in [Basic Settings] > [System Configuration].
Refer to section 6-3-1 “System Configuration settings” for details.

(5) Click [Data acquisition] > [Acquire data] in the tool bar to load the AE-200/AE-50/EW-50 settings information
onto the Initial Setting Tool.
* Enter the user ID and password for an AE-200/AE-50/EW-50 maintenance user.

(6) Click [File] > [Save As...] in the tool bar to save the pre-change initial settings data.

Note: For backup purposes, save the pre-change settings file under a file name such as “date + pre-change”.
Note: At this point, the settings will not be sent to the AE-200/AE-50/EW-50.

(7) Change the initial settings. Refer to sections 6-3 “Basic settings”, 6-4 “Unit settings”, 6-5 “Floor Settings”,
6-6 “Billing function settings”, 6-7 “Interlock Control”, and 6-8 “Function settings”.

(8) Click [File] > [Save As...] in the tool bar to save the settings data on the PC.
Note: Save the data using a different name to the pre-change settings file, such as “date + post-change”.
Note: At this point, the settings will not be saved on the AE-200/AE-50/EW-50.

(9) Click [Send] > [Send to all controllers] to overwrite the AE-200/AE-50/EW-50 settings data registered in
System Configuration settings.
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6-3. Basic settings

6-3-1. System Configuration settings
Make the configuration settings of centralized controllers and expansion controllers on the Initial Setting Tool.
Click [Basic Settings] > [System Configuration] to access the system configuration settings screen.

(1)

()
@)
(4)
®)

(6)

Note: Connection settings can be made for up to 40 centralized controllers.

AE-200 units set as the [AE-200 (Billing)] or [AE-200 (No M-NET)] will not be included in this 40 controllers.

Click the “Controller type” pull-down menu (V) and select [AE-200], [AE-200 (No M-NET)], [AE-200 (Billing)],
or [EW-50].

Enter the IP address in “Destination IP address”.
Click the “Expansion controller” checkbox.
Enter the IP address of the AE-50/EW-50 in “Destination IP address”.

If there are multiple AE-200/EW-50 units, click the “Centralized controller” checkbox and repeat procedures
1to 4.

Click [Save] after completing the settings.

Note: The selectable options vary depending on the type of centralized controller selected in the “Controller type” of
Centralized controller.

Note: The AE-200/AE-50/EW-50 IP address and expansion controller connection settings cannot be changed in this setting
screen.
To set the AE-200/AE-50/EW-50 IP address, set on the AE-200/AE-50’s LCD, Initial setting tool or the quick IP
address setting switch (EW-50 only). To increase the number of expansion controllers to be connected, set the
setting on the LCD of the AE-200.

@ MITSUBISHI Air Conditioning Control System - Initial Setting Tool ﬂ
File (F) Data acquisition (M) Send (S) Data verification (V)  Option (Q)  Help (H)
Basic Settings: | Unit Settings | Floor Ssttings | Billing Function Settings |
System Configuration
Expansion controller
System Configuration Settings Check the checkbox to add
Gentralized controller Destination IP address Expansion controller Destination IP address an eXpanSiOn COntrO”er.
1 [#E-200 (Billine) ] 18218811 - ‘ =
Controller type ] U
i - A
Set the centralized controller = RIS
type "
yp : 2 [AE=200 (Mo M-NET) ] [192.T68.12 21 [lezieeTais ]
. 22 (EALRED Destination IP address
Centralized controller = Set the IP address of the
Check the ch_eckbox to add 2l o expansion controller.
a centralized controller. §] 12 (et b <] [ I
The checkbox of the first a2
row is checked and cannot il
be unchecked
’ 4 @ [Ew-50 ] 18216814
Destination IP address
Set the IP .address of the
centralized controller.
Save — —— Back
Click to save the settings. Click to display the previous
settings without making any
changes.
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6-3-2. Basic System settings
Click [Basic Settings] > [Basic System] to access the basic system settings screen.
Make necessary basic system settings such as unit settings and M-NET settings for each centralized controller.

Target centralized N\

Contro I Ie r IS MITSUBISHI Air Conditioning Control Syst\ - Initial Setting Tool X
File()  Dataacquisition (M)  Send (S) \a verification (V) Option (Q)  Help (H)
Select the connected

Basic Settines  Unit Settings  Floor Settines  Billing\unction Settings  Interlock Control Settings ~ Function settines.

centralized controller whose System Genfiuration (B35 Syiiem ]
baSIC settlngs are tO be Target centralized controller: ™ 1 Mitsubishi building v | M_N ET s ettin g s
made.
Set the M-NET address
Unit Settings and range of prohibited
Set the centralized controller Name controllers.
. . Unit ID 1000001 (6 figures)
name and unit ID. The serial e HNET Adsrss
number and the SOftWare Software Version Acquire ‘ Range of Prohibited Controllers @ SC/RC O RC Only External Input Settlng
version can be acquired. Betrloots © bamant Lol sna/lot e Set the external signal input
R . —] O Emereency Stop (Level sienal) mode.
Decimal point character - O ON/OFF (Level sienal
(O ON/OFF/Prohibit/Permit (Pulse signal)
and separator character .
for CSV file £38 Advanced Setting.
Set the format of the CSV k
file that is output from the © 00 .
. it of Temperature "o CF —l
Centra“zed COntrO”er. :e‘ssljv:un:eni‘measme @MPa O PSI O kef/em2 A(.’vance.d Settlng
— Date Format @ 3171272019 O 12/31/2019 O 2019/12/31 CIICk tO dlSplay the screen
Time Format O 0600 PM @ 1800 for making advanced
. Group name display on Gondition List screen O ON - @ OFF .
Display Format B> i vy @on QoFF settings.
Set the screen dlsplay items Temperature display (for LGD) @ Room temp. (Always) O Room temp. (During operation) (O Set temp.
. O Room temp. (Always)/Set temp. (O Room temp. (During op)/Set temp. v
for the centralized controller = =
and the Web browser.
Save — \— Back
Click to save the settings. Click to display the previous
settings without making any
changes.

[1] Unit Settings

Set the AE-200/AE-50/EW-50 unit name and unit ID in “Unit Settings”.

Clicking [Acquire] will start communication with the AE-200/AE-50/EW-50 selected in “Target centralized controller”,
and its serial number and software version will be displayed.

Mame |Mitsubishi building |

Unit ID nonom (6 figures)
SERIAL Mo. 23164-027
Software Werzion prorrRR

(1) Enter the unit name in “Name” in 40 characters or less. The name entered here will be used as a sender
name in the error notification e-mail and e-mail alarm.

(2) Enter the unit ID in “Unit ID” in 6 figures. Use this setting to manage the multiple unit IDs.

Note: The unit name and the unit ID can be set for each centralized controller that can be selected in “Target centralized
controller”.

Note: The name entered here will be displayed in “Target centralized controller”.

Note: The unit ID will be used as a sender ID in the error notification e-mail and e-mail alarm.

Note: When the software is updated, check that the ####(****) in “Software Version” is the same as the # of the update file
(AEXx_FWi#HH **** dat).
For example, if the AE-200 software version is 7.70 (1.07), the update file name is “AE200_FWO0770_0107.dat”.
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[2] Network setting
Click the [Network setting] button to access the network settings screen.

Note: LAN2 is exclusively used for BACnet® function. For BACnet® function settings, refer to the Instruction Book (BACnet®
function).

Note: Although the settings for LAN1 and LAN2 will appear on the screen, only the settings for LAN1 is required. However, only
when the LAN1 IP address is required to be set to [192.168.2.1], change the default LAN2 IP address to avoid address
overlap.

Note: To operate EW-50 according to the settings made with the Initial Setting Tool, set the rotary switch (SW1) to “0.”

Note: After the AE-200 IP address is changed, the AE-50/EW-50 power will be reset.

Clicking [Acquire] will communicate with AE-200/AE-50/EW-50 selected as “Target centralized controller,” and
display the current network settings.

Clicking [Edit] will reflect the network settings to the target centralized controller, then the target centralized
controller will be reset.

LAN1 LAN2
Network setting X
I
LAM1T Settings LAN2 Settings
IF Address 192.168.1.1 1P Address 192.168.12
Subnet Mazk 255255 2650 Subnet Mazsk 255255625510
Gateway 192.168.1.254
MAC Addrezs MAC Address
Bcquire Edit

(1) Settings for connecting the AE-200/AE-50/EW-50 to a dedicated LAN

(1) Enter the AE-200, AE-50, or EW-50’s IP address in the [IP Address] field. If the LAN has been newly set up,
allocate IP addresses to the AE-200 units in a sequential order starting with [192.168.1.1]. For example, the
first AE-200 unit will have an IP address of [192.168.1.1], the second AE-200 unit will have an IP address of
[192.168.1.2] and so on.

Allocate IP addresses to the AE-50/EW-50 units in a sequential order starting with [192.168.1.211].
Note: The recommended IP address ranges are as follows.
AE-200: Between [192.168.1.1] and [192.168.1.40]

AE-50/EW-50: Between [192.168.1.211] and [192.168.1.249]
PC: Between [192.168.1.101] and [192.168.1.150]

[IP address setting example]

Hub
100 BASE-TX LAN straight cable |
AE-200 E AE-50 E_ AE-50 E
192.168.1.1 | [192.168.1.211| | 192.168.1.212 | | 192.168.1.101

Note: Some hubs have dedicated ports for connection with another hub.
Connect the AE-200/AE-50/EW-50 and PC to the normal ports.

(2) Enter [255.255.255.0] in the [Subnet Mask] field (unless otherwise specified).

WT07627X17 104



(3) When monitoring the system remotely or using e-mail function via a dial-up router, enter the router IP

address in the [Gateway] field.

Leave the [Gateway] field blank when not connecting a dial-up router.

[Remote Monitoring System example]

Telecommunication Network

Dial-up router
| IP Address: 192.168.1.254 |

AE-200 (=

Dial-up router, cellular phone etc.

IP Address: 192.168.1.1
Subnet Mask: 255.255.255.0
Gateway: 192.168.1.254

IP Address: 192.168.1.101
Subnet Mask: 255.255.255.0

Gateway: Blank

Note: [192.168.1.254] is recommended for use as the IP address of the dial-up router. Refer to the dial-up router
instruction manual for details of how to set the IP address.

Note: The use of a dial-up router with no modem requires a modem (for analog or ISDN) to be connected between the

router and the public phone line.

(2) Settings for connecting the AE-200/AE-50/EW-50 to an existing LAN

(1)

the IP, subnet mask, and gateway addresses.

[Existing LAN System example]

When connecting the AE-200/AE-50/EW-50 to an existing LAN, consult the system administrator to decide

Backbone LAN

| |
Gateway Gateway
[ 10.1.1.250 | [ 10.1.2.250 |

AE-200 12 Obtain the addresses from

the system administrator.

Obtain the addresses from
the system administrator.

X

¥\
IP Address: 10.1.1.1

Subnet Mask: 255.255.255.0
Gateway: 10.1.1.250

IP Address: 10.1.1.101

Gateway: 10.1.1.250

Subnet Mask: 255.255.255.0

IP Address: 10.1.2.51
Subnet Mask: 255.255.255.0
Gateway: 10.1.2.250

WT07627X17

105




[3] M-NET settings

M-MET fddress D

Range of Prohibited Contrallers @) SC/RGC ) RG Only

(1) Enter[0] in “M-NET Address” (unless otherwise specified).

(2) When the local remote controller operation is prohibited on the centralized controller, this setting determines
the scope of its applicability. Select [SC/RC] to prohibit the operation from both the sub system controllers
and the remote controllers. Select [RC Only] to prohibit the operation only from the remote controllers.

[4] External Input setting
In “External Input Setting” column, set the external contact input function. Using a level signal or pulse signal of the
external contact input function, the air conditioning units can be collectively controlled (e.g., stopped, operated) via

a separately-sold external input/output adapter (PAC-YG10HA-E).
Note: Peak Cut control is performed based on the demand level signal (level 1 to 4) input from the connected demand controller.
Note: A separate license is required to use the Peak Cut function.
Note: The external input setting is required for each AE-200/AE-50/EW-50.

@ Demand (Level zignal)/Nat in uze

() Emergency Stop (Level signal)
() OMSOFF (Level signal)

) OMSOFF/Prohibit/Permit {Pulze signal)

(1) Select one of the following options, referring to the AE-200 Technical Manual: [Demand (Level signal)/Not in
use], [Emergency Stop (Level signal)], [ON/OFF (Level signal)], [ON/OFF/Prohibit/Permit (Pulse signal)].

[5] Advanced Settings
Click [Advanced Setting] to open the advanced settings screen.

Advanced Setting M
Time Master @ Master () Sub
Schedule: Season setting @ #vailable ) Mot Available
Old model compatibility mode &) OM @ OFF
Hold type @ Mormal () Forced
[ QK ] [ Gancel

(1) Time Master/Sub

(1) In “Time Master”, select [Master] or [Sub]. When using two AE-200 units to operate and monitor the
connected units, set to [Master] on only one AE-200, and set to [Sub] on the other AE-200.
The date and time synchronization is performed from the AE-200 whose “Time Master” setting is set to
[Master] to the AE-200 whose “Time Master” setting is set to [Sub].

Important

e When only one AE-200 unit is connected to the system, leave the default setting [Master] as it is.

e \When multiple AE-50/EW-50 units are connected to the system, leave the default setting [Master] as it is on all
AE-50/EW-50 units.
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(2) Schedule: Season setting

(1)

In “Schedule: Season setting”, select [Available] to enable the seasonal settings of the weekly schedules
and [Not Available] to disable. Unless otherwise specified, leave the default setting [Available] as it is.

(3) Old model compatibility mode

(1)

In “Old model compatibility mode”, select [ON] or [OFF].

Selecting [ON] will exclude the functions that require the indoor units to support the auto dual set point
mode. This function is useful when new and old indoor units that support or do not support the auto dual set
point mode exist in a given system, or when connecting a high-level building management system that does
not support the auto dual set point mode is connected via the BACnet® function.

Select [ON] when not using a Dual set point function and the Prohibit Remote Controller function (Timer, Air
Direction, Fan Speed).

The following functions are available.

O : Available
Setting Old model compatibility mode OFF ON
Model New indoor unit| Old indoor unit | New indoor unit| Old indoor unit
Set temperature  |Auto dual set point mode O |
Auto single set point mode O O
Prohibit remote  |ON/OFF O O O
controller Operation mode O O O
Set temperature O O O
Filter sign reset O O O
Air direction O
Fan speed O
Timer O

When some of the connected indoor units support a Dual set point function and some do not, selecting [ON]
will mean that they all do not support the function.
When some of the connected indoor units support the Prohibit Remote Controller function (Timer, Air
Direction, Fan Speed) and some do not, selecting [ON] will mean that they all do not support the function.
Note: When changing the old model compatibility mode while this mode is used, note the following.
* The set temperature will go back to the default setting value. Write down the current set temperature of each
group to reconfigure the set temperature settings later.
» The set temperature for the schedule settings will be cleared. Write down the current set temperature of each
group for schedule settings to reconfigure the set temperature settings later.
* Some equipment whose operation is to be interlocked with another equipment support the dual set point
function in the Auto mode. Reconfigure the Interlock Control setting if it is affected by the change of the old
model compatibility mode.

(4) Hold type

(1)

In “Hold type”, select [Normal] or [Forced].

The Hold function is a function to disable the operations that were scheduled for air conditioning unit
groups. If the setting for [Hold] is set to [ON] on the Monitor/Operation screen and the “Hold type” on the
screen above is set to [Forced], the [Hold] setting can be cancelled only from the AE-200/AE-50/EW-50.
If the “Hold type” is set to [Normal], the [Hold] setting can be cancelled from AE-200/AE-50/EW-50, other
system controllers, or remote controllers.

Note: The Hold function can be used on the AE-200A/AE-50A/EW-50A, but not on the AE-200E/AE-50E/EW-50E.
Note: The Hold function cannot be used on general equipments.
Note: The setting [Forced] will not be effective on Air To Water (PWFY)) unit groups, LOSSNAY unit groups, and air conditioning

WT07627X17

unit groups that do not support the Hold function (i.e., Mr. Slim M-Series/P-Series indoor units).

107



[6] Display Format
Set the items in “Display Format”.

Dizplay Format

@'C O°F

) MPa ) PSI () ketdom?

32016 O 122006 O 201651240
O 060D PM @ 1800

ON @ OFF

ON € OFF

Unit of Temperature

@

Frezsure unit of measure

Date Format
Time Format

Group name digplay on Condition List screen

® G G

Filter Sien Display

®

Temperature dizplay (for LGD) Foom temp. (Always) () Room temp. {During operation) () Set temp

() Room temp. {Always)/Set temp () Room temp. (During op J/Set temp

© Hide

®

) Room temp. (Always) ) Foom temp. (During operation) () Set temp.
) Room temp. {Ahways)/Set temp, () Room temp. (During op )/Set temp.
© Hide

Temperature display (for Web)

Qooupancy sensor display ) Hide @ Show occupancy icon, ) Shaw vacancy icon. () Show both icons.
Brighthess sensar display @ Hide ) Show bright icon. () Show dark icon. ) Show both icons.
Humidity sensor display @ ON () OFF

In “Unit of Temperature”, select the desired temperature unit.

In “Pressure unit of measure”, select the desired pressure unit.

)
)
(3) In “Date Format”, select the desired display format for year, month, and date.
) In“Time Format”, select the desired display of time format.

)

In “Group name display on Condition List screen”, select [ON] to display the group names under the icons
on the Monitor/Operation screen. Select [OFF] not to display the group names.

(6) In “Filter Sign Display”, select [ON] to display the filter sign on the Monitor/Operation screen, and select [OFF]
not to.
When the “Filter Sign Display” is set to [OFF], the filter sign will not appear on the Monitor/Operation screen
even when the indoor unit detects a filter cleaning signal.
If the filter is regularly cleaned and the sign display is unnecessary, set it to [OFF].

(7) Inthe [Temperature display (for LCD)] section, select the desired display option for the room temperature or
the set temperature to be used on the [Floor] or [Block] display on the LCD.
In the [Temperature display (for Web)] section, select the desired display option for the room temperature or
the set temperature to be used on the [Floor Layout] screen on the Integrated Centralized Control Web.
Select [Room temp. (Always)] to display the room temperature at all times, [Room temp. (During operation)]
to display the room temperature only during operation, [Set temp.] to display the set temperature at all
times, [Room temp.(Always)/Set temp.] to display both the room temperature and set temperature at all
times, [Room temp.(During op.)/Set temp.] to display the room temperature only during operation and
to display the set temperature at all times, and [Hide] not to display the room temperature or the set
temperature.

Note: The room temperature shown may be higher than the actual temperature especially when the unit is stopped during
the Heat mode. Therefore, selecting [Room temp. (During operation)] is recommended when displaying the room

temperature.
Note: The outlet air temperature is displayed for the room temperature of outlet air temperature control units.

(8) In “Humidity sensor display”, make the Show/Hide setting for the humidity reading of the built-in humidity
sensor on the ME remote controller (North America: PAR-UO1MEDU, Other countries: PAR-U0O2MEDA).
Select [ON] to display the humidity reading on the Monitor/Operation screen.

Note: The table below summarizes the items that are displayed on the Monitor/Operation screen according to the
combination of the settings for “Temperature display” and “Humidity sensor display.”

Temperature display
Humidit [Room temp.(Always)/
sensory [Room temp. (Always)] Settemp]
i or [Set temp.] or Hide
displa i :
play [Roor:)wptgrrgt;i)(.)r(lgurmg [Room temp.(During op.)/
Set temp.]
OFF Upper: Room temp. Upper: Set temp. Upper: Room temp. Upper: N/A
Lower: N/A Lower: N/A Lower: Set temp. Lower: N/A
ON Upper: Room temp. Upper: Set temp. Upper: Room temp. Upper: N/A
Lower: Humidity Lower: Humidity Lower: Set temp. Lower: Humidity
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(9) In“Occupancy sensor display”, make the Show/Hide setting for the occupancy/vacancy status that is
detected by the built-in occupancy sensor on the ME remote controller (North America: PAR-UO1MEDU,
Other countries: PAR-U02MEDA).

Occupancy icon Vacancy icon

(Blue) (Gray)

Select [Hide] not to display the occupancy/vacancy status on the Monitor/Operation screen.

Select [Show occupancy icon] to display the occupancy icon when the sensor on the remote controller
detects occupancy.

Select [Show vacancy icon] to display the vacancy icon when the sensor on the remote controller detects
vacancy.

Select [Show both icons] to display the occupancy or vacancy icon according to the occupancy status of the
room.

Note: If the ME remote controller has no built-in occupancy sensor, the occupancy/vacancy icons will not be displayed on
the Monitor/Operation screen.

(10) In “Brightness sensor display”, make the Show/Hide setting for the brightness/darkness status that is
detected by the built-in brightness sensor on the ME remote controller (North America: PAR-UO1MEDU,
Other countries: PAR-U02MEDA).

Brightness icon Darkness icon

(Yellow) (Gray)

Select [Hide] not to display the brightness/darkness icons on the Monitor/Operation screen.

Select [Show bright icon] to display the brightness icon when the brightness level in the room reaches the
predetermined brightness level.

Select [Show dark icon] to display the darkness icon when the darkness level in the room reaches the
predetermined darkness level.

Select [Show both icons] to display the brightness or darkness icon according to the brightness/darkness
level of the room.

[7] CSV file format settings (separator character and decimal point character)

(1) Set the format of the AE-200 CSV file (Energy management data, apportioned results, charges calculation
results from the Charge Calculation Tool).

Important

e This setting must be the same with the “Decimal point character for CSV file” and “Separator character for CSV file”
settings on the [Advanced Settings] screen on the Charge Calculation Tool. If the settings are not the same, an error
message “The CSV file format is not appropriate. Check the directory from which the CSV file is acquired.” will appear.

e When multiple AE-200 units are connected, make the same settings for all of them.

[8] Saving the settings
Click [Save] after setting [1] to [6] above.
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6-4. Unit settings

This section explains how to make unit settings on the Initial Setting Tool.

6-4-1. Group settings
Note: Each group can contain up to 16 air conditioners.
Note: Air conditioners (City Multi indoor unit), Air conditioners (A-control), LOSSNAY units, OA Processing units, Air To Water (PWFY)

units, HWHP (CAHV, CRHV) units, chiller units, and general equipment groups cannot be combined in one group.

Note: HWHP (QAHV) units cannot be registered from the Initial Setting Tool. Register the HWHP (QAHV) units on the LCD.

Note: When registering LOSSNAY units or OA Processing units, do not combine the units that support Night Purge function and the
units that do not in one group.

Note: The addresses of the units that have been registered to other groups or used for the Refrigerant System settings, the interlocked

LOSSNAY settings, Pl controller settings, or Al controller settings will appear with a gray background and cannot be selected.

(1) Click [Unit Settings] > [Groups] to access the group settings screen.

Register the groups of air conditioning units, LOSSNAY units, OA Processing units, Air To Water (PWFY)
units, HWHP (CAHV, CRHV) units, chiller units, general equipment, remote controllers, system controllers,
or AHC to be connected to the AE-200/AE-50/EW-50.

Unit registration

& MITSUBISHI Air Conditioning Control System - Initial Setting Tool

==

File (F) Dataacquisition (M) Send (S) Data verification (V) Option (Q)  Help (H)

Target centralized
controller

Select the connected
centralized controller whose
group settings are to be
made.

Basic Settings | Unit Settings | FloomSatines | Billing Function Settings |

Groups | Refrigerant System | !Mev\m:kedm Blocks | Enerey Management Block | PIGentroller | AL cmmus/

Target centralized cunt@ [H Mitsubishi building 1F

Group Settings

Group Name

il

Group No.

Click to display the screen
for registering the air
conditioners, Air To Water
(PWFY) units, LOSSNAY
units, OA Processing units,
HWHP (CAHV, CRHV) units,
chiller units, and general
equipment.

Group name

System controller
registration

Click to display the screen
for registering the system
controllers.

Remote controller

=

T

~——

registration

Click to display the screen
for registering the remote
controllers.

— AHC registration
Click to display the screen

Save
Click to save the settings.

(2) In“Group Name”, enter the group name in 20 characters or less.

for registering the AHC.
\ Back

Click to display the previous
settings without making any
changes.

(3) Click the icon in “Unit registration” ( ¥ ) to display the unit address selection screen.

(4) Select [Air-conditioners], [Air-conditioners (A-control)], [Air To Water], [HWHP], [Chiller], [LOSSNAY],
[LOSSNAY with heater and humidifier], or [General Equipment (via PAC-YG66DCA)]. To register outlet
air temperature control units, select [Air-conditioners], and then check the checkbox next to [Outlet temp.

control].

(5) Select the address numbers of the units to be registered.

(6) When [General Equipment (via PAC-YG66DCA)] is selected, select the contact number that is connected to
the general equipment to be registered.

(7) To change the icon,

click the right or left arrow.

The selected icon will be displayed on the AE-200/AE-50’s LCD and on the AE-200/AE-50/EW-50’s
Integrated Centralized Control Web.
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(8) When [General Equipment (via PAC-YG66DCA)] is selected, make the setting to allow or disallow operation
in “Allow Operations”.
Select [In batch and on individual group] to allow the operator to turn on or off the general equipment
collectively or by the groups.
Select [On individual group] to allow the operator to turn on or off the general equipment by the groups.
Select [No operations (Monitor only)] to disallow the operator to turn on or off the general equipment.

(9) When [General Equipment (via PAC-YG66DCA)] is selected, in “Monitor”, select which status will be used
to reflect the units’ ON/OFF status to the unit icons on the Monitor/Operation screen.
Select [Output status] to use the status that is sent to the general equipment, and [Input status] to use the
status that is sent from the general equipment.

(10) Click [OK] after completing the settings.
(11) Click the icon in “Remote controller registration” ( E] ) to display the unit address selection screen.

(12) Select the address numbers of the ME remote controllers to be registered, and click [OK].
Note: Each group can contain up to two ME remote controllers.
Note: Each group can contain up to four ME remote and system controllers combined.
Note: MA remote controllers do not need to be registered to a group.

(13) Click the icon in “System controller registration” ( i ) to display the unit address selection screen.

(14) Select the address numbers of the system controllers to be registered, and click [OK].
Note: Each group can contain up to four ME remote and system controllers combined.

(13) Click the icon in “AHC registration” ( 5_-.‘ ) to display the unit address selection screen.

(16) Select the address number of the AHC to be registered, and click [OK].
Note: Each group can contain one AHC.

(17) Click [Save] to save the settings.

Note: Switch the “Target centralized controller” setting to make group settings for each centralized controller.

Note: The controllers to which [AE-200 (Billing)] or [AE-200 (No M-NET)] is set in section 6-3-1 “System Configuration
settings” will not be displayed in “Target centralized controller”.

Note: Up to six general equipment can be registered for each DIDO controller (PAC-YG66DCA). Each contact counts as
one unit.

Note: Each group can contain up to 16 general equipment. (Each contact counts as one unit.)

Note: To register general equipment to a group to which units other than general equipment are already registered, delete
the existing registration first before registering general equipment to it.

Note: General equipment groups cannot include remote controllers or system controllers.
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6-4-2. Refrigerant System settings

Refrigerant system information (connection information of outdoor, sub outdoor, and indoor units) can be set.

(1) Click [Unit Settings] > [Refrigerant System] to access the refrigerant system settings screen.

& MITSUBISHI Air Conditioning Control System - Initial Setting Tool X
; Option (Q)  Help (H) . - .
Target centralized — i e s — Indoor unit registration
controller Groups  Refrigerant System  ferlocked OSSN Blocks Enerey Management Block Pl Gontroller Al Goniroller AHG Part Name Seftings Click to d|sp|ay the screen
Select the connected Target centraized controller: |1-1 Mitsubishi buiding 1F = for registering the indoor
centralized controller whose units.
. . Refrigerant System Setti
refrigerant system settings nas /
Outdoor unit Sub outdoor unit Pump unit Indoor unit
are to be made. d- 3 B = o
0s pU —— - - .
Outd it istrati d - b FE Y o Pump unit registration
utdoor unit registration — — ; ;
Click to display the screen 4= |8 d - Srene Click to display the screen
) display for registering the pump
for registering the outdqtor do TR | AT units.
units.
‘ﬂ 113 Om 113 pﬁ Q 15 1617 18 19 20
‘ﬁ i om 27 ‘\ Dw D 2122 2324 25 26
0os PU =
o .
i é Pﬁ Sub outdoor unit
= registration
os PU = Click to display the screen
s _agm A
Data acquisition —_ | d L] 2 - for registering the sub
Click to acquire the N outdoor units.
connection information Rrncmi N
of the actual unit from / L
AE-200/AE-50/EW-50 and Save \ Back

replace the settings.

Click to save the settings.

Click to display the previous
settings without making any
changes.

(2) Click [Data acquisition] with the units properly connected to acquire the connection information from AE-200.

(3) Click the icon in “Outdoor unit registration” ( ﬁ ) to display the unit address selection screen.

(4) Select the address number of the outdoor unit to be registered, and click [OK].

(3) Click the icon in “Sub outdoor unit registration” ( OE ) to display the unit address selection screen.

(6) Select the address number of the sub outdoor unit to be registered, and click [OK].

(7) (HVRF system only) Click the icon in “Pump unit registration” ( pw ) to display the unit address selection

screen.

(8) (HVRF system only) Select the address number of the pump unit to be registered, and click [OK].

(9) Click the icon in “Indoor unit registration” ( "/ ) to display the unit address selection screen.

(10) Select the address number of the indoor unit to be registered, and click [OK].

(11) Click [Save] to save the settings.

Note: Ensure that these settings match the actual connection status. Also open [Initial Settings] > [System View] screen on
the AE-200’s LCD and check that the settings are the same. If the settings are not the same, the charges will not be

properly calculated.

Note: If A-control units are group registered, the addresses of the A-control units will be displayed under “Indoor unit” or

“Outdoor unit”.

Note: If a “warning message” appeared during [Data acquisition], there may be an error in the air conditioner connection
information and in the group setting, Pl controller setting or Al controller setting on the Initial Setting Tool.
Review the settings on the Initial Setting Tool and then try the data acquisition again.

Note: Adding or deleting the information on this screen will not change the actual refrigerant system.

Note: Not all the refrigerant system information may be acquired depending on the centralized controller’s start-up
condition. In this case, add or change the information on this screen.

Note: If the displayed information acquired from the centralized controller differs from the actual system, restart the

centralized controller or check the air conditioning units.
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6-4-3. Interlocked LOSSNAY settings

The ON/OFF status of the LOSSNAY or OA Processing units can be interlocked with the operation of indoor units.
Note: The ON/OFF status of the indoor units are not interlocked with the ON/OFF status of the LOSSNAY unit.

(1) Click [Unit Settings] > [Interlocked LOSSNAY] to access the interlocked LOSSNAY settings screen.

@ MITSUBISHI Air Conditioning Control System - Initial Setting Tool @
File(F) Dataacquisition (M) Send (S) Data verification (V) Option (Q)  Help (H)
Basic Settings | Unit Settings | Floor Settings | Billing Function Settings |
Groups | Refrigerant System | interlocked LOSSNAY [ Blacks | Enerey Management Block | PI Caniroller | Al Contraller
Target cenfralized confroller [1.1 Mitsubishi building 1F -
Interlocked LOSSNAY Settings
Interlocked LOSSNAY Indoor Units
= w w1 ‘,
R
Interlocked LOSSNAY S o — Interlocked indoor unit
_ _ registration registration
Click to display the screen % s & o Click to display the screen
for registering the LOSSNAY for registering the air
unit to be interlocked. 3 = conditioners with whose

operations are to be

3w o interlocked.

= U a1

> v U 112181415

i \\
Save — \_ Back
Click to save the settings. Click to display the previous

settings without making any
changes.

(2) Click the icon in “Interlocked LOSSNAY registration” ( 3 ) to display the unit address selection screen.
(3) Select the address number of the LOSSNAY to be interlocked, and click [OK].
(4) Click the icon in “Interlocked indoor unit registration” ( W&/ ) to display the unit address selection screen.

(5) Select the address number of the air conditioners with whose operations are to be interlocked, and click [OK].
Each LOSSNAY can be interlocked with up to 16 indoor units.

(6) Click [Save] to save the settings.
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6-4-4. Block settings

By making block settings, multiple groups in a given block can be collectively monitored or operated on the AE-200’s
LCD and the Integrated Centralized Control Web.
Note: To use the energy-save control (Peak Cut), make block settings.
The ventilation will stop when the Peak Cut control runs for the LOSSNAY units or OA Processing units that perform Night
purge operation. For this reason, do not register the LOSSNAY units and OA Processing units that perform Night purge
operation to the same block.
Note: HWHP (CAHV, CRHV, QAHV) unit groups and chiller unit groups cannot be registered to a block.

(1) Click [Unit Settings] > [Blocks] to access the block settings screen.

Target centralized

controller B G
| .
Select one of the connected —— Copy from group settings
centralized controllers Click to create a block with
whose block settings are to the setting_s copied from the
be made. group settings.
Copy from eroup settines
Member Groups:
@ e 1
A 3 . .
BIOCk NO. l enant DE T/ crowt Tenant D . Gr_oup re_gIStratlon
frewh  Tent® Click to display the screen

l T cows Tt for selecting groups.
l [fenet GR W ¢ ns
= Goes, Tty
T sowy  Tenx
Block name —_I = oam o
lTenaMN @ Groupld Tenant N
l Tenant O Q Group 1§ Tenant O

»

Save — \_ Back

Click to save the settings. Click to display the previous
settings without making any
changes.

(2) In“Block Name”, enter the block name in 20 characters or less.

The name entered here will be displayed on the LCD and the Integrated Centralized Control Web.
Note: Click [Copy from group settings] to create a block with the settings copied from the group settings.

(3) Click the icon in “Group registration” ( Wof ) to display the group selection screen.

(4) Select the group numbers to be registered, and click [OK].
(To show the group name, move the cursor to the group number.)

(5) Click [Save] to save the settings.
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6-4-5. Energy management block settings
Make the settings for the energy management block (tenant) used as collective unit for the apportioned electricity
billing function.

[1] General descriptions
(1) What is energy management block (tenant)?

* An energy management block (tenant) is the unit used for displaying and outputting charge calculation
results.

* An energy management block (tenant) is a collection of operation blocks. (When EW-50 controllers are used
without an AE-200, operation blocks belonging to different EW-50 controllers cannot be included in the same
energy management block.)

» An operation block is a collection of groups.

Energy management block

Operation block

I Group I Group I

[
T

£ LK &

(2) LOSSNAY (including OA Processing unit) settings
Make the settings based on the LOSSNAY system configuration.

Usage Energy management block setting method
LOSSNAY When not interlocked with the operation of | To apportion the electric energy, set as energy
indoor units management block (tenant). (See [2] (3).)
When interlocked with the operation of No settings are required (cannot be set as a target
indoor units for billing function).

Note: The LOSSNAY electric energy will be
apportioned based on the operating status
of the interlocked indoor units.

OA Processing unit | When not interlocked with the operation of | Set as energy management block (tenant). (See [2]
indoor units (3).)

When When interlocked with Set as same energy management block (tenant)
interlocked with | the operation of same as the interlocked indoor units. (See [2] (6).)

the operation of | tenant’s indoor units
indoor units

When interlocked with Make the settings in one of the following ways:
the operation of multiple

tenants’ indoor units <Method 1>

Set as independent energy management block
(tenant) and invoice the electricity charges by
including it to common area charges, etc. (See [2]

(6).)

<Method 2>

Exclude these units from the tenant settings.

In this case, the electric energy for OA Processing
units will be apportioned based on the operating
status of the interlocked indoor units.
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[2] Energy management block settings

(1) Click [Unit Settings] > [Energy Management Block] to access the energy management block settings

screen.

Target centralized
controller
Select one of the connected

Data verification (¥)  Option (Q)  Help (H)

trol Settings|

1 Copy from block settings

Click to create an energy

lock | PI Gontraller | Al Gontroller

management block with the

settings copied from the
block settings.

centralized controllers /
Target centralized mrmoHevT1 Mitsubishi Building ']
whose energy management
block settings are to be YN A Qe BBl R ‘
mad e - Interfocked member LOSSN:Yth heater and:um\dmer
/) el sia \é
Energy management block
No. =
=
17}
1)
=/
1) g
Save —

Click to save the settings.

Interlocked member
LOSSNAY with heater/
humidifier registration
Click to display the screen
for selecting OA Processing
units.

Member block registration
Click to display the screen
for selecting member blocks.

\— Back

Click to display the previous
settings without making any
changes.

(2) In “Energy management block name”, enter the energy management block number in 20 characters or less.
Note: By setting the same name for the energy management blocks that are connected to different AE-200 units, the

calculation results can be merged.
Refer to the Instruction Book (Apportioned Electricity Billing Function) for details.

Note: Click [Copy from block settings] to create an energy management block with the settings copied from the block

settings. Then, make the setting for the OA Processing units in steps (6) through (8).

(3) Click the icon in “Member block registration” ( £ ) to display the member block selection screen.

(4) Select one of the controllers (JAE200], [Exp1] through [Exp4]) of the member block to be registered.

(5) Select the block number of the member block to be registered, and click [OK].
Note: To show the block name, move the cursor to the block number.

(6) Click the icon in “Interlocked member LOSSNAY with heater/humidifier registration” ( W&/ ) to display the OA

Processing unit address selection screen.

Note: The setting for the OA Processing units in steps (6) through (8) is required only when the apportioned electricity

billing function is used.

(7) Select the controller ([AE200], [Exp1] through [Exp4]) of the OA Processing unit to be registered.

(8) Select the unit address of the OA Processing unit to be registered, and click [OK].
Note: To show the block name, move the cursor to the block number.

(9) Click [Save] to save the settings.
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6-4-6. Pl controller settings
To use metering device on the centralized controller, follow the instructions below to register Pl controllers (PAC-
YG60MCA) and to make measurement settings.
Note: The maximum settable number of Pl controllers for each centralized controller is 15. The maximum number of connectable
PI controllers in an AE-200 system is 20.
Note: A separate license is required to use the Peak Cut function using the measurement values.
Note: Only the addresses that have not been registered on the group, the Refrigerant System settings, interlocked LOSSNAY, or Al
controller setting screens are available for selection.

(1) Click [Unit Settings] > [PI Controller] to access the PI controller settings screen.

Target centralized & MITSUBISHI Air Conditioning Contral System - Initial Setting Tool =2
controller File (E) Da‘ta acquisition ‘(m) Send S)\ Data verification (\‘,/) Option (Q)  Help (H)
Basic Settings | Unit Settings | Floor SettingSnGilling Function Settings H H
Select one of the Connected Groups | Refrigerant System | Interlocked LOSSNAY Nqcks. | Enerey Management Black | PI Gontraller | Al Controller Meterlng deVIce hame
centralized controllers Target centraizedt contrller. |1 Misubishi bulding 1F -
whose PI controller settings e
are to be made.
PI Controller address Metering device nami Pulze Wizight
Ghl [Outdoor Tnit ]| 0o \I ﬁ(w" D
. Ch2 [ndor Unit ]| [0 u_[wh )
1 = -
] ) ]_A © | il e T Pulse Weight
Pl controller registration
Click to display the screen o U I\ [ 7)
for registering PI controllers. o | al H———kl\
. o | ]| 1 I B
" B B N Ik I J ;
Measurement unit
oht [ ]| [ I -]
o | ]| 1 I )
) chi = )
3 4=
= o | ]| T I )
save —/ \_ Back
Click to save the settings. Click to display the previous
settings without making any
changes.

(2) Click the icon in “PI controller registration” ( =23 ) to display the unit address selection screen.

(3) Select the address number of the Pl controller to be registered.
When a built-in Pulse Input (PI) of AE-200/AE-50/EW-50 is used, select [PI].

(4) In “Metering device name” (Ch1 to Ch4), enter the metering device name in 20 characters or less.

(5) Enter the pulse weight and select the measurement unit.
Note: The measurement unit can be selected from [kWh], [m3], [MJ], or [--(no unit)].
Note: When not using a metering device, leave the pulse weight blank and select [--(no unit)] for the measurement unit.
Note: The measurement values for which “--(no unit)” has been selected will not be plotted on a graph on the Energy Use
Status screen.

(6) Click [Save] to save the settings.

Important

e Set the pulse weight according to the metering device to be used. To ensure proper settings, first check the value
measured by the metering device and the value counted by the built-in Pulse Input (PI) of AE-200/AE-50/EW-50 or the PI
controller. Then, after a certain time, check that both values have increased by equal values. (The values that the built-
in Pulse Input (Pl) of AE-200/AE-50/EW-50 or the PI controller counts can be checked on the LCD and the Integrated
Centralized Control Web.
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6-4-7. Al controller settings
To use temperature and humidity sensors, follow the instructions below to register Al controllers (PAC-YG63MCA)
and to make measurement settings.

Note: Only the addresses that have not been registered on the group, the Refrigerant System settings, interlocked LOSSNAY, or
PI controller setting screens are available for selection.

(1) Click [Unit Settings] > [Al Controller] to access the Al controller settings screen.

& MITSUBISHI Air Conditioning Control System - Initial Setting Tool X
File () _Dataacquisition (M) ~ Send (S) Dataverification (\)  Option (@) Help (H)

Target centralized —
controller
Select one of the connected

Basic Settings U owiazs_Floor Settings  Billine Function Settines  Interlock Control Settings  Function settings

Groups Refrigerant System  InterlocRETeSSSNAY Blocks  Enerey Management Block PIGontroller Al Controller | AHG Port Name Settines:

. Target centralized controller: | 1-1 Mitsubishi building 1F ~ L_ Measurement setting
centralized controllers
whose Al controller settings Aliconolless siings) /
are to be made. Al Gontroller address __ Sensor name/Measurable rangs: [[E-all Address |
uteids Temp
O Mot in use

]
Measurable range J;! Fan ] o- JL! B e
M

Modified Value Sensor vale Offset =

E-Mail Address

® M Temperature sensor

Al controller registration ——

» =]
) ) ~ o\,j Humidity sensor ' ° 6| hequre |+ 00 o
Click to display the screen I, ‘
for registering Al controllers. » SZL‘"TN Wessrable raes OF Jx- 4@ Ik

Modified Value Sensor value Offset
® (] Hmidity sensor v - o [ hogure |+ 0 ol

Mat in use
N Terperatire sensor

U Humidity sensor

) Mot in uge
W] Temperatire sensor
|| Humidity sensor
‘ Save Eack‘
/[ N\
7/
| Save N\— Back
Click to save the settings. Click to display the previous
settings without making any
changes.
Measurable range
Al Gontraller address Sensor name/Measurable range N Upper"ower ON- and
Sensor name P-{outcie Terp ! I 4 OFF-threshold settings
Selecti £ > LT Measurable ranse @ [ ] § 0] a e _=E—\l| for e-mail alarm function
election of — @ M| Temperature sensor 4
Modified Value Sensor value Offset EH
temperature or humidity E © Q] ramidiy senser s o[ e |+ <) o | "sPo ) Ng| S Upper limit
sensor icon M s iy | (ON-threshold)
@ Not in use _ EA
I P L L 1A |\ Upper limit
- . Modified Value Sersor valie Offset ER\a (OFF-threshold)
@ Q_.| Humidity sensor % = v [ poie ]+ [20 <]w  [B8 % \[%0

%
— Lower limit
Acquire (OFF-threshold)
Lower limit

(ON-threshold)

(2) Click the icon in “Al controller registration” ( 53 ) to display the unit address selection screen.
(3) Select the address number of the Al controller to be registered, and click [OK].

(4) Enter the name of the sensor in 20 characters or less.

(9) Select a temperature sensor icon ( JM ) or humidity sensor icon ( :ﬂ ) for Ch1 and Ch2 respectively. “Not
in use” can also be selected.

(6) Enter the measurable range of the sensor.
When the Pt sensor is connected, the range must be between -30°C (-22°F) and +60°C (+140°F).
When the sensors other than the Pt sensors are connected, enter the ranges that are described in the
operation manuals of the sensor.

(7) To receive an e-mail alarm when the temperature or the humidity exceeds certain predetermined values, set
the ON- and OFF-thresholds for both the upper and lower limit temperatures.
To avoid frequent ON/OFF cycling, the minimum differential between the ON- and OFF-threshold values
should be 1°C (2°F).

(8) Click [Save] after completing the settings.
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[1] Offsetting the measured temperature/humidity values
To set the offset value for the measured values, click [Acquire] to acquire the current value, and set the offset value
according to your usage environment.

Note: If Al controller connection settings for a given centralized controller have not been saved, the “measurement value” will not
be displayed even when [Acquire] is clicked.

Note: When registering an Al controller for the first time, the “measurement value” cannot be acquired. To input the “offset value”
after acquireing and checking the “measurement value”, once the setting information must be sent to the centralized
controller. After registering the Al controller and temperature/humidity sensors, send the settings data to the centralized
controller. (See section 6-2-3 [5] “Send”.)

Note: The default offset value for temperature sensor is “0.0”. The settable offset value range is between -10.0°C (-18.0°F) and
+10.0°C (+18.0°F).

Note: The default offset value for humidity sensor is “0.0”. The settable offset value range is between -10.0% and +10.0%.

[2] E-mail alarm function settings
To receive an e-mail alarm when the temperature or the humidity exceeds certain predetermined values, set the
e-mail settings by following the instructions below.

(1) In the [Mail Subject] field, enter the e-mail subject. E-Mail s

Note: The following characters cannot be used in the [Mail
Subject] field: <, >, &, “, or

Tvpe of E-Mail

Out-af-limit alarm

(2) In the [E-Mail Address] field, select the row whose address
is to be changed, enter the e-mail address, and then click

E-Mail Add
[Update]. il
Mo, E-Mail Address ~

3. |AE-200_3@MitzubishiElecetic co jp
4. |AE-200_t@MitzubishiElectric cojp
5.

AE-200_h@Mitzubishiklectric cojp [¥]
BE-200_1@MitsubishiElectric cojp | Update
Garcel

An e-mail alarm will be sent in the format shown below.

From: Mitsubishi Building(000001)
Date/Time: 2014/03/14 09:38:39
Address: 50-1

Current value: 24.9 deg C
Status: Exceeded lower limit
Trend Data:

09:38 25.2deg C

09:37 25.4 deg C

09:36 25.6 deg C
09:3525.8deg C

09:34 26.1 deg C

09:33 26.4 deg C

09:32 26.7 deg C
09:3127.0deg C

09:30 27.5deg C

09:29 27.7 deg C

AE-200/AE-50/EW-50 name + Unit ID
From Note: The AE-200/AE-50/EW-50 unit name and unit ID entered in section 6-3-2 “Basic System
settings” will appear.

yyyy/mm/dd hh:mm:ss

Date/Time Note: The date and time will appear in the format selected in section 6-3-2 “Basic System settings”.

Address M-NET address of Al controller - sensor No.

Current temperature or humidity (one decimal place)

Current value Note: [**.*] may appear until the value measured by sensor becomes stable.

“Exceeded upper limit, Exceeded lower limit,” or “Recovered from

lower limit”

Status Recovered from upper limit,

Trend Data Time + Temperature or humidity values (for the last 10 minutes)
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6-5. Floor Settings
6-5-1. Floor settings for LCD

The floor layout on the floor display under the [Monitor/Operation] menu on the LCD can be set and changed, and

the display position of the group icons on the floor can be changed.

(1) Click [Floor Settings] > [Floor] to access the LCD’s floor settings screen.

@ MITSUBISHI Air Conditioning Control System - Initial Setfing Tool s =

¥

File (F) Data acquisition (M) Send (S) Data verification (¥) ~ Option (Q)  Help (H)

Target centralized
controller

Basic Settings | Uit Settings | Floor Settings | Biling Function Settings|

Floor | Flgor Layout | Floor for Inteerated Gentralized Gontrl Web | Floor Layout for Iteerated Gentralized Gontrol Web |

Target centralized controllr: [1_ Witstubishi buiding

-]

Total Floors Floor level name

B L < 1 _ 4

Floor Layout Clear FIOOr name

I P Il
& |
@ I Import floor plan
M
[ ——
Clear floor plan

Floor Layout

Import \\\.
™~— Floor plan image
e ————— . lihd | — Back
el
— Save

(2) In [Target centralized controller], select a target centralized controller.
The floor level settings for the selected centralized controller will appear.
Note: The target centralized controller No. is the number shown in 6-3-1 “System Configuration settings”. The controller name
is the name registered in unit settings in Basic System settings.
(3) Click [Edit] in [Total Floors] to display the “Total number of floors setting” screen.
(4) Set the total number of floors by entering the number on the keyboard or by clicking [=! [~ buttons.
rTotal number of floors setting
- Total number of floors
Total Floors 10 = ‘l‘
OK
[ o] S | ’ Cancel ‘L ‘I‘
— Cancel
Note: If the total number of floors is set to “0,” all groups will appear as unassigned groups.
Note: Up to ten floors can be registerted.
The display range of the area on the Floor Layout screen vary, depending on the selected floor layout.
Floor layout Display area Floor layout Display area
(5) In [Floor Layout], select the floor layout to be used.
(6) In [Floor level name], enter the floor level name in 3 alphanumeric or symbol characters or less.
(7) In [Floor name], enter the floor name in 20 alphanumeric or symbol characters or less.
(8) To read a floor plan file, click [Import] and select a file. Refer to the table below for the restrictions on the floor
plan files to be imported. Click [Clear] to delete the imported floor plan file.
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Restrictions on the floor plan files to be read

900 (height) x 1890 (width) dots for each floor plan
Note: The file size must be 900 (height) x 1890 (width) dots regardless of the display range of the area. (Even
when the floor layout shows only one display area, the file size must be 900 (height) x 1890 (width)
dots. In this case, create a file plan only in the left top area.)
Fil iz 630 dots
e size
450 dotsj:
900 dots
1890 dots
File capacity Max. 600 KB for each floor plan
gif
File format Note: Files that contain extension data (metadata such as XMP, transparent GIF, interlace GIF, animated GIF)
cannot be read.
R G B R G B R G B R G B
224 71 72 101 112 150 130 150 153 176 255 185
221 151 152 126 137 176 105 134 135 238 255 240
81 66 81 142 149 175 37 96 86 154 255 163
105 89 105 175 180 199 204 214 211 198 255 203
17 16 17 33 77 225 48 64 59 106 255 116
51 42 52 37 83 234 250 255 253 137 255 144
27 23 30 39 86 240 227 255 243 226 252 227
165 145 185 41 89 245 241 255 248 124 233 125
33 37 57 42 92 249 237 249 243 250 255 250
2 17 85 46 93 246 67 97 79 167 229 166
6 35 160 23 47 124 59 78 66 107 145 104
6 28 122 63 104 238 61 116 80 182 211 180
9 40 168 77 116 241 85 128 100 23 95 15
12 45 176 99 137 255 154 177 162 149 211 141
154 162 194 126 146 214 14 45 24 128 140 126
211 214 227 149 170 235 59 93 70 95 202 74
15 49 182 70 79 108 178 187 181 194 231 186
17 53 188 179 189 222 46 181 88 147 169 142
20 57 195 191 202 230 59 157 90 41 177 3
24 64 205 192 210 241 90 213 129 166 203 154
17 46 149 163 170 180 214 255 225 208 224 202
21 52 163 236 242 250 224 239 228 219 235 211
28 70 215 159 185 210 129 155 135 172 187 164
32 64 178 144 154 162 178 194 182 203 211 197
45 80 204 204 228 245 115 255 143 241 244 238
44 75 190 112 183 219 99 193 117 199 201 195
55 90 213 126 139 145 182 201 185 110 114 98
69 99 205 214 241 251 59 255 88 127 129 119
99 122 202 159 240 253 19 255 48 210 211 196
Available colors
(RGB) to be R G B R G B R G B R G B
/ ) 255 253 185 179 159 1 225 148 50 195 195 195
used in the file 193 193 150 172 169 147 214 159 89 193 193 193
255 255 221 187 185 169 77 76 75 191 191 191
121 121 106 179 177 162 230 211 206 189 189 189
162 162 147 205 203 187 207 203 202 185 185 185
142 142 129 224 222 206 225 197 192 179 179 179
94 94 89 212 201 139 225 8 8 173 173 173
212 212 203 136 134 122 221 179 179 171 171 171
235 235 227 158 156 143 152 151 151 169 169 169
213 213 207 217 215 202 255 255 255 166 166 166
203 203 198 230 228 216 250 250 250 161 161 161
137 137 134 142 128 71 249 249 249 154 154 154
116 116 114 254 246 220 246 246 246 148 148 148
245 245 242 244 237 215 243 243 243 143 143 143
85 85 84 33 25 2 241 241 241 133 133 133
121 121 120 111 110 107 239 239 239 129 129 129
253 253 252 63 43 4 236 236 236 103 103 103
119 117 23 106 104 100 232 232 232 82 82 82
255 253 143 133 132 130 228 228 228 70 70 70
253 241 7 116 79 14 225 225 225 64 64 64
174 173 157 254 251 246 220 220 220 58 58 58
208 195 0 255 151 0 217 217 217 51 51 51
220 210 64 93 61 13 215 215 215 44 44 44
156 153 113 254 221 171 211 211 211 41 41 41
201 199 175 157 97 18 209 209 209 34 34 34
151 150 136 211 205 197 207 207 207 4 4 4
187 175 71 205 128 31 205 205 205 0 0 0
195 193 175 187 116 28 202 202 202 255 170 63
198 197 187 219 138 35 198 198 198 255 203 131
* Use the colors in the table above, otherwise the floor plan will appear in different colors.
* The default background color is RGB [103, 103, 103].

(9) Click [Save] to save the settings.

WT07627X17 121



6-5-2. Floor Layout settings for LCD
Click [Floor Settings] > [Floor Layout] to access the LCD’s floor layout settings screen.

& MITSUBISHI Ar Con =
File(F) Data acquisition (M) Send (5) Data verification (v) Option (Q)  Help (H) N .
Basic Settings | Unit Settings | Floor Settines | Billing Function Settines | Target centralized
Floor Layout |Floor for Iteerated Gentralized Gontrol Web | Floor Layout for Ineerated entralized Control Web / controller
Target centralized controller: [1 Mitsubishi buiding ']
Assign with gridline
Floor switching P> fioc >
Group Name:
L Tenant E
Group name - Assigned group
Centralized controller
itchi 17 [N I I I
switching 11 2 i 6 11 1) [0 s
23 o .... 2 &
. 51 5 6 Selected grou
Groups to be assigned O e group
A

a

Assignment mode/

Deletion mode N— Floor plan image

T~—— Back

Save
[1] Assigning groups
(1) Click [Assignment mode].
(2) Select a target centralized controller.
(3) In [Floor switching], select a floor to set the layout.
(4) Switch between display areas by scrolling up/down, and left/right.
(5) Select the controller managing the group to assign. (EW-50 cannot be selected.)

(6) Select the group number to assign.
Note: . (green) indicates a selected group, H (dark gray) an assigned group, and 1 (light gray) a selectable group.
Note: Groups of air conditioners, Air To Water (PWFY) units, LOSSNAY units, OA Processing units, and general equipment

can be assigned to the floor layout.

(7) Click on the floor plan image to assign the group.
Note: If assigning group icons overlappedly, groups having higher group number are placed above.

(8) Click [Save] to save the changes.

[2] Moving groups within areas

(1) Click [Assignment mode].

(2) Click the group icon you wish to move within the display area, and this will become selected (with orange
frame).

Note: Before clicking the group icon, placing a check mark in “Assign with gridline” to select ( ) will allow assignment of
the group icons at a set interval.

Additionally, removing this check mark ( ) will allow fine assignment of group icons.
(3) Click again in the location to move to in order to confirm the group icon positions.

(4) Click [Save] to save the changes.

[3] Deleting groups
(1) Click [Deletion mode].
(2) Click the assigned group icon, and this will return to the selectable group.

(3) Click [Save] to save the changes.

Note: Up to 30 groups can be assigned to each area. If the layout is 2 (height) x 3 (width), up to a maximum of 180 groups
can be assigned on each floor.
Note: Groups that have not been assigned to any area will appear in “Unassigned groups” on the LCD.
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6-5-3. Floor settings for Integrated Centralized Control Web

Configure floor-related settings for when monitoring and operating air conditioning units with centralized controllers
using the Integrated Centralized Control Web. Logging in to the centralized controller set as the login destination
using a Web browser enables monitoring and operating of all air conditioning units connected to the managing

centralized controller using the Integrated Centralized Control Web.

Integrated Centralized
Control Web

Here, use the Integrated Centralized Control Web to configure the managing centralized controller, floor level, floor

Wireless LAN router

(@ ) (e @

Tablet

Integrated Centralized Control Web login destination

AE-200 &

e

AE-50/EW-50

- =

Yo

) |

) |

(|

Max. 50 units

I

Max. 50 units

ﬁ_

Max. 50 units

ﬁ_

Max. 50 units

ﬁ_

Max. 50 units

A

name and other floor settings, and the floor plan settings.

A

Air conditioning units that can be used on the

Integrated Centralized Control Web

Floor setting —\ Floor plan
Y ‘ Nww’ e
©® Monitor/Operati M Today's electric energy consumption 1
lonitor/Operation wa ' i 9y P e 1F Office 1 ) selectall | X
PS H = ~ 106 [—]
tlome. 10F Office 10 = = Home. - . N
oo g g i 1 |
9F Office 9 = i o8 |
Moritor/Operaton 80 <
8F Office 8 e ) o
7FO0 Gt
Pt bl 7F Office 7 %
6Fo e @ = %=
sa!'“g 6F Office 6 - = -
560 ey 47
e SF Office 5 & 8 Notics - - e
Norce & Error code: 3602 eIt o 2z - =
I 4F Office 4 - Admin.Depr.2_ Addresss 01:002 I ?
| I 1= » 3o ®
3F Office 3 gD Error code: 7106 = . e % - L=
Address: 01-011 n E o "
[ 2O — , =L o 1y .
oroblicams ) Eror code: 3602 l i [ - P |
I A Group01-11 _Address: 01-012 o 20 ‘ - |
Error code: 3602
' defined floor Vi w Group2-5 _Address: 02005
i 7K Number of arors: 5. ¥ _unde
07:35m 07:35 7
ool Entire building LD
Floor name
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(1)

Click [Floor Settings] > [Floor for Integrated Centralized Control Web] to access the Integrated Centralized

Control Web’s floor settings screen.

(& MITSUBISHI Air Conditioning Control System - Initial Setting Tool =
File (F) Data acquisition (M) Send (S) Data verification (V) ~ Option (0)  Help (H)
Basic Settines | Unit Settines | Floor Settings | Billing Function Settines| Target centralized
Floor | Floor Layout | Floor for Integrated Centralized Gontrol ieb |F\um Lawout for Integrated Gentralized Control Web % controller
Target centralized confroller [1 Yt
‘ Floor Settings for Integrated Centralized Control Web
Total number of floors — | Floo Name Flear plan AT Copy floor settings
setting Total Floors ] Inpot | |
|
Managed centralized —A Maﬂ?m ”Mdt" iE mport
controller ]
m Floor plan image
[l ‘\ ‘\ Impert
\
Floor name setting
\
Floor No. Floor level name setting
i e 1T 1T | — 1T
\
T~ Back
Save
(2) In [Target centralized controller], select a target centralized controller.
The setting contents of the selected centralized controller will appear.
(3) In [Total number of floors setting], set the total number of floors to be displayed on the Integrated Centralized
Control Web.
Click [Edit] in [Total Floors], and set the total number of floors by entering the number on the keyboard or by
clicking == | buttons.
Up to 99 floors can be set. In the Integrated Centralized Control Web, floors can be divided up into 10 floor
units and displayed.
Note: If the total number of floors is set to “0,” all groups will appear as unassigned groups.
Number of floors: 0 to 10 Number of floors: 41 to 50 Number of floors: 91 to 99
10F Office 10 10F Office 10 I 10F Office 10
OF Office 9 OF Office 9 I 9F Office 0
8F Office 8 8F Office 8 I 8F Office 8
7F Office 7 7F Office 7 7F Office 7
6F Office 6 6F Office 6 I 6F Office 6
SF Office 5 yAN I SF Office 5 A I SF Office 5 A
4F Office 4 I 4F Office 4 I 4F Office 4
E 31F E 31F E
3F Office 3 el 3F Office 3 el 3F Office 3 el
2EOffice . aF | 2FOffice . aFf 2EOffice2
1F Office 1 VAN 1F Office 1 A 1F Office 1 A
11F 11F
Undefined floor VAN ' Undefined floor VAN Undefined floor A\
1F 1F
\ \ \ Display area switching
(4) In[Managed centralized controller], set the centralized controllers to be managed with the Integrated
Centralized Control Web.
Centralized controllers and expansion controllers set in section 6-3-1 “System Configuration settings” will
appear.
The centralized controller with a check mark ( ) next to [Manage] will be a control target of Integrated
Centralized Control Web. Even if only one AE-200 is shown with a check mark ( ) in gray, settings and
reflecting the settings on the Initial Setting Tool is required.
Note: Any centralized controller without a check mark ( I:I ) is not a control target of Integrated Centralized Control Web.
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(5) In [Floor name setting], set the floor level name and floor name to be displayed on the floor layout.
Enter the floor level name in 3 alphanumeric or symbol characters or less.
Enter the floor name in 20 alphanumeric or symbol characters or less.

C= bfﬁce 1‘ | A\
; Floor name

(6) In [Floor plan image], import a floor layout image and configure settings.
Click [Import] and select a file to import.

To delete the imported floor layout image, click [Clear].
Note: Floor layout images other than the following file sizes and file formats cannot be read.

Floor level name

Floor layout size Between 450 (height) x 630 (width) and 900 (height) x 1890 (width) dots

File format gif

File capacity Max. 600 KB for each floor plan

(7) After the settings are completed, click [Save].

Note: Adjusting the floor name settings enables application in managing multiple buildings.

Example) To manage three buildings A to C, configure the floor settings as follows.

10F Office 10
Building A Building B Building C e
8 floors 10 floors 5 floors =
8F Office 8
7F Office 7
6F Office 6
SF Office 5 AN
4F Office 4
Setting contents e
Total number of floors: 25
Floor level name: No. 1 =A, No. 11 =B, No.21=C 2Loficed
Floor name: No. 1 to No. 8 = 1F **** to 8F ***** 1F Office 1 A
No. 11 to No. 20 = 1F **** to 10F ***** ) -
No. 21 to No. 25 = 1F **** to 5F **++ ndefined floor
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6-5-4. Floor Layout settings for Integrated Centralized Control Web

Assign the air conditioning unit icons to display on the Integrated Centralized Control Web floor layout.
Note: Assignment of unit groups registered in the centralized controllers selected as “Managed centralized controller” on the “Floor
for Integrated Centralized Control Web” screen is possible.

AR

®

Home

fo.e}

Monitor/Operation

™

Energy Management

Schedule

=
Notice
é Y
Maintenance

w Show groups HWHP

1F Office 1

| Deselect all ’ | Select all I

Schedule settings

Air conditioning unit group
Assign on the floor plan
image.

(1) Click [Floor Settings] > [Floor Layout for Integrated Centralized Control Web] to access the Integrated
Centralized Control Web'’s floor layout settings screen.

& MITSUBISHI Air Cond

File (E)

Data acquisition (M)

Send (S) Data verfication (v)  Option (Q)  Help (H)

Basic Settings | Unit Settings | Floor Settings | Billing Function Settings|

Floor switching

Floor | Floor Layout | Floor for Inteerated Gentralized Gontrol Yieb | Floor Layout for Integrated Gentralized Gantrol Wb \7/

Target cenfralized controller: [1 Mitsubishi building

“« ]

Group name

Centralized controller
switching

Groups to be assigned —

Group Name:

111z (18] (18] [ 160 ] e 9
v @s o EEEE s e
..... 5 . TN
| 1 I I

Assignment mode Deletion mode. “

4

Assignment mode/
Deletion mode

Scroll bar

Tenant G

Target centralized
controller

Assign with gridline
Selecting this enables
movement in grid units.

)

T— Back

Assignment area I

In [Target centralized controller], select a target centralized controller.

Save

Note: Make sure to select a target centralized controller set in section 6-5-3 “Floor settings for Integrated Centralized Control

Web”.

®)

In [Floor switching], select a floor to which the unit groups are assigned.

The floor layout set in section 6-5-3 “Floor settings for Integrated Centralized Control Web” will appear.

(4)
®)

In [Groups to be assigned], select a unit group to assign.

In [Centralized controller switching], select a centralized controller of the unit group to assign.

Note: Groups of air conditioners, Air To Water (PWFY)) units, LOSSNAY units, and general equipment can be assigned to the

floor layout.
(6)
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In the floor layout in [Assignment area], assign unit group icons.



(7) After the settings are completed, click [Save].
Note: Up to 180 unit group icons can be assigned in each floor layout.
Note: When no floor layout is registered, a white floor will appear.
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6-5-5. Convenient usage methods

[1] Matching the AE-200’s LCD and the Integrated Centralized Control Web floor layout

Use the Integrated Centralized Control Web to configure the settings to use the floor layout which is the same as on
the LCD.

(1)

()

@)

(4)

Integrated Centralized Control Web

eeeeee =3
P AHC Status.

Moni tor/ g 5 N 3 [ra—
l:l Operation l-uMgmt =l ) A

A
1F Lobby | sl | X

1F Lobby

e

ORPORATION A Rghs Reserved

Note: On the LCD, the floor layout image is divided for display, however on the Integrated Centralized Control Web, it is not divided
for display.

Carry out LCD floor settings.

Configure the 6-5-1 “Floor settings for LCD” and 6-5-2 “Floor Layout settings for LCD” settings for the target
centralized controller.

Configure the floor settings for the Integrated Centralized Control Web.
From [Floor Settings], click [Floor for Integrated Centralized Control Web], and from [Target centralized
controller], select the centralized controller set in (1) above.

& MITSUBISHI Al Conditioning Contral System - Initial Setting Tool ==
File (F) Data acquisition (M) Send (5) Data verification (V)  Option (0}  Help (H)

| Basic Settines | Linit Settings | Floor Settines | Billing Function Settings |

Floor | Floor Layout | Floor for Integrated Gentralized Contral Web | Floar Layout for Inteerated Gentralized Gontrol Web |

Target certraized controller [1 - |= Select a centralized controller set in
= | “Floor settings for LCD.”

Flcor Name Floar plan I Gy floo settnes Copy floor settings
| —

Click [Copy floor settings] and select [Floor and floor layout settings].

r M
Copy floor and floor layout settings g

Select a setting to be copied

@ Floor and floor layout settings

(2 Flaor and floor layout settings for Inteerated Centralized Gontrol Web

Click [OK].
The settings details for 6-5-1 “Floor settings for LCD” and 6-5-2 “Floor Layout settings for LCD” for the

centralized controller set in (1) above are copied to the 6-5-3 “Floor settings for Integrated Centralized Control
Web” and 6-5-4 “Floor Layout settings for Integrated Centralized Control Web”.

Note: Even if the floor layout settings for LCD are other than 2 (height) x 3 (width) layout, the copied Web floor plan size will be 900

(height) x 1890 (width). When handling a floor layout of other than 2 (height) x 3 (width), we recommend that this be replaced
with a floor plan that has unnecessary areas cut away for Web use.
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[2] Creating the login destination centralized controller for backup

Multiple login destinations can be set for the Integrated Centralized Control Web.

By copying the login destination centralized controller floor settings and preparing a backup centralized controller,
then if the login destination centralized controller malfunctions, it is possible to use the Integrated Centralized
Control Web by logging in to the backup centralized controller.

Wireless LAN router Tablet Normally logged-in centralized controller

(M@
Normally‘ U’
logged-in AE-200

% ?( ;- W A i Max. 50 units

LAN sl

AE-50/EW-50

fi

ﬁ_
o

y

Max. 50 units

Max. 50 units

Backup log-in

|

B Do e
ﬁ_

firi: -

Max. 50 units

'I Max. 50 units
I

Target centralized controllers for the backup centralized
controller

Q

A
AP sssssssnnnnnnnnnsn®

Backup centralized controller
Target centralized controller for the normally logged in centralized

controller

Note: Air conditioning unit groups managed by a malfunctioning centralized controller are not covered by monitoring and operation.
In the event of a malfunction, promptly replace with a new product and configure.

(1) Add an IP address of the backup centralized controller in 6-3-1 “System Configuration settings”.

(2) Configure the centralized controller to be normally logged in.
Configure the 6-5-3 “Floor settings for Integrated Centralized Control Web” and 6-5-4 “Floor Layout settings for
Integrated Centralized Control Web” settings for Integrated Centralized Control Web login destination target

centralized controller.

(3) From [Floor Settings], click [Floor for Integrated Centralized Control Web], and from [Target centralized
controller], select the backup centralized controller.

W& MITSUBISHI Air Conditioning Control System - Initial Setting Tool
File (F) Data acquisition (M) ~Send (S)  Data verification (V) ~ Option (Q)  Help (H)

| Basic Settines | Unit Settings | Floor Settines | Billing Function Settines |

[[Floor | Floor Layeut | Floor for Intesrated Centralized Gontrol b | Floor Layout for Intearated Centralized Gontrol Web |

Y

Select the backup centralized controller.

Target centralized controller: [1

Floor Nams Fior plen I Gopy floor sattines Copy floor settings
—_
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(4) Click [Copy floor settings], select [Floor and floor layout settings for Integrated Centralized Control Web], and

select a centralized controller set in (1).

Copy floor and floor layout settings

)

Select a setting to be copied.

(2 Flaor and floor layout settines

@ Floor and floor layout settings for Inteerated Centralized Gontrol Weh

/

Copy from

1 Mitstubishi building -

(5) Click [OK].

Copy from

Select a centralized
controller to be normally
logged in.

The settings details for 6-5-3 “Floor settings for Integrated Centralized Control Web” and 6-5-4 “Floor Layout
settings for Integrated Centralized Control Web” for the centralized controller set in (1) above are copied to the

backup centralized controller.

6-6. Billing function settings

Configure the billing function settings on the Initial Setting Tool. For details about the billing function settings, refer to

the Instruction Book (Apportioned Electricity Billing Function).

WT07627X17 130



6-7. Interlock Control

Set the Interlock Control setting to interlock the operation of multiple units.

Note: A separate license is required to use the Interlock Control function. Make sure that the required license has properly been
registered on the Registration of Optional Functions screen. (Refer to section 4-5 “License registration for optional functions”
for details.)

Note: When [External Input Setting] on the AE-200/AE-50/EW-50 that controls the equipment whose operation is to be interlocked
with another equipment is set to [Emergency Stop (Level signal)] (see section 6-3-2 “Basic System settings”) and the
external input contact is ON, or when the indoor unit is stopped due to the Peak Cut control (see section 7-1-2 “Peak Cut
(Energy-save control function)”), only the Interlock Control of free contact and DIDO controller (PAC-YG66DCA) will be
performed, but other Interlock Control will not be.

Note: If a group is deleted on the group settings screen, be sure to delete the Interlock Control settings in which the group is
selected as the input units or the output units.

Note: For how to connect general equipment to the free contact, refer to the AE-200/AE-50/EW-50 Technical Manual.

Up to 200 Interlock Control settings from No.1 through No.200 can be set for each AE-200/AE-50/EW-50. (Up to
800 Interlock Control settings can be made when one AE-200 and three AE-50/EW-50 controllers are connected.
Up to 1000 Interlock Control settings can be made when one AE-200 (No M-NET) and four AE-50/EW-50 controllers
are connected.)

The Interlock Control verifies the state changes in an ascending order of No.1 to No.200 every three to five
seconds. When the interlocking conditions are met, the interlocking action commands will be issued to the output
units.

By making the interlocking condition settings (input category, input states, and input units) and interlocking action
settings (output unit type, actions, and output units) for each Interlock Control setting, the operation of the output
units can be interlocked with the operation of the input units.

Caution:
Before using the Interlock Control function, you must agree to the following.

1. This function must not be used for disaster prevention or security purposes unless a backup device is
provided in case of failure of this function. (This function should never be used in the way that would put
people's lives at risk.)

2. The interlocking action settings that are not supported by the interlocked output units must not be made on
the [Set up Actions] screen. Failure to observe this precaution may result in malfunctions.

3. Both the Interlock Control settings set from AE-200 and from expansion controllers AE-50/EW-50 will
run. To avoid their settings competing against each other, make the setting from expansion controllers
AE-50/EW-50 if the setting is only for units under the control of the same expansion controller.

4. After completing each Interlock Control setting, perform a test run and confirm proper settings and
operation.

5. Do not set the Interlock Control settings as the following examples show. Doing so will cause short-cycling,
resulting in unit damage.

Example 1: Group 1 is turned off when Group 1 is turned on.
Example 2: Group 1 is turned on when Group 1 is turned off.
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Shown below are eight examples of Interlocked operations.
Example 1: Interlocked operation of indoor unit and card key via a DIDO controller

7

(D The card key status is input ’
key has been removed
V V "

through the contact.

DIDO controller Card key
(PAC-YG66DCA)

(2 Signal indicating the card ’ ‘

aad

AE-200

(3 Signal to stop the indoor
unit

Indoor unit

\_

J

Example 2: Interlocked operation of operation mode between indoor units

s

(@ Signal indicating the operation mode for the
indoor unit #1 has changed to fan mode

(D The operation mode has changed
from heating to fan mode.

—V

AE200 \

(3 Signal to change the
operation mode for the
indoor unit #2 to fan

Remote
Indoor unit #1 controller

(conference room No.1)

mode

\_

Indoor unit #2

(conference room No.2)

~

J

Example 3: Interlocked operation of indoor unit and window through the free contact on an indoor unit

r

(2 Signal indicating the
window has been opened

(D The open/close status of the window is
input to the free contact (CN32).

\/

<
<

[XE]

AE-200

(® Signal to stop the indoor
unit

.

Indoor unit

\

J

Example 4: Interlocked operation of indoor unit, lighting, and card key through the free contact on an indoor

unit
( Card k )
. ard ke
@ Signal indicating the card @ The card key status is input I y
key has been removed to the free contact (CN32). L 1
AE-200 |3 ’
|- ¥ }
(3 Signal to stop the indoor Indoor unit ; \ Lighting
unit and turn off the
lighting @ Signal to turn off the lighting
via the free contact
\ J
WT07627X17
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Example 5: Interlocked operation of indoor unit and other company’s ventilation unit via a DIDO controller

4 N
(2 Signal to operate the other company’s
ventilation unit

AE-200 |3 i @
= \ —_— Other company’s
% DIDO controller ventilation unit

(PAC-YGB6DCA)

[

(@ The indoor unit has
started operation

Indoor unit

. J
Example 6: Interlocked operation of the indoor unit in error and the auxiliary unit
4 )
(M An error has occurred in the
indoor unit.

A

il = @

AE-200 |z
Indoor unit
Indoor unit in error
(2 Signal to operate the
auxiliary unit =
Auxiliary unit
L J

Example 7: Interlocked operation of the indoor units

4 N
(D The representative indoor unit
has stopped

AE-200 |3

Representative
indoor unit

indoor units

(@ Signal to stop the other ’

L Indoor unit Indoor unit Indoor unit

Example 8: Interlocked operation of the security system and the connected units

4 )
(D The security system alarm is input to
the free contact (CN32).

\
e

— =
Indoor unit

A

aad

AE-200

Representative Security system
@ Signal to stop the ] indoor unit

indoor unit
ri
R

Indoor unit LOSSNAY unit

(2 Signal to stop the
indoor unit
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By connecting expansion controllers to AE-200, operation of units that are connected to different expansion
controllers can be interlocked.
4 )

(2 Signal to operate the other company’s
ventilation unit

A >

AE-200 | - @

/ = —_— Other company’s
DIDO controller ventilation unit

(PAC-YG66DCA)

E]

: /]

- /|

AE-50/EW-50 ’

(@ The indoor unit has
started operation

\ J

Indoor unit

Make the settings for AE-200 when interlocking the operation of units that are under the control of different
expansion controllers.

Make the settings for the expansion controller when interlocking the operation of units within the control of the same
expansion controller.

Click [Interlock Control] in the menu bar, and then click [Interlock Control] to access the Interlock Control settings
screen.

MITSUBISHI Air Conditioning Control System - Initial Satti

Target centralized F) Dataacquisition (M) Send () Data verification () Option ()  Help (H)
controller [ Basic Unit Settines | Floor Settings | Billing Function Settings | Iterlock Gontrol Settines |
Select the connected [ [ oo | Input Units
centralized controller whose B> Targel contaizd conroler [1-1 Miubisibuiking 1 -
Interlock Control settings are G ST rD Input State
to be made. — S Output Units
p /
. Enable/Disable Tnput Unit: Input State: Output Units Action
Execute/Stop Execution e — o b ol Ao T -~ Delete all
CIle to enable/dlsable the 1 U Group2 TenantB Cool \= |/ Groupd TenantD Direction_Swing. Fan Speed_Auto [ |
Interlock Control. . Eﬂ Graupl Tenanth 41l Groups On = g;gzgg Tenant® oN N Action
’ Groupd. TenantD
7
// 5 D%g:;:s‘z (One or mare units in Address1-1 ON
Enable/Disable e
Click to enable/disable each 7
Interlock Control setting. B
Row selection 8 0
Select the row to make the .
Interlock Control settings. B i Edit button )
/ Click to display the window
[ e = | it to set the Interlock Control
Edit buttons — 1 settings.
- \_
Save Back
Click to save the settings. Click to display the previous
settings without making any
changes.

[1] Selecting the Interlock Control setting to be made
(1) Select the row to make the settings for. A frame will appear around the selected item.

(2) Click [Settings] to display the window for setting the detail settings for Interlock Control.

[2] Disabling/Enabling Interlock Control settings
Interlock Control setting of each item can be enabled or disabled by checking “Enabled (checked)” or “Disabled
(unchecked).” No actions will be taken for the Interlock Control setting that is set to [Disable].

[3] Temporarily disabling the Interlock Control
Click the [Stop Execution] button to temporarily disable the Interlock Control. Click [Execute] to resume the Interlock
Control.
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[4] Editing Interlock Control settings
Use the Edit buttons to edit each row of Interlock Control setting.

Button name Function
Delete all Deletes all Interlock Control settings.
Copy By selecting the row to be copied and clicking [Copy] and then clicking [Paste] on the paste
Paste destination, the settings of a given row can be pasted to another row.
Inserts a blank row of Interlock Control setting above the row that is displayed, and moves all
Insert rows down by one.
If interlocking conditions are entered in the last row, no more rows can be inserted.
Delete Deletes the Interlock Control settings of the selected row.
Whether to move up the row below the deleted row or not can be selected.
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Set the Interlock Control settings on the window for setting the detail settings for Interlock Control.

Input Category —3

Input State 1 — 1

Input State 2 — ~

Tnput Gatesory

Interlock Control

Output Lhit Type

[Group (Mods)

=) o

Output Unit Type

L

Tnput State ON

[l eroups in the mode =

ON/OFF

.

Select mode

[Gaol

Select Lhits

At Direc

Mode

ion

()
=

Action

Set Temp.

Selecting the equipment —p» 5!

to which the operation
of another equipment is
interlocked

Displays the window to
select the equipment.

OK
Click to save the settings.

Group?

enant A
Tenant B Groupt

Selecting the equipment
whose operation is to be
interlocked with another
equipment

Displays the window to

select the equipment.

[1] Making the interlocking condition settings

(1) Setting an Input Category and Input States
Select an Input Category and Input States 1 and 2, referring to the table below.

Cancel

Cancels the settings and
reverts the window to the
previous state.

Table: Interlocking condition settings

Input
Input Category unit icon Input State 1 Input State 2
All Groups On
Group - All Groups Off 3
(On/Off) \'\:J One or more Groups On
One or more Groups Off
All groups in the mode Air conditioning unit group: 1273
Group L All groups out of the mode Cool, Dry, Fan, Heat, Auto, Setback
(Mode) \" /' | one ormore groups in the mode LOSSNAY unit group:
One or more groups out of the mode Bypass, Heat Recovery, Auto
All units in error
Group All units in normal operation B
(Error/Normal) One or more units in error
One or more units in normal operation
All Units On
Free Input Points All Units Off B
(On/Off) One or more Units On
One or more Units Off
*1 The operation modes for Air To Water (PWFY) unit groups, HWHP (CAHV, CRHV) unit groups, chiller unit groups, or general

equipment groups are not available for selection.

*2
*3

If the selected operation mode is not available on the input unit, interlocking conditions will not be fulfilled.
The Setback mode can be selected on the AE-200A/AE-50A/EW-50A, but not on the AE-200E/AE-50E/EW-50E.

Note: If the Input Category is set to [Group (On/Off)] and the Input State 1 is set to [All Groups On], the interlocking action

commands will be issued to the output units when the state on the input units changes to [All Groups On] from another state [All

Groups Off], [One or more Groups On], or [One or more Groups Off].
Note: Free contact is available for use on R410A- and R407C-compatible indoor units with software Ver. 33 or later. The software
version can be confirmed with the Maintenance Tool.

Note: When [External Input Setting] on the AE-200/AE-50/EW-50 that controls the equipment whose operation is to be interlocked

with another equipment is set to [Emergency Stop (Level signal)] (see section 6-3-2 “Basic System settings”) and the
external input contact is ON, or when the indoor unit is stopped due to the Peak Cut control (see section 7-1-2 “Peak Cut
(Energy-save control function)”), only the Interlock Control of free contact and DIDO controller (PAC-YG66DCA) will be
performed, but other Interlock Control will not be.
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(2) Selecting the input units
Click [Select Input Units] to display one of the following screens, depending on the selected Input Category.

Note: Operation of the units under the control of different expansion controllers can be selected only when the settings
are made for AE-200.

(A) When [Group (On/Off)], [Group (Mode)], or [Group (Error/Normal)] is selected as the Input Category

The [Select Input Groups] screen will appear.

Select the group numbers of the input unit groups. The

selected group numbers will appear with a yellow-green ae200 (BB B2 Epd
background. -- 3 7 8 10

Click again to deselect. The deselected group numbers will w-----
appear with a light-gray background. ----------
To deselect all selected groups, click [Reset selections]. Wow w e om @ w w W @

(N 2 [ [ e ) ) s
To select a block of groups, click [Select a Block]. Select a

block name and press [OK]. The groups that are registered
to the block will appear with a yellow-green background. -

Note: If the Input Category is set to [Group (On/Off)] or [Group (Error/Normal)], air conditioning unit groups, LOSSNAY
unit groups, Air To Water (PWFY) unit groups, HWHP (CAHV, CRHV) unit groups, chiller unit groups, and general
equipment (connected via DIDO controller PAC-YG66DCA) groups can be selected.

If the input category is set to [Group (Mode)], air conditioning unit groups and LOSSNAY unit groups can be
selected.

Note: Different types of groups (air conditioning unit groups, LOSSNAY unit groups, or general equipment (connected
via DIDO controller PAC-YG66DCA) groups) cannot be simultaneously selected.

(B) When [Free Input Points (On/Off)] is selected as the Input Category

The [Select Addresses of Input Units] screen will appear.

Select the addresses of the indoor units to which the
general equipment is connected, and select contact points

for each indoor unit. e

The selected unit address will appear with a red frame. The "

unit addresses whose contact points have been set will n 2 |2 ) N ) 0 )
appear with a yellow-green background. (i i ) ) ) ) ) e e e

Contact Points

- 'l IER
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[2] Making the interlocking action settings

(1) Setting an Output Unit Type and Actions
Select an Output Unit Type and set the Actions, referring to the table below.

Table: Interlocking action settings

) Actions
Qutput Unit Output
Type uniticon Setting item*2 Setting options
ON/OFF ON, OFF
Air conditioning unit group:
Mode *" Cool, Dry, Fan, Heat, Auto, Setback™3
LOSSNAY unit group:
Bypass, Heat Recovery, Auto
Set Temp. "1 74 Desired temperature
R — Air direction *1 Mid3, Mid2, Mid1, Mid0, Horizontal, Swing, Auto
Group |
Fan speed "1 Low, Mid2, Mid1, High, Auto

Prohibit Remote Controller

Operation (ON/OFF) Permit, Prohibit

Prohibit Remote Controller

Operation (Mode) Permit, Prohibit

Prohibit Remote Controller

Operation (Set Temp.) Permit, Prohibit

Free Output

. ON/OFF ON, OFF
Points

*1 The available setting options vary, depending on the connected indoor unit model.
Make the interlocking action settings that are available for the output units.

*2  Only the items “ON/OFF” and “Prohibit Remote Controller Operation (ON/OFF and Set Temp.)” can be selected for Air To Water
(PWFY) units. Only the item “ON/OFF” can be selected for HWHP (CAHV, CRHV) units.

*3 The Setback mode can be selected on the AE-200A/AE-50A/EW-50A, but not on the AE-200E/AE-50E/EW-50E.

*4 Set the outlet air temperature for the outlet air temperature control units.
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The screen display under Action will vary, depending on the selected Output Unit Type.

(A) When [Group] is selected as the Output Unit Type

Click [Edit] under Action. The [Set up Actions]

screen will appear.

Set the interlocking actions to be taken when the

interlocking conditions are met.

ONAOFF
[on -]
Mods Set Temp.
Coal -
| ENFa ]
Fan Speed Air Direction
e (a) e L)
= =
Prohibit Operation
OMAOFF Made Set Temp.

]

Note:
Note:
Note

Note:

Note:

Note:

Note:

The current operation status will be maintained for the setting items that were not changed.
The set temperature cannot be set unless the operation mode has been set.

. If the selected operation mode is not available on the interlocked output units, the Interlock Control will not be

performed.

To prevent malfunctions of the air conditioning units, be sure to set the set temperature to a temperature within
the normal operating temperature range, although there may be rare cases in which it is possible to set the set
temperature to a temperature outside the normal operating temperature range (depending on the model of the
air conditioning units that are connected to a system).

When making the set temperature setting for the Auto mode, set two different set temperatures for both cooling
and heating in [Set temp.] for the units that support the dual set point function, and set the single set temperature
in [Set temp. (Single set point model)] for the units that do not support the dual set point function.

Signals for Swing and Auto of Air direction setting and Auto of Fan speed setting will not be output unless these
functions are available on the interlocked output units.

With respect to the air direction and fan speed, if the number of settable air directions and fan speeds vary
among the connected unit models, the signals that are rounded up to the settable range may be output.

When the interlocking conditions are met, it will take some time to issue the interlocking action commands to the
output units. This may delay the state change verification, which is usually performed every three to five seconds.

(B) When [Free Output Points] is selected as the Output Unit Type

WT07627X17
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(2) Selecting the output units
Click [Select Output Units] to display one of the following screens, depending on the selected Output Unit

Type.
Note: Operation of the units under the control of different expansion controllers can be selected only when the settings
are made for AE-200.

(A) When [Group] is selected as the Output Unit Type

The [Select Output Groups] screen will appear.

Select the group numbers of the output unit groups. The

selected group numbers will appear with a yellow-green aean BT B2 Bl
background. [ ] R R R R R
Click again to deselect. The deselected group numbers will "ot 13% IR
appear with a light-gray background. TR B T TR TR I A R T T
To deselect all selected groups, click [Reset selections]. 8132 3 M %% T B 30 40

[ OK ]i Cancel ]

To select a block of groups, click [Select a Block]. Select a
block name and press [OK]. The groups that are registered
to the block will appear with a yellow-green background.

Note: If the Output Unit Type is set to [Group], air conditioning unit groups, outlet air temperature control unit groups,
LOSSNAY unit groups, Air To Water (PWFY) unit groups, HWHP (CAHV, CRHV) unit groups, chiller unit groups,
and general equipment (connected via DIDO controller PAC-YG66DCA) groups are available for selection.

Note: Different types of groups (air conditioning unit groups, outlet air temperature control unit groups, LOSSNAY unit
groups, Air To Water (PWFY) unit groups, HWHP (CAHV, CRHV) unit groups, chiller unit groups, or general
equipment (connected via DIDO controller PAC-YG66DCA) groups) cannot be simultaneously selected.

(B) When [Free Output Points] is selected as the Output Unit Type

The [Select Addresses of Output Units] screen will appear.

Select the addresses of the indoor units to which the

general equipment is connected, and select contact points AEZ0D B2 Bt
for each indoor unit. B9 E e A e e o
The selected unit address will appear with a red frame. 112 138 1 15 16 17 18 19 20
The unit addresses whose contact points have been set TR TR TR TR TR TR YR T

will appear with a yellow-green background. IETIE I R TR TR
R TR R

Contact Points

-234

I OK I [ Gancel

[3] Saving the Interlock Control detail settings
Click [OK] to save the settings.
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6-8. Function settings

6-8-1. Energy Management Settings
On the Energy Management Settings screen, make the settings for the energy-control-related items, such as
temperature sensor to measure the outdoor temperature with, electricity meters that are used for acquiring the data
to display the trend graph of indoor unit electricity consumption, and also the mode that are used for apportioning
indoor unit electricity consumption.
Click [Function settings] in the menu bar, and then click [Energy Management Settings] to access the energy

management settings screen.
Note: Electricity consumption is apportioned based on the electricity consumed by outdoor units. The electricity consumed by
indoor units is not considered.

Important: The energy management settings must be made after all units have been started up.
The settings that have been saved while one or more units are starting up may be lost.

(S) Data verification (V)  Option (Q)  Help (H)

| Unit Settines | Floor Settines | Billine Function Settines | Interlock Gontrol Settines || Funciion setfings

Enerey Manseement Seitnes |Systom—changeover Seltigs | Temperatu re sensor
Target centralized controller: 1 Mitsubishi Elecric - Select a temperature sensor
Energy Management Settings to measure the outdoor
. . | temperature with.
Indoor unit operation TN B [ )
apportioning mode Indoor unit operation apportioning mode ) FAN operation time © Thermo-ON time. © Capacity save amount
Address Group Name: Electricity meter
1 Entrance _'EJ 50-1 Electic Meter! M
7 Lobby(Soutr) —EJ 50-1 Electric Meter]
/3 Lobby(Eas) | 501 Eleatic Mt Indoor unit address
7} 4’ Labby(Center) —EJ 50-1 Electric Meter]
/s Lobby(west _'5‘ 50-1 Electic Meter] Group Name
(i ] S0z Eleetic Mot L
W e =lg] so2Elew M\Z\
= - [ TR Electricity meter
/e _'EJ 50-3 Electiic Meter? Save
Click to save the changes
made.

(1) Inthe [Temperature sensor] section, select a temperature sensor to measure the outdoor temperature with.
In the pulldown menu, the name of the temperature sensor that is connected to the Al controller or the AHC
will appear.

Note: Connect the temperature sensor to either the Analog Input 1 or Analog Input 2 port on the AHC.
Note: This setting is interlocked with the temperature sensor setting on the External Temperature Interlock settings screen.

(2) In the [Indoor unit operation apportioning mode] section, select the way indoor units' operation time is
counted that is used to apportion the electricity consumption, which appears on the screens under the
Energy Management menu.

Select [Fan operation time] to apportion the electricity consumption based on the fan operation time, and
select [Thermo-ON time] to apportion the electricity consumption based on the Thermo-ON time of the
indoor units.
Select [Capacity save amount] to apportion the electricity consumption based on the indoor unit operation
time that was calculated based on the amount of energy saved on the indoor units.
The selected setting must meet the system requirements. Selecting [Capacity save amount] is
recommended.

Note: “FAN operation time” is the cumulative duration of time in which the indoor unit is powered on.

Note: “Thermo-ON time” is the cumulative duration of time in which the refrigerant is flowing into the indoor unit.

Note: “Capacity save amount” is the cumulative operation time of the outdoor unit based on its capacity.

Note: Electricity consumption is apportioned based on the electricity consumed by outdoor units. The electricity consumed

by indoor units is not considered.

Note: When an AE-200 apportioned electricity billing function is used, this setting is not effective because the billing
function settings are used to apportion the electricity consumption.
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(3) In the [Electricity meter] section, select the electricity meter to be used to measure the electricity
consumption of each group of indoor units.
In the pulldown menu, [Pl controller address + “-” + Electricity meter number + Electricity meter name] will
appear when a PI controller (PAC-YG60MCA) is connected, or [“Meter” + Channel No. + Electricity meter
name] will appear when a metering device is directly connected to the controller.

Note: If the electricity meter name is long, only part of it may be displayed.

Note: The electricity meter name will be blank if it has not been registered.

Note: Only the electricity meters whose measurement unit setting is set to [kWh] on the Measurement screen are available
for selection.

Note: When an AE-200 apportioned electricity billing function is used, this setting is not effective because the billing
function settings are used to apportion the electricity consumption.

(4) Click [Save] to save the settings.
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6-8-2. System-changeover
The System-changeover function switches the operation modes of the indoor units connected to the same outdoor
unit between cooling and heating based on the room temperature and the set temperature. Click [Function settings]
in the menu bar, and then click [System-changeover Settings] to access the System-changeover settings screen.
The System-changeover function is available only on the Y series of outdoor units, whose operation modes do not
include the Auto mode. Use this function to operate the air conditioning units in the heating mode in the morning
and in the cooling mode in the afternoon. The operation mode of all indoor units will automatically be switched,
eliminating the need to switch the operation mode manually from the remote controllers.
Note: Because the operation mode is selected based on the demands of the representative group or of the majority of the groups,
not all areas may be air conditioned to the optimum temperature.
Note: If the outdoor unit is an R2 series, whose operation modes include the Auto mode, use the Auto mode instead of the System-
changeover function to switch the operation mode automatically.
Note: This function is not available for the outdoor unit to which an outlet air temperature control unit is connected.

Note: Group settings and refrigerant system settings are required to configure the System-changeover settings. Refer to section
6-4-1 “Group settings” and 6-4-2 “Refrigerant System settings”.

File (F) Dataacquisition (M) Send (S) Data verification (¥) ~ Option (Q)  Help (H)

| Basic Sattines | Unit Settings | Floor Ssttines [ Billing Function Ssttins [ Interiack Contral Settings | Function settings

Target centralized controller: [1 Mitsubishi Electric -

System-changeover Settings
Target outdoor unit Outdoce it adress Chiree Mode
The M-NET address of the FE &
outdoor unit appears. Groups

A - The names of the groups
PE / that are connected to the
outdoor unit appear.
Change Mode When the [Representative
Group] mode is selected,
select the representative
group from among these

groups.

Save

Click to save the changes

made.

(1) Select the Change Mode [None], [Averaging], or [Representative Group], referring to the table below.
If [Representative Group] is selected, also select a representative group from among the groups on the

right.
Table: Change Mode
Change Mode Content
None System-changeover function will not be used.
The operation mode (cooling or heating) will be determined and switched every 15
Averaging minutes based on the demands of the majority of all groups connected to the outdoor

unit, taking into consideration the capacity of each indoor unit and the temperature
differences between the set temperatures and room temperatures.

The operation mode (cooling or heating) will be switched based on the temperature
Representative Group difference between the set temperature and the room temperature of the
representative group.

(2) Click [Save] to save the settings.
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6-8-3. AHC Port Name Settings
On the AHC Port Name Settings screen, enter the names of the input and output ports of the Advanced HVAC
CONTROLLER (AHC).
The names that are entered on this screen will appear on the AHC List screen.
Click [Function settings] in the menu bar, and then click [AHC Port Name Settings] to access the AHC Port Name
Settings screen.

Important: The AHC port name settings must be made after all units have been started up.
The settings that have been saved while one or more units are starting up may be lost.

File (F) Data acquisition (M) Send (S) ~Data verification (V) ~ Option (0)  Help (H)

Basic Settings | Unit Settines |Floor Settines | Biline Function Settines | Interlock Gontrol Settings | Function settines| EXte nded In p Ut
Groups | Refrigerant System | Interlocked LOSSNAY | Blosks | Enerey Management Block | PIGontroller | AL Gontrolier | AHC Pmy Zettings ( 1 _4)

Target centralized controller: [1 Mitsubishi Electric ']

AHC Port Name Settings Output Port Name

AHC address Thput Name Output Name.

Unit address B F e v I
D2+ Hester 150 Emar £

D3 * Hester 2nd Err

[T

DIs

Dl

> Digital Output

e (1-9)

- = Extended Output
a5 (1_4)
Digital Input ;o Sercr w
(1_1 5) oIz :F’:mu\mev\utk A5 T Analog Output
Input Port Name / 7 (1-2)
on - o : Analog Input
oe w 008 I (1-8)
Save
Click to save the changes
made.

(1) Inthe [Input Port Name] field, enter the input port name in 20 characters or less.
Note: Digital Input (DI) 1-15, Extended Input (El) 1-4, and Analog Input (Al) 1-8 will appear regardless of whether the
ports are used or not.
Note: The following characters cannot be used in the [Input Port Name] field: <, >, +, &, “, or

(2) Inthe [Output Port Name] field, enter the output port name in 20 characters or less.
Note: Digital Output (DO) 1-9, Extended Output (EO) 1—4, and Analog Output (AO) 1-2 will appear regardless of whether
the ports are used or not.
Note: The following characters cannot be used in the [Output Port Name] field: <, >, +, &, “, or

(3) Click [Save] to save the settings.

WT07627X17 144



7. Settings using Integrated Centralized Control Web

7-1. Function settings

7-1-1. E-Mail
E-mail settings must be configured properly to use the error notification e-mail function. Error notification e-mail
function is the function to send the error information to the specified e-mail addresses. E-mail communication
function is the function to send the units’ maintenance data to the specified e-mail addresses of the PCs to which
Maintenance Tool is installed.
Click [Function] in the menu bar, and then click [E-Mail] to access the e-mail settings screen. Make the various
e-mail settings, and then click [OK].

E-Mail Settings of Mail Communication
AE-200/AE-50/EW-50 Controller  Mitsubishi Building Setﬂng
Server Settings Basic Settings Ml frror Set the e-mail addresses
Communication Settings of the PCs that will receive
maintenance data through
e-mail communication

Outgoing Mail Server (SMTP) smtp.ae200.co jp function.
Mail server |nf°rmation Outgoing Mail Server Port 25
Set the mail server/DNS enervotion method
; . i . .
server information. nevptonmete “ Error Mail Settings

Enter the e-mail information
for error notification e-mail
Incoming Mail Server (POP3) function.

Use SMTP Authentication

* : Required if you make use of Mail Communication Settings.
DNS Server (Primary)

DNS Server (Secondary)

Cancel OK
Click to save the changes
made.

[1] E-Mail Settings of AE-200/AE-50/EW-50

E-Mail

Controller AE01 Mitsubishi Building

Server Settings Basic Settings Mail Commuriication Error Mail Settings

E-Mail Address mitubishi@ae200.co.jp
User ID ae200

Password (XYY YYYYYYY Y]

Interval of checking incoming mails
e

Cancel oK

Enter the AE-200/AE-50/EW-50’s e-mail information provided by the Internet Service Provider (ISP) or the system
administrator. The items required to be set vary, depending on the functions to be used. Refer to the table below to

determine which items need to be set.
Note: A contract with the ISP is required to send e-mail via an ISP.
User ID must be up to 30 single-byte characters.
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Table: ltems required to be set (E-Mail Settings of AE-200/AE-50/EW-50)

Item Without SMTP authentication With SMTP authentication
E-Mail Address Vv \%
User ID - \Y,
Password - \%
Interval of checking incoming mails - -

(V) Required to be set, (-) Not required to be set
[2] Mail Server Information

Controller  Mitsubishi Building

smtp.ae200.cojp
25

Use SMTP Authentication

Encryption method

Incoming Mail Server (POP3)
*: Required if you make use of Mail Communication Settings.

DNS Server (Primary) 10 30 40

[ 20

DN Server (Secondary) 1 ‘ 21 Ell 4

Cancel OK

Enter the e-mail server information provided by the ISP or the system administrator. The items required to be set
vary, depending on the functions to be used. Refer to the table below to determine which items need to be set.
Either the IP address or the host name (server name) can be entered in the [Outgoing Mail Server (SMTP)] and
[Incoming Mail Server (POP3)] fields.

Note: The port number of the Outgoing Mail Server (SMTP) can be changed. (Factory setting: 25)
Note: When “587” is entered as a port number, make sure to check the checkbox next to [Use SMTP Authentication].

Note: When “465” is entered as a port number, make sure to select [SSL/TLS] for the encryption method.

Table: ltems required to be set (Mail Server Information)

Item Without SMTP authentication With SMTP authentication

Outgoing Mail Server (SMTP) "3 IP address c\)/r host name Host\r/mme
Qutgoing Mail Server Port V V

Encryption method *2 [None] or [SSL/TLS]

Use SMTP Authentication - V

Incoming Mail Server (POP3) - -

DNS Server (Primary) (V)™ \%

DNS Server (Secondary) (V)™ \Y,

*1
*2

Note that TLS ver. 1.1 and later or STARTTLS are not supported.

*3
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(V) Required to be set, (-) Not required to be set
Required if the host name is entered in the [Outgoing Mail Server (SMTP)] or [Incoming Mail Server (POP3)] field.
When not encrypting e-mails, select [None]. When encrypting e-mails, select [SSL/TLS]. (Factory setting: None)




[3] Error Mail Settings

Controller AEO1 Mitsubishi Building

Server Settings Basic Settings

it Mitsubishi Building

0.  E-Mail Address

service@ae200.co.jp

Cancel OK

(1) In the [Mail Subject] field, enter the mail subject to be used for the error notification e-mail function in 40

characters or less.
Note: The following characters cannot be used in the [Mail Subject] field: <, >, &, “, or*

(2) In the [Kind of Errors] field, select the error type out of the following: [Unit Error], [Preliminary Unit Error],
[Communication Error], [General Equipment], and [User Setting 1] through [User Setting 6]. Then, in the
[E-Mail Address] field, enter the e-mail addresses of the recipients of the error notification e-mail.

(3) If [User Setting 1] through [User Setting 6] is selected in the [Kind User Setting
of Errors] field, a [User Settings] button will appear. To send error s
notification e-mail only upon occurrences of certain errors, click
[User Settings] to display the User Settings screen.

Enter the error codes to be notified.

Up to 20 error codes can be set for each user setting. In addition
to specific error codes such as [1302] or [6607], codes that use
asterisks as wildcards such as [10**] or [12**] can also be used.

If [10**] is entered, for example, error notification e-mail will be
sent upon an occurrence of any type of errors between [1000] and
[1099]. If error codes are entered on this screen, confirm that the
e-mail addresses of the recipients are registered.

(4) If [General Equipment] is selected in the [Kind of Errors] field, a 7 _ LCCometon
[PLC Connection] button will appear. To send error notification ey

PLC No. 1P Address

e-mail upon occurrences of errors on the general equipment that Wil
are connected to PLC Software for General Equipment, click [PLC R
Connection] to display the [PLC Connection] screen. Enter the IP :
addresses of PLC Software for General Equipment.

The row number that corresponds to each IP address will appear

in the error notification e-mail as a PLC number. (e.g., When an

error occurs on the general equipment #20 connected to the PLC

Software in the second row, “PLC2-20" will appear in the [Error

unit] section in the error notification e-mail.)

Note: A TG-2000A is required to monitor the status of the general

equipment that is connected to the PLC Software for General
Equipment.
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[4] Mail Communication Setting

Controller AEQ1 Mitsubishi Building

Error Mail Settings

No.  E-Mail Address

1 maintenace@ae200.co.jp

Cancel oK

To use an e-mail communication function, enter the addresses of the PCs that will receive the units’ maintenance
data in the [Mail Communication Setting] section. Up to 10 e-mail addresses can be set.

[5] E-mail format
Error notification e-mail will be sent in the format shown below.

From:Mitsubishi Building(000001)
Date:01/06/2014 16:32:12

Error unit:065

Error code:1302
Status:Occurrence

Mail subject The mail subject entered in section 7-1-1 “E-Mail” [3] will appear.
From The AE-200/AE-50/EW-50 unit name and unit ID entered in section 6-3-2 “Basic System settings” will
appear.
Date Error occurrence date and time will appear in the format entered in section 6-3-2 “Basic System
settings”.
- When an error occurs on air conditioning units or general equipment, the M-NET address of the unit
in error will appear.
- When an error occurs on general equipment connected to PLC Software for General Equipment, PLC
number* (1 to 20) and connection number of general equipment (1 to 32) will appear.
- When a communication error occurs on PLC Software for General Equipment, PLC number* (1 to 20)
Error unit will appear.
* PLC number indicates the row number on the [PLC Connection] screen. (Refer to section 7-1-1 “E-Mail” [3].)
Note: When an error occurs on the general equipment connected via DIDO controller, M-NET address of
the DIDO controller will appear. (The recipients will know that an error has occurred on one of the
general equipment that is connected to the DIDO controller.)
Error code (4-digit) will appear.
- When an error occurs on air conditioning units, refer to the service manual of the unit for the error
Error code codes.
- When an error occurs on general equipment, “0091” (General equipment error) will appear.
- When a communication error occurs on PLC Software for General Equipment, “0003” (LAN
communication error to PLC) or “0007” (PLC program stopped) will appear.
Status Error status “Occurrence” (The error is occurring) or “Recovery” (The error has been resolved) will
appear.
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[6] Conducting an error email trial run

(1) Create an error such as a communication error.

(2) Check the sending results of an error email by clicking [Maintenance] - [Send Mail Log] on the Integrated
Centralized Control Web.

(3) If the error email is successfully sent, the trail run is complete. Confirm that the error email was received
at the send destination address.

(4) Check the following if transmission failed. (An error message will appear approximately 30 minutes after an
occurrence of the error.)

(4)-1 Check the network for problems
* Between the AE-200 and the public network
Check to see if other computers are connectable to the Internet.
» Between the public network and the outgoing mail server and incoming mail server
Operational status of outgoing and incoming mail servers
(4)-2 Check the email settings.
* Server settings

Check the outgoing mail server (SMTP), outgoing mail server port, encryption method, and DNS
server.
* Basic settings

Check the email addresses, user IDs, and passwords.
* Error mail settings
Check the send destination email address.

WT07627X17 149



7-1-2. Peak Cut (Energy-save control function)

According to the selected Peak Cut method, the AE-200/AE-50/EW-50 obtains the demand level or the electric

energy values to determine the control level, and operates outdoor units and blocks of indoor units below the
specified maximum capacity that corresponds to the control level.

Click [Function] in the menu bar, click [Peak Cut], and then click [Advanced] that corresponds to the target unit to

access the Peak Cut control settings screen. Make necessary settings, and then click [OK].

Important: The amount of electricity that is actually used may exceed the maximum power demand due to unexpected
problems such as controller malfunctions or broken transmission cables. Mitsubishi Electric will not be
responsible for exceeding the maximum power demand.

Note: After completing the settings, perform a test run and confirm proper connections of equipment before using the Peak Cut

function.

Note: A separate license is required to use the Peak Cut function. Make sure that the required license has properly been registered
on the Registration of Optional Functions screen. (Refer to section 4-5 “License registration for optional functions” for

details.)

Note: Peak Cut control cannot be performed on DIDO controller (PAC-YG66DCA), AHC, Air To Water (PWFY)) unit, HWHP (CAHV,

CRHYV, QAHV) unit, chiller unit, or MEHT-CH&HP unit.

Note: The Peak Cut control of indoor units is performed per block. Be sure to make block settings to use the Peak Cut function.
Note: The Peak Cut control settings between the outdoor and indoor units connected to the AE-200, AE-50, and EW-50, as well as

between the units connected to different AE-50/EW-50 controllers, cannot be made.

Peak Cut
AE name AE name Peak Cut method
AE01 PI Controller Advanced Advanced
AEO01-1 Mitsubishi building 1 PI Controller Advanced
Peak Cut method

AE01-2 Mitsubishi building 2 External input Advanced
AEO01-3 Mitsubishi building 3 PI Controller Advanced

Close

Click to send

the settings to

AE-200/AE-50/EW-50
and PLC.
[1] Peak Cut method
[Demand-Input PLC] [Electric Amount Count PLC]
e N e N

Reads electric
energy values.

Demand level is
input.

Demand level
signal is sent.

HENE: Electric Amount Pulse-watt-
Demand-Input Count PLC h
i Demand J our meter
‘ <« PLC controller '
e+ ] -
Maximum ten Maximum fourteen
z <) AE-200/AE-50/EW-50 units z —! ) AE-200/AE-50/EW-50 units
\\ J \\ J
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[PI Controller]

/

\
<When a PI controller (PAC-YG60MCA) is used> <When a built-in Pulse Input (PI) is used>
Reads electric
energy values.
— [
— ] A
- (Built-in Pulse Input (PI)) Pulse-watt-
P1 controller Pulse-watt- hour meter
hour meter | ~
Reads control f Reads control
_—" level. |_— level.
Maximum 10 Maximum 10
T 3 AE-200/AE-50/EW-50 units T i AE-200/AE-50/EW-50 units
Peak Cut method [Remote AE] Peak Cut method [Remote AE] )

[External Contact point input] (1)

External input/output
adapter (PAC-YG10HA-E)

LAN \
—» | |AE-200}:

Reads control
level.

Demand level is
input.

Demand
controller

L\

Maximum 10
AE-200/AE-50/EW-50 units

Peak Cut method [Remote AE]

. J

[From external system]
4 )

Demand level

signal is sent.

reand] 7 — T
PLC etc. Pulse-watt-
5 < hour meter
5 “1  Maximum 10
AE-200/AE-50/EW-50 units
eolj~
. = J
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[External Contact point input] (2)

- )
External input/output Demand level is
adapter (PAC-YG10HA-E) input.

‘ Demand
E controller
L = J
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(A) When the Peak Cut method [Demand-Input PLC] is selected

Controller AEO01 Mitsubishi Building

Peak Cut method Demand Input PLC

Peak Cut Outdoor unit Indoor unit

1P Address 192 168 1 171 Initialize

Control target AE
temperature

| A~ ]
3.0°c

Cancel

(1) Inthe [IP Address] field, enter the IP address of the Demand-Input PLC.

(2) When using the Demand-Input PLC for the first time, click [Initialize] to initialize its internal memory.
Note: Do not initialize the Demand-Input PLC after the operation has begun, for it will clear all operation data.

(3) In the [Controlled AE] field, enter the IP addresses of the AE-200/AE-50/EW-50 units to which the demand
level signal is sent. Up to 10 IP addresses can be registered.

(4) Inthe [Temperature difference between set point and inlet] section, a temperature differential can be set to
between 3 and 9 as necessary. The Peak Cut control setting that corresponds to the control level 0 will be
disregarded for the indoor unit groups in which the temperature difference between the set temperature and
the room temperature is greater than the specified temperature differential.

Note: This setting is not effective for the outlet air temperature control units.
Note: The Peak Cut control setting that corresponds to the control levels 1 to 4 will be effective regardless of the
temperature differential setting.

(B) When the Peak Cut method [Electric Amount Count PLC] is selected

Controller AEQ1 Mitsubishi Building

Peak Cut method Electric Amount Count PLC
P— P——

P Address 192 168 1 151 Initialize
DI Board Pulse Unit 1.0 kwh / pulse

Temperature difference bet

Control Level Minimum value Maximum value
temperature and temperature

200

180

160

140

(1) Inthe [IP address] field, enter the IP address of the Electric Amount Count PLC.

(2) When using the Electric Amount Count PLC for the first time, click [Initialize] to initialize the internal memory.
Note: Do not initialize the Electric Amount Count PLC after the operation has begun, for it will clear all operation data.

(3) Inthe [DI Board] field, select the DI board number to which the watt-hour meter is connected, and the
terminal number. If the watt-hour meter is connected to terminal 2 on a DI board 1, select 1-2.
Note: Select a DI board number 1 or 2, and select a terminal number/code between 0 and F.
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(4) In the [Pulse Unit] field, enter the pulse value that the watt-hour meter outputs. Set the pulse value according
to the watt-hour meter to be used.

Important: Check the watt-hour meter readings several times on the hour and the half-hour. Then, be sure to check
that the increase in the watt-hour meter reading for each 30-minute period and the average electric power
consumption in the same period that the Peak Cut function is used are the same amount.

(5) In the [Control levels] section, the range of the electric power must be set for each control level. For control
level 4, enter the value that is 10% to 15% below the maximum power demand (average electric energy that
cannot be exceeded in any 30-minute period). For control levels 3 to 0, enter the value that is decreased
by about 10% from the set value of the previous control level. (The screenshot above shows the setting
example of the maximum demand of 200 kW.)

Note: The optimum setting depends on the system configuration of the electric equipment and on the indoor environment in
each building. Determine the appropriate values accordingly.

(6) In the [Temperature difference between set point and inlet] section, a temperature differential can be set to
between 3 and 9 as necessary. The Peak Cut control setting that corresponds to the control level 0 will be
disregarded for the indoor unit groups in which the temperature difference between the set temperature and

the room temperature is greater than the specified temperature differential.
Note: This setting is not effective for the outlet air temperature control units.
Note: The Peak Cut control setting that corresponds to the control levels 1 to 4 will be effective regardless of the
temperature differential setting.

(C) When the Peak Cut method [Pl Controller] is selected

Controller AEO1 Mitsubishi Building

Peak Cut method PI Controller

P—— p—
Watthour r Address01-048-1 Exhibition hall(H)

Temperature difference between set

Control Level Minimum value Maximum value
temperature and room temperature

200
180
160
140

0 K

Cancel

(1) In the [Watthour meter] field, select the watt-hour meter used for the Peak Cut function or the PI controller to
which the watt-hour meter is connected.

Note: Only the watt-hour meters that have been registered on the Measurement screen are selectable. Refer to section
6-4-6 “Pl controller settings” for how to register metering devices.

Note: When a built-in Pulse Input (PI) is used, [‘Meter” + Channel No. + (space) + Metering device name] will appear. (For
example, if the watt-hour meter used for the Peak Cut function is connected to channel 3 of CN7 of AE-200 and the
metering device name is “For Peak Cut function,” [Meter3 For Peak Cut function] will appear.)

When a PI controller (PAC-YG60MCA) is used, [*Address” + Pl controller address + “-” + Channel No. + (space) +
Metering device name] will appear. (For example, if the watt-hour meter used for the Peak Cut function is connected
to channel 2 of a Pl controller (address 10) and the metering device name is not registered, [Address10-2] will
appear.)

(2) In the [Control levels] section, the range of the electric power must be set for each control level. For control
level 4, enter the value that is 10% to 15% below the maximum power demand (average electric energy that
cannot be exceeded in any 30-minute period). For control levels 3 to 0, enter the value that is decreased
by about 10% from the set value of the previous control level. (The screenshot above shows the setting

example of the maximum demand of 200 kW.)
Note: The optimum setting depends on the system configuration of the electric equipment and on the indoor environment in
each building. Determine the appropriate values accordingly.
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(3) Inthe [Temperature difference between set point and inlet] section, a temperature differential can be set to
between 3 and 9 as necessary. The Peak Cut control setting that corresponds to the control level 0 will be
disregarded for the indoor unit groups in which the temperature difference between the set temperature and
the room temperature is greater than the specified temperature differential.

Note: This setting is not effective for the outlet air temperature control units.

Note: The Peak Cut control setting that corresponds to the control levels 1 to 4 will be effective regardless of the
temperature differential setting.

Note: When a PI controller is only connected to AE-200, and when AE-50/EW-50 monitors AE-200, select “Remote AE” for
AE-50/EW-50.

(D) When the Peak Cut method [Remote AE] is selected

Controller AEO1 Mitsubishi Building

Peak Cut method Remote AE-200
P— P——

1P Address 192 168 1 2

Temperature difference between set
temperature and room temperature

[ A~ |
3.0°c

Cancel

(1) Inthe [IP address] field, enter the IP address of the AE-200/AE-50/EW-50 that uses one of the following.
- Built-in Pulse Input (P1)
- PI controller (PAC-YG60MCA)
- External contact input (Refer to (E) “When the Peak Cut method [External input] is selected” for details.)
Note: As the control level is obtained every minute from the AE-200/AE-50/EW-50 that uses a built-in Pulse Input (PI) or
a Pl controller (PAC-YGB60MCA), the control will be late for up to one minute on the AE-200/AE-50 whose Peak Cut
method setting is [Remote AE].
Note: Up to ten AE-200/AE-50/EW-50 units can be connected to the AE-200/AE-50/EW-50 unit that uses a built-in Pulse
Input (PI) or a PI controller (PAC-YG60MCA). When eleven or more AE-200/AE-50/EW-50 units are connected, add
the settings in (C) “When the Peak Cut method [PI Controller] is selected” or (E) “When the Peak Cut method [External input]

is selected”. Increase the number of AE-200/AE-50/EW-50 units to which pulse signals of watt-hour meters, PI controllers, or
external contact inputs are connected.

(2) Inthe [Temperature difference between set temperature and room temperature] section, a temperature
differential can be set to between 3 and 9 as necessary. The Peak Cut control setting that corresponds to
the control level 0 will be disregarded for the indoor unit groups in which the temperature difference between
the set temperature and the room temperature is greater than the specified temperature differential.

Note: This setting is not effective for the outlet air temperature control units.
Note: The Peak Cut control setting that corresponds to the control levels 1 to 4 will be effective regardless of the
temperature differential setting.
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(E) When the Peak Cut method [External input] is selected
Note: The external signal can be input to AE-200, AE-50, and EW-50, so that all outdoor units and blocks of indoor units can be
selected.

Controller AEQ1 Mitsubishi Building

Peak Cut Outdoor unit Indoor unit

Temperature difference between set
temperature and room temperature

Cancel

(1) Inthe [Temperature difference between set temperature and room temperature] section, a temperature
differential can be set to between 3 and 9 as necessary. The Peak Cut control setting that corresponds to
the control level 0 will be disregarded for the indoor unit groups in which the temperature difference between
the set temperature and the room temperature is greater than the specified temperature differential.

Note: This setting is not effective for the outlet air temperature control units.
Note: The Peak Cut control setting that corresponds to the control levels 1 to 4 will be effective regardless of the

temperature differential setting.
Note: When an external input is only connected to AE-200, and when AE-50/EW-50 monitors AE-200’s control level, select

“Remote AE” for AE-50/EW-50.

(F) When the Peak Cut method [From external system] is selected

Controller AEQ1 Mitsubishi Building

Peak Cut method From external system
e s

Temperature difference between set
temperature and room temperature

(1) Inthe [Temperature difference between set temperature and room temperature] section, a temperature
differential can be set to between 3 and 9 as necessary. The Peak Cut control setting that corresponds to
the control level 0 will be disregarded for the indoor unit groups in which the temperature difference between
the set temperature and the room temperature is greater than the specified temperature differential.

Note: This setting is not effective for the outlet air temperature control units.
Note: The Peak Cut control setting that corresponds to the control levels 1 to 4 will be effective regardless of the

temperature differential setting.
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[2] Control details for outdoor units (All Peak Cut methods)

Follow the instructions below to make the Peak Cut control settings for each control level for given outdoor units.
Note: If the outdoor unit is a City Multi unit, the M-NET address will appear. If the outdoor unit is an A-control (Mr. Slim) unit, the
M-NET address and group name will appear.
Note: As for A-control outdoor units, only the inverter models can perform Peak Cut control. The Peak Cut control settings for
constant-speed models can not be made.
Note: Do not make the Peak Cut control settings for heat pump models of outdoor units or some types of outdoor units.

Controller AEO01 Mitsubishi Building

Peak Cut method From external system

Peak Cut Outdoor unit Indoor unit

Maximum CapaCItyl Maximum Capacity/Control Time
Control Time All
Click to make settings for

all outdoor units at once.

\, Level 0 Level 1 Level 2 Level 3 Level 4

01-051 100%/3min  80%6/9min 709%/9min  609%/15min  5096/30min
01-053 80%/3min 70%/9min 70%/9min 609%/9min 60%6/30min
01-071 80%6/6min  70%6/15min  709%/15min  60%/30min  60%/30min L Edit

90%/6min 80%/9min 70%/9min 709%/15min 709%/30min

Maximum Capacity/Control Time settings

Outdoor units : 01-081

Maximum Capacity

Outdoor units ol Maximum Capacity G Select the maximum

When the “All” button was operation c_apacity of
clicked, “All” will appear. . e outdoor units.

When the “Edit” button was

clicked, outdoor unit name

will appear. 90% 5 6min | 9min | 15min

90% | 80% % 3min | 6min | 9min | 15min

émin | 9min | 15min

90% b émin | 9min | 15min

6min | 9min | 15min

Control Time

cancel oK Select the control time.
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(1) To make settings for all outdoor units at once, Capacity
click [All]. A
Then, set the maximum operating capacity for
each control level.

The smaller the maximum operating capacity, 80% [~=-=-="=====-=----22

the more energy will be saved.

Note: Energy-saving effects cannot be expected Operating
during low-load operation with the capacity Capacity
below the selected maximum capacity.

Note: For heat pump outdoor units and City Multi
S series (PUMY) outdoor units, leave the
default setting [100%] as it is not to activate
the capacity-save control.
However, [50%] though [100%] can be set on
the following models.
PUMY-P**KM or later
PUMY-P**KM-A or later
PUMY-P**HMC-S or later
PUMY-P**HMC-C or later
PUMY-P**KMC-C or later
PUMY-P**YKM.TH(-T) or later

Note: AE-200/AE-50/EW-50 that support Maximum
Capacity [50%)] are from Ver. 7.23 or later.

e.g., Maximum capacity at 80%

No energy-saving effects Energy-saving effects

> Time

(2) For each control level, set the total time in which the Peak Cut control is performed during every 30 minutes.
Setting the time to [30] or [15] minutes is preferable, for shorter control time is not likely to bring much
benefit.

If any time other than [30] minutes is selected, the outdoor units will operate in rotation so that they will not
perform the Peak Cut control at the same time.

WT07627X17 157



[3] Control details for blocks of indoor units

Click [Edit], and follow the instructions below to make the Peak Cut control settings for each control level for given
blocks of indoor units.

If the block settings have not been made, refer to section 6-4-4 “Block settings” for how to make the block settings.

Controller AEO01 Mitsubishi Building

Peak Cut method Electric Amount Count PLC

Peak Cut Outdoor unit Indoor unit

Control level

Control Details/Control Time

All

Click to make settings for
all indoor units at once.

Level 0 Level 1 Level 2 Level 3 Level 4

+29C/9min Fan/9min Fan/9min OFF/15min OFF/20min

+29C/6min Fan/9min Fan/15min Fan/30min  OFF/30min

+20C/6min Fan/9min Fan/9min Fan/9min Fan/15min Ed it

None/3min None/3min None/3min None/3min None/3min

None/3min  £2°C/6min  £2°C/9min  Fan/15min  OFF/15min

Control Details/Control Time settings

Indoor units : 1F North

f Control Details
Indoor units T Control Details Control Time Select the indoor unit
When the “All” button was fevel control type.
clicked, “All” will appear.
When the “Edit” button was
clicked, indoor unit name will
appear. 2! 6min 9min | 15min | 30min

3min 6min 9min 15min | 30min

6min 9min 15min | 30min
6min 9min 15min | 30min
6min 9min 15min | 30min

Control Time

Cancel OK Select the control time.
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(1) Display the block whose settings are to be made. To make settings for all blocks at once, click [All].
Then, select the control method for each control level, referring to the table below.

Note: Only the control method “OFF” is effective for Air To Water (PWFY) units. Other methods can be selected, but are not
effective.

Table: Indoor Unit Control Method

Control Method Control details

None Peak Cut control will not be performed.

During the Peak Cut control, the set temperature in the Cool or Dry mode will be offset by +2°C (+4°F),
and the set temperature in the Heat mode will be offset by -2°C (-4°F).
Note: Peak Cut control will not be performed during the Fan or Auto mode.
+29C (+4°F) Note: When the unit of temperature is Fahrenheit, the set temperature may not be offset by +4°F
- - exactly because 2°C is used for the calculation first, and then the temperature in Celsius is
converted into the temperature in Fahrenheit.
Note: The set temperature will be adjusted within the set temperature restrictions settings.
Refer to section 7-1-3 “Set Temperature Range Limit” for details.

During the Peak Cut control, free-plan indoor units and A-control Mr. Slim indoor units (M-Series/
P-Series indoor units) will go in to the Thermo-OFF state, and the units older than free-plan units will
operate in the Fan mode. (When the units are in the Thermo-OFF state, the operation mode on the
remote controller LCD will not change.)

Fan *1

During the Peak Cut control, the units will stop.
OFF ™1 Note:If the control method is set to [OFF] and the Control Time is set to [30] minutes, the groups
that are operated in the Peak Cut control cannot be operated from any controller.

*1 When the indoor unit Peak Cut control function is used during the heating operation, it takes a while to resume operation to prevent cold air
draft. This may negatively affect the performance of the unit for a certain period of time after the operation is resumed. To ensure maximum
performance, it is recommended to use an outdoor unit capacity-save control function (that will not stop the compressor operation) during the
heating operation. If the indoor unit Peak Cut control function is still used, selecting [3] minutes in the Control Time section is recommended.
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7-1-3. Set Temperature Range Limit
The settable temperature range for the local remote controllers can be limited. By restricting the lower and upper
limit of the set temperatures for cooling, heating, and auto modes, energy consumption can be reduced.

Click [Function] in the menu bar, and then click [Set Temperature Range Limit] to access the set temperature range

restrictions settings screen.

Note: The set temperature range restrictions settings may not be effective, depending on the unit model of the remote controller

and the indoor unit.

Note: A-control (Mr. Slim) units, room air conditioners, and residential air conditioners do not support the set temperature range

restrictions settings.

Note: The set temperature limit range for the AUTO mode cannot be set for the groups that support the dual set point function in
the AUTO mode. The set temperature ranges for the normal cooling and heating modes will be used for the ones for cooling
and heating in the Auto (dual set point) mode.

Set Temperature

Controller All controllers

Group
number

Group No. and 01-1

group name
01-2

01-3
01-4
01-21

01-25

Group Name

Group01-1

Group01-2

Group01-3

Group01-4

Group01-21

Group01-25

Range Limit

Set temperature range
o " ’

Cool Heat
Upper/Lower Upper/Lower Upper/Lower

Cancel

(1) Display the group whose settings are to be made. To
make settings for all groups at once, click [All].
Then, click the [Set temperature range] area to display Cool mode Heat mode Auto mode

the setting screen.

Edit
Edit
Edit
Edit

OK
Click to save the changes
made.

Set Temperature Range Limit settings

Controller Group01-25

Set the temperature ranges for cooling, heating, and auto [l 2o § o0 RSl w0 N 20 [l 20 f 20 08

modes.

Click [OK] to return to the previous screen.

Note: When the temperature unit is Fahrenheit, temperatures

are displayed in 2°F increments.
Note: The temperature range for Dry mode will be the same as

the one for cooling mode.

(2) Click [OK] to save the settings.
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7-1-4. External Temperature Interlock

Based on the temperature difference between the set temperature and the outdoor temperature, the set temperature

can be adjusted automatically. Making this control setting on the air conditioning unit at an entrance of a building
prevents extreme temperature change from distressing our bodies and sending us into shock. Click [Function] in
the menu bar, and then click [External Temperature Interlock] to access the External Temperature Interlock settings
screen.

Note: External Temperature Interlock is available only for air conditioning unit groups.
Note: Either an Al controller (PAC-YG63MCA) or AHC, and an outdoor temperature sensor are required to measure the outdoor
temperature.

Note: When connecting one or more AE-50/EW-50 controllers, connect an Al controller (PAC-YG63MCA) and outdoor temperature

sensor on each AE-50/EW-50.

Note: The External Temperature Interlock settings between the units connected to the AE-200, AE-50, and EW-50, as well as
between the units connected to different AE-50/EW-50 controllers, cannot be made.

Note: This function is not available for the outlet air temperature control units.

External Temperature Interlock

Controller AEO1 e
Set Temperature Variation
Temperature Sensor Extemal Temperature Sensor Address50-1 Exhibition hall(T) Range
Select a temperature sensor ) Select a maximum
Group Number Group Name Set Temperature Variation Range
to measure the outdoor temperature value to be

temperature with. T Groupo1-21 P | e | p— . added to or subtracted from

the set temperature.

(1)

()

@)

/' 01-25 Group01-25 None | 1oc | #29€ | x3oc | zaoC

Group No. and
group name

Cancel OK

Click to save the changes
made.

In the [Temperature Sensor] section, select a temperature sensor to measure the outdoor temperature with.
In the pulldown menu, the name of the temperature sensor that is connected to the Al controller or the AHC

will appear.
Note: Connect the temperature sensor to either the Analog Input 1 or Analog Input 2 port on the AHC.

In the [Set Temperature Variation Range] section, select a maximum temperature value for each group to be
added to or subtracted from the set temperature.

For example, when [£4°C] (£8°F) is selected and the set temperature for the Cool or the Dry mode is set to
24°C (75°F), the set temperature will be adjusted to a maximum of 28°C (83°F) based on the temperature
difference between the set temperature and the outdoor temperature. When [+2°C] (+4°F) is selected, the

set temperature will be adjusted to maximum of 26°C (79°F).
Note: When the unit of temperature is Fahrenheit, the selected temperature value may not be added to the set temperature
accurately because 2°C is used for the calculation first, and then the temperature in Celsius is converted into the
temperature in Fahrenheit.

Click [OK] to save the settings.
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When the External Temperature Interlock function is active, the set temperature will be adjusted as shown

below.

H “Cool” and “Dry” modes

36 ~| Outdoor temperature i

. ~N—

34 / \
%) 23 / Set temperature after being adjusted
‘L, / when [Set Temperature Variation
g 31 / Range] is set to [+4°C] (+x8°F)
] E— Z
S / L\
sn /0 1\

26

_/

o | < AN

24

23 !_S'et temperature |:

Time

Outdoor temperature conditions

Set temperature after being adjusted

Outdoor temperature =
Set temperature + 1.5°C (3°F)

Set temperature + 1°C (2°F)

Outdoor temperature =
Set temperature + 4.5°C (9°F)

Set temperature + 2°C (4°F)

Outdoor temperature =
Set temperature + 6.5°C (12°F)

Set temperature + 3°C (6°F)

Outdoor temperature =
Set temperature + 7.5°C (14°F)

Set temperature + 4°C (8°F)

M “Heat” mode

19 Y
18 | ™ L l /
17 N\ L 1/
16 N\ L I/

O 15 \ | /

@ 14 \ 4 /

=213 Set temperature after being adjusted /

g 12 | | when [Set Temperature Variation /

S 1y | |Rangelis set to [+4°C] (+B°F) /

€ 10 \ /
9 \ A
8 \ /A
7 N\ /| Outdoor temperature
: N S ! |

Time

Outdoor temperature conditions

Set temperature after being adjusted

Outdoor temperature <
Set temperature - 4.0°C (8°F)

Set temperature - 1°C (2°F)

Outdoor temperature <
Set temperature - 6.0°C (11°F)

Set temperature - 2°C (4°F)

Outdoor temperature <
Set temperature - 8.0°C (15°F)

Set temperature - 3°C (6°F)

Outdoor temperature <
Set temperature - 10.0°C (18°F)

Set temperature - 4°C (8°F)
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7-1-5. Night Mode (quiet operation) Schedule
Outdoor units can be operated in a quiet mode for the specified time period. Use the Night mode when low-noise
operation of the outdoor unit is preferable during the night.
Click [Function] in the menu bar, and then click [Night Mode Schedule] to access the Night Mode Schedule settings
screen.
Note: Make the Night Mode Schedule settings only when all the units are in normal operation. When connection error occurs with

the indoor or the outdoor units, the target outdoor units may not be displayed properly.
Note: The degree of noise reduction depends on the outdoor unit model.

Night Mode Schedule

Controller AEO1 End Time
E——
Start Time —

Address ight Mode Schedule
Target Outdoor Units 01-051
01-053
01-071

01-075

Cancel OK OK
Click to save the changes
made.

(1) Inthe [Start Time] and [End Time] sections, specify the start and end times for the Night mode.
Note: When the start time and the end time is the same, the units will operate in the Night mode at all times.
Note: The time period over the next day (such as 22: 00 - 6: 00) can be set.

(2) Select the Night Mode Schedule setting “ON” or “OFF” for each outdoor unit.
(3) Click [OK] to save the settings.
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7-1-6. Night Setback Control

The Night Setback Control function (hereafter abbreviated as Setback Control) prevents indoor condensation by
performing heating operation automatically when the room temperature goes outside of the specific range during
the night. Click [Function] in the menu bar, click [Night Setback Control], and then select the target centralized
controller in the [Controller] section.

Heating operation starts when a given group is stopped and the room temperature drops below the specified
minimum temperature.

Note: The Setback Control function also prevents excessive temperature rise by performing cooling operation automatically when
the room temperature goes outside of the specific range. Cooling operation starts when a given group is stopped and the
room temperature rises above the specified maximum temperature.

Note: If the room temperature is measured by the return air temperature sensor on the air conditioning unit, the measured value
may not be an accurate representation of the temperature in the room, especially when the air conditioning unit is stopped
and the room air is stagnant. When this is the case, use an external temperature sensor (PAC-SE40TSA) or remote
controller sensor to measure the room temperature.

Note: This function is not available for the outlet air temperature control units.

Night Setback Control

Setback Control Period

Setback Control Usability il .
Night Setback Control E_ Control Period
Group Number Group Name Min. Temperature  Max. Temperature Temperature range
Group No. and group 01-21 Group01-21 21.5°C -
name

01-25 Group01-25 22.5°C -
Paste
Copy

Cancel OK

Click to save the changes
made.

(1) Select [Use] and set the time period in which Setback Control is performed.
Note: When [00: 00 - 00: 00] is selected, Setback Control is active for 24 hours.

(2) In the [Temperature range] section, set the maximum and minimum temperatures for each group.
For example, if [Setback Control Period] is set to [01:00 - 05:00] and [Temperature range] is set to
[12°C - --°C] ([53°F - --°F]), heating operation starts automatically when the room temperature drops below
the set temperature 12°C (53°F) between 1:00 and 5:00. When the Setback Control ends at 5:00, the set
temperature returns to the original setting, and the operation stops.
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Note: The air conditioning units in the heating operation will stop and the set temperature will return to the original setting
when the Setback Control period is over or the room temperature rises to the minimum temperature plus 3°C (6°F).
Likewise, the air conditioning units in the cooling operation will stop and the set temperature will return to the original
setting when the Setback Control period is over or the room temperature drops to the maximum temperature minus

3°C (6°F).
Setback
operation
Room temp. Setback ends.
21°C(69°F) =W WK =~ ===~ | operation i iy A2
starts.

Min. temp.
12°C(B3°F)=~F~~~—°~ ufttnininininin

Heat ON Heat OFF Heat ON Heat OFF
21°C (69°F) 12°C (53°F) 21°C (69°F)
>
< >

Setback Control period

When the temperature drops below the minimum temperature (heating operation)

Setback
operation
Max. temp. stz

28°C(83°F) ==~ ————=-— 7/3aA——"—-———==

Setback

Room temp. operation
24°C (75°F) N & AF"— — — = — starts. L
Cool ON Cool OFF Cool ON Cool OFF
24°C (75°F) 28°C (83°F) 24°C (75°F)
- >

Setback Control period

When the temperature rises above the maximum temperature (cooling operation)

(3) To copy the settings of a group to the settings for other groups, click [Copy] in the row of the group whose
settings are to be copied, then click [Paste] in the row of the group to which the copied settings are to be
pasted. The rectangular icons next to the selected buttons will appear in yellow-green.

(4) Click [OK] to save the settings.
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7-2. Ventilation Settings

7-2-1. Night purge
During summer, the Night purge function draws cooler outside air into the room to suppress temperature rises at
night. This energy conservation reduces the load when air conditioning starts the next morning.
Click [Ventilation Settings] in the menu bar, and then click [Night purge Setting] to access the Night purge settings
screen.
All LOSSNAY unit groups that support the Night purge function from AE-200 will appear.
Note: During the Night purge operation, LOSSNAY units operate in the Bypass mode.
Note: Night purge setting cannot be made from AE-200 for the LOSSNAY units that are connected to the AE-50/EW-50 in
communication error.
Note: Some models of LOSSNAY units do not support the Night purge function from AE-200. (As of March 2015, only LGH-RVX-E
models support the function.)
For more details about the Night purge function, refer to the Installation Manual, Instruction Book, or technical documents
that are provided with the LOSSNAY unit .

Night purge setting

Night purge setting Setting contents

[Available]/[Not Available] e

Group Number Group Name AvailableNot Available Setting contents

Sun Mon Tue Wed Thu Fri Sat  01:00-06:00

Group No. and group 1F Ventilation Not Available -_— T
5°C v Edit

name 28°C 58w

Sun Mon Tue Wed Thu Fri Sat  23:00-07:00

2F Ventilation Available —
27°C 4°C Edit

(3

Sun Mon Tue Wed Thu Fri Sat  00:00-05:00

3F Ventilation Available —
28°C 7°C Edit

Cancel OK OK

Click to save the changes
made.

(1) Click the “Setting contents” section in the row of the group whose settings are to be made. A settings screen

will appear.
Note: To make settings for all groups at once, click [All].

Night purge setting
[Available]/[Not Group01-21

Available]
Available./Not Available Available

Days of the week

. Night purge setting

Days of the week

Start time End time OT threshold Init fan spd
Hour Minute Hour Minute — .
28 oo ~ Initial fan speed
E RoomTemp dif Outdoor temperature
Start Time threshold
08 01 5.00c
09 02
End Time
Temperature
difference between
Cancel room temperature and

outdoor temperature

(2) In the Night purge setting section, select [Available] to enable the Night purge settings.
(3) Select one or more days on which the Night purge control is executed at the selected start time.

(4) Set the times at which the Night purge control starts and ends.
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®)

(6)

(7)
(8)
©)

Set the outdoor temperature threshold value as a condition for activating the Night purge operation.
* The settable temperature is between 15°C and 30°C.

Set the temperature difference as a condition for activating the Night purge operation.
* The settable temperature is between 0°C and 7°C.

Set the fan speed to be set when the Night purge operation activates.
Click [OK] to go back to the previous screen.

After the settings are completed, click [OK] to send the settings to the AE-200/AE-50/EW-50.

Starting condition
Condition #1: LOSSNAY units stop at 20:00.
Condition #2: Between the start time 1:00 and the end time 6:00
Condition #3: LOSSNAY units detected the outdoor temperature threshold 17°C or higher in the past 24 hours.
Condition #4: The current room temperature is higher than 22°C. (The temperature 22°C cannot be set from
AE-200/AE-50/EW-50.)
Condition #5: The temperature difference between room temperature and outdoor temperature is greater than
the temperature difference 5°C.
* LOSSNAY units start the Night purge operation at 3:00 when the temperature difference between room
temperature and outdoor temperature exceeds 5°C.
» The Night purge operation is not activated at 1:00 or 2:00 because the temperature difference between room
temperature and outdoor temperature is less than 5°C.

= == Room temp.

Time 12:00 16:00 20:00 1:00 3:00 6:00
v AV v AV AV
§ i Condition #4 Condition #5
' ! Room temp.: 25°C Temp. difference: 6°C
/ ’ : i —— —

Condition #3 : >~ o~

Temperature | .~ i Maximumoutdoor |__ <. S A SER T
| temperature: 29°C ! i

2°C

4°C

—_———— —— — ——————— — —— i .

i : 1:00 i 2:00

= Qutdoor temp. i : Tomp. Tomp.
: ! difference: || difference: |———— — —

LOSSNAY

OFF

Night purge
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8. Maintenance

This section explains backup and reading of settings data.

There are two ways to backup the settings data — from the AE-200’s LCD to a USB memory device, and from
Integrated Centralized Control Web.

The settings data backed up to a USB memory from the LCD and the settings data backed up from the Integrated
Centralized Control Web are compatible.

8-1. Settings Data Backup from the AE-200’s LCD
Backup the settings data from the AE-200’s LCD to a USB memory device.

Backup of settings for the AE-200 and for the expansion controller is possible.

Note: Test the USB memory device several times before use and verify that the device functions properly. Reading data from or
writing data to a USB memory device that has not been confirmed to work may cause unexpected problems. (If the data
cannot be output to the USB memory device after a writing error occurs and the device is replaced, reboot the AE-200/AE-50
(turn off the power and restart). Do not use the USB memory device that has experienced writing error once.)

Note: License registration information cannot be backed up.

8-1-1. Backing up settings data
The settings data can be exported to a USB memory as a backup.

Touch [Maintenance] in the menu bar, and then touch [Backup].
Note: IP address settings will not be backed up. Make sure to write them down.

v Settinas
Backup Energy data outm

Setting data for main unit and air conditioners

All settings

All settings

Copy to USB Memory

Copy to USB Memory
Touch to back up the
settings data.

Important

e The USB memory device may not be recognized if you insert and remove it within a short time. If this happens, reset the
AE-200/AE-50.

e The AE-50/EW-50 data can be output from the AE-200.

(1) Remove the controller cover, and insert a USB memory device to the USB port.
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(2) Touch [All settings], then touch [Copy to USB Memory].
The settings data file will be created in the root folder of the USB memory.

B File output destination, folder name, and file name

[Root folder of the USB memory]\[Serial No.]\"SettingData”\"AE” *1
*1 “AE1,” “AE2,” “AE3,” or “AE4” when one or more AE-50/EW-50 controllers are connected

<Example>

Root folder of the USB memory

12345-123 (AE-200 serial No.)

l—SettingData

AE — AE-200 settings file
——AE1 — AE-50_1 settings file
——AE2 — AE-50_2 settings file
——AE3 — AE-50_3 settings file
—— AE4 — AE-50_4 settings file
Note: It will take a few minutes to create the settings data.
Note: Do not remove the USB memory device while the data is being output.
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8-1-2. Importing settings data
The exported data can be imported back to the AE-200/AE-50/EW-50 to restore the previous settings after the
controller replacement.
Touch [Maintenance] in the menu bar, and then touch [Import].

All settings

,, " " car Trfn | Mainte-
‘ ! Settings A nance

Read from USB Memory

Read from USB Memory
Touch to import the settings
data.

Important

e The USB memory device may not be recognized if you insert and remove it within a short time. If this happens, reset the
AE-200/AE-50/EW-50.

(1) Have the settings data to be imported ready in the root folder of the USB memory as shown below. (common
to both AE-200/AE-50)

B File location, folder name, and file name

[Root folder of the USB memory]\“SetupData”_[IP address|\"AE” *1
*1 “AE1,” “AE2,” “AE3,” or “AE4” when connecting AE-50/EW-50 to AE-200

<Example (When AE-200 LAN1 IP address is [192.168.1.1]>
Root folder of the USB memory

SetupData_192_168_1_1 "2

AE — AE-200 settings file
——AE1 — AE-50_1 settings file
——AE2 — AE-50_2 settings file
——AE3 — AE-50_3 settings file
—— AE4 — AE-50_4 settings file

*2 The folder name will not be [SetupData_192_168_001_001].
Note: Only the data that have been backed up from the AE-200 can be imported to the AE-200. The data that have been

backed up from the AE-50 must be imported to the AE-50.

Note: Do not change the file name from that of when backup was performed. If the folder name or file name is different from

Note:

the given name, no data can be read.
Files that were backed up from the Integrated Centralized Control Web are importable.

Note: The [IP address] shown above will be set to [192_168_1_12] when the IP address of AE-200 is [192.168.1.12].

(Replace the period “.” with underbar “_".)

(2) Remove the controller cover, and insert a USB memory device to the USB port.

(3) Touch [All settings], then touch [Read from USB Memory].

Note:
Note:
Note:
Note: If the data is not read, check if the USB memory device is inserted correctly.
Note:
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It will take a few minutes to import the settings data.

Do not remove the USB memory device while the data is being imported.

If the data is not read, check the folder name and the file name. The period “.” in the IP address within the folder
name must be changed to underbar “_".

Files backed up from the Integrated Centralized Control Web can be loaded. When loading the files, ensure that the
root folder of the USB memory device is set in the format shown in step (1) above.

170




8-2. Settings Data Backup from Integrated Centralized Control Web
The settings data that have been made from the Initial Setting Tool or Integrated Centralized Control Web can be

exported to an HDD as a backup.
The exported data can be imported back to the AE-200/AE-50/EW-50 to restore the previous settings after

AE-200/AE-50/EW-50 replacement. The settings data can be backed up or imported from the Integrated Centralized

Control Web.

(1) Click [Maintenance] > [Utility] > [Back up/import settings data] to access the Back up/import settings data

screen.

Note: This function is accessible only if logged in as a building manager. Tenant managers and general users cannot use

this function.

Reference —

Click to browse for a file
that contains the data to be
imported.

KX

Back up/import settings data

®

Home Back up settings data

[o.]

Monitor/Operation

.

Energy Management

Schedule

Import settings data

Notice

o

Settings

Reference | Data import source SettingData.dat

Data import source
The path to the file to be
imported will appear.

11:09.

08/08(Wed)
2018

Import settings data |

Back up settings data

— Back up settings data
Click to back up the
AE-200/AE-50/EW-50
settings data.

\—— Import settings data

Click to import the file
specified in the “Data
import source” field to the

coman© assaoney rsuersw tecrc comorsron [ AE-200/AE-50/EW-50.
s esened

8-2-1. Backing up settings data

(1) To back up the data, click [Back up settings data]. The settings data will be created and the Window’s

standard file download dialog will appear.
Note: It will take a few minutes to create the settings data.
Note: The name of the settings data will be “SettingData.dat”.

Smm

Home. Back up settings data

Monitor/Operation Creating settings data.
Please wait:

Eneray Management

05:44..

08/03(Thu)

Back up/import settings data
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Back up/import settings data

Back up settings data

Back up settings data

The settings data have been created. Please download the
settings data.

Import settings data |




8-2-2. Importing settings data
(1) Click the [Reference] button on the Back up/import settings data screen.
(2) Select the file to be imported, and click [Open].

(3) Click [Import settings data] to import the settings data to the AE-200/AE-50/EW-50.
Note: It will take a few minutes to import the settings data.

A A
Back up/import settings data Back up/import settings data
A
Home Home
o] o]
Monitor/Operation
e
ncrgy Management
Schedule
=] Import settings data Import settings data
Notce
| Data import source Settngbota dot || Data import source SetungData.dat
S The settings data is being sent. Please wait: The settings data is being updated. Please wait it

AKEBTk 01:46n

08/08(Wed)
2018

o8/08(Wed)
2018

(4) When the settings data has been successfully imported, the AE-200/AE-50/EW-50 will restart.

EX:
Back up/import settings data
oo}
o
s
et
En <
a Import settings dal
Notoe
| o
gy The settings data have been successfully updated. The computer
will restart.
Please try accessing later.
caiostwed o
2018 5

Note: Files backed up from the LCD screen can be loaded.
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9. Troubleshooting

See the table below and troubleshoot accordingly.

No. Problem Possible cause Solution
Errors are displayed | “Version combination error | The versions of the » Check the versions of the AE-200
on the [Malfunction] | (0092)” AE-200/AE-50/EW-50 do and AE-50/EW-50.
) screen under the not match.
[Status List] menu Refer to the Instruction Book
on the AE-200’s (Apportioned Electricity Billing
LCD. Function) for details.
“Warning - possibility of The measurement value » Check if the measurement value
Or, damaged metering device | of the metering device is properly counted up on the
) (0095)” (which should count up the | [Measurement] screen under the
Error log is operation amount of air- [Monitor/Operation] menu.
displayed on the conditioning units) does When an electricity meter with
[Unit Error] screen not count up for 3 to 7 large pulse value is used, the error
under the [Log] days. message may appear even if the
menu on the * Whether to warn (3 to 7 days | wiring connection is correct.
AE-200's LCD. before the warning is issued) | « Check for proper connection
or not to warn can be set. between the electricity meter
(2) When *Not warn” is set, and the PI controller (when a Pl
errors cannot be detected. controller is used).

» Check for proper connection
between the electricity meter
and the built-in Pulse Input (PI)
on the AE-50/EW-50 (when a
built-in Pulse Input (PI) on the
AE-50/EW-50 is used).

» Check if no communication error
between the PI controller and the
AE-50/EW-50 is occurring.

“Communication error - No | The communication * Check if the destination IP address

response error (6920)” between AE-200 and is properly entered.

(3) AE-50/EW-50 is not * Check for proper connection
properly established. between the AE-200 and
AE-50/EW-50.

“System abnormality - 1) In the group of units Cause 1)

Attribute setting error such as PI controllers, Configure the groups so that all

(7106)” chiller units, or HWHP addresses in each group have
(QAHV) units, an the same attribute (such as Pl
address with attribute controllers, chiller units, or HWHP
for different type of units | (QAHV) units).
(such as air conditioning Cause 2)
units) exists. Correct or delete the address of

(4) 2) Thg addrgss of the the unit to be interlocked set in the
unit to be interlocked | jipteriocked LOSSNAY] screen.
set in the [Interlocked
LOSSNAY] screen is not | Cause 3)
an address of LOSSNAY | Switch the attribute using a
unit. dipswitch. Refer to the installation
3) The attribute setting (IC/ manuallof the OA processing unit
FU) for OA processing | for details.
unit is not correct.
WT07627X17

173




No.

Problem

Possible cause

Solution

Errors are displayed
on the [Malfunction]
screen under the
[Status List] menu
on the AE-200’s
LCD.

Or,

Error log is
displayed on the
[Unit Error] screen
under the [Log]
menu on the
AE-200’s LCD.

“System abnormality -
Connection setting error
(7109)

1) The group setting
contents set on the
AE-200 do not match
with the chiller unit
configuration and the
setting contents.

2) The HW Supply setting
contents set on the
AE-200 do not match
with the HWHP (QAHV)
unit configuration and
the setting contents.

Cause 1)

Check the addresses in the group
settings and the unit configuration
for chiller units. If they do not match,
reconfigure them.

Cause 2)

Check the addresses in the HW
Supply settings and the unit
configuration for HWHP (QAHV)
units. If they do not match,
reconfigure the address settings.

“System abnormality -
Different unit model error
(7130)”

1) The digital setting on
the HWHP (QAHV) unit
is wrong.

Cause 1)

Set the digital setting item code
“107” on the circuit board on the
HWHP (QAHV) unit to “2”.

Errors are displayed
on the [Malfunction]
screen under the
[Status List] menu
on the AE-50’s
LCD.

“Communication error - No
response error (6920)”

1) The communication
between AE-50 and
AE-200 is not properly
established.

2) An error for the
communication with
the AE-200 that was
connected in the past is

» Check for proper connection
between the AE-200 and AE-50.

» Make the AE-50/EW-50
communication error detection
settings on the [Network] screen
under the [Initial Settings] menu.
Refer to section 5-1-5 “Network” [5]
“Communication error detection”

(7) being detected. for details.
3) The IP address of
the AE-200 has been
changed.
4) The AE-50/EW-50
that experienced 2)
or 3) above has been
updated to Ver. 7.3 or
later.
A message is Message: Settings were transmitted | Settings for functions added in new
displayed when “The versions of one or from a new Initial version have not been carried out.
Initial Setting more centralized controllers | Setting Tool to an old Update the AE-200/AE-50/EW-50.
Tool settings are are old and not compatible | AE-200/AE-50/EW-50. Refer to section 3-1 “Separately
(8) | transmitted. with this tool. The settings sold parts” for compatible version
that are not supported for combination of Initial Setting Tool
these centralized controllers and AE-200/AE-50/EW-50.
will not be sent. Check the Refer to section 4-4 “Software
transmission result.” Update” for details of updates.
A message is Message: 1) The centralized Cause 1)-1
displayed when “The unit configuration controller type set on Check the “AE-200 M-NET” and
data is acquired settings for the following the system configuration | “AE-200 Apportion” settings on the
or Initial Setting centralized controller does settings screen differs [Unit Info.] screen on the LCD.
Tool settings are not match with the actual from the actual type. Cause 1)-2
) transmitted. unit configuration. 2) The configuration Change the system configuration
setting for the expansion | settings so that the settings match
controller set on the with the actual unit configuration.
syst.em configuration Cause 2)
sgttlngs screen Make the expansion controller
differs from the actual | qoitings on the [Network] screen on
configuration. the LCD.
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No.

Problem

Possible cause

Solution

(10)

Initial settings data cannot be output from the
LCD to the USB memory device.

1) The USB memory
device is not set
correctly.

2) There is insufficient
free space on the USB
memory device.

3) The USB memory
device does not support
the AE-200/AE-50.

4) The USB memory
device was removed or
inserted too quickly.

5) The USB memory
device is write-
protected.

Check causes 1) to 3).

Cause 1)
Check that the USB memory device
is fully inserted.

Cause 2)

Check that there is sufficient free
space on the USB memory device,
and if necessary, create more free
space. (Maximum 64 MBytes)

Cause 3)

Use a USB memory device as
detailed in section 8 “Maintenance”.
After a malfunction has occurred, if
writing does not proceed normally
even after using a different USB
memory device, then restart the
AE-200/AE-50 (power OFF—ON),
then try again using a USB memory
different from that originally used.

Cause 4)
Restart the AE-200/AE-50 (power
OFF—ON).

Cause 5)

Unlock the write-protect switch on
the USB memory.

For details, refer to the USB
memory device Instruction Book.

Reading of initial settings data from the USB
memory device by using an LCD is not possible.

1) The USB memory
device is not set
correctly.

2) The USB memory
device read folder is
different.

3) A USB memory device

Check causes 1) to 3).

Cause 1)

Check that the USB memory device
is properly inserted.

Cause 2)

Check that the folder name for the

(11) that supports the initial settings data is correctly set
AE-200/AE-50 is not as “SetupData_[IP address]” (case-
used. sensitive).

For details, refer to section 8-1
“Settings Data Backup from the
AE-200’s LCD".
Cause 3)
Refer to Cause 3) of problem (10).
Login to the initial settings screen from the LCD 1) This is logged in as Cause 1)
was successful, but the settings button stays the building manager, Input the maintenance user login
pressed, and cannot be operated. so there is no right for name and password, and log in.
(12) settings. In order to log in as the building
manager and configure settings,
have the settings rights changed to
maintenance user.
The license cannot be registered on the License | 1) The license information | « Perform [Collective data
(13) Registration screen of the Initial Setting Tool even of the centralized acquisition] or [Data acquisition]
though the license number has been entered. controller has not been before registering the license.
acquired.
The CSV file that contains license information 1) The CSV file has been * Reissue the CSV file that contains
cannot be imported and collective license edited using programs license information.
registration fails on the License Registration such as Microsoft® * Individually register the licenses by
(14) " . . :
screen of the Initial Setting Tool. Excel. entering the license numbers on
the License Registration screen of
the Initial Setting Tool.
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Problem

Possible cause

Solution

(15)

AE-200/AE-50/EW-50 does not startup after the
update.

The log appears and disappears repeatedly

on the AE-200/AE-50 LCD. The status LED of
EW-50 blinks in blue, blinks in pink, and turns off
repeatedly.

The update has failed.

* Turn off the AC power of
AE-200/AE-50/EW-50, and turn it
back on.

Cause 1)

If the problem persists, AE-200/
AE-50/EW-50 is at fault. Replace
the AE-200/AE-50/EW-50.

(16)

Anti-virus software detects a virus or malware
while the Initial Setting Tool is being used.

1) The anti-virus software
mistakenly identifies the
Initial Setting Tool as a
virus or malware.

Cause 1)

Add the Initial Setting Tool folder
(C:\Program Files\MITSUBISHI
ELECTRIC CORPORATION\
AE-200 Initial Setting Tool) as an
exception in the anti-virus software
so that the folder is excluded from
virus scanning by the software.
For how to add exceptions in anti-
virus software, refer to the manual
of the anti-virus software.

(17)

“Centralized controller network error” appears
under “Notice” on the Integrated Centralized
Control Web.

1) The IP address of the
AE-50/EW-50 that has
been set on the AE-200
is incorrect.

2) The certificate of the
AE-50/EW-50 that is
connected to the AE-200
has not been registered
to the browser.

Cause 1)

Set the correct IP address using
the network setting that can be
accessed from the LCD screen

of the AE-200 or using the Initial
Setting Tool.

For how to set the IP address, refer
to section 4-2-2.

Cause 2)

Register the certificate to the PC,
tablet computer, or smartphone to
be used.

For how to register the certificate,
refer to “1. HTTPS (SSL)
connection” in chapter 5 of
Instruction Book (Integrated
Centralized Control Web) for
AE-200/AE-50/EW-50.

(18)

Loading floor plan files fails.

1) Loading from a USB
memory device using
the LCD screen
(D Format or size of the
floor plan files

@ Factors attributable
to the USB memory
device

2) Loading from the Initial
Setting Tool
(D Format or size of the
floor plan files

Cause 1)

(D Check that the floor plan files
meet the restrictions given in
section 5-1-11 “Floor Layout” in
this manual.

(2 Check that the USB memory
device meets the following
requirements.

* Supports USB 2.0 (Must be
USB 2.0-compatible when using
a USB 3.0)

» Formatted with FAT32 or FAT
(FAT16)

» Without a security function
(locked by a password or
encrypted) that prevents the
data files from being written
to or the function is unused.
When using a USB memory
device with a security function,
its function must be disabled.
(USB memory device with
a fingerprint authentication
function may be used.)

Cause 2)

(D Check that the floor plan files
meet the restrictions given in
section 6-5-1 “Floor settings for
LCD” in this manual.
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Problem

Possible cause

Solution

(19)

The colors of the floor layout shown on the LCD
screen differ from the colors of the floor plan files.

The floor plan files contain
colors that cannot be
displayed on the LCD
screen.

Select colors for the floor plan files
according to the color table shown
in section 5-1-11 “Floor Layout” in

this manual.

(20)

Not accessible to AE-200/AE-50/EW-50 from the
remote-side computer (no response to ping)

The IP address (network
address) of the remote
side and the IP address
(network address) of
LAN2 (for exclusive

use for BACnet®) of
AE-200/AE-50/EW-50 are
the same.

Change the IP address of LAN2 of
AE-200/AE-50/EW-50 with the Initial
Setting Tool. Alternatively, change
the IP address (network address)

of the remote-side. See the notes
under 4-2. [1].
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10.Advance preparation

This section explains preparations for prior to configuring initial settings.

10-1. Preparation of the PC

Prepare a PC with which to use the Initial Setting Tool and Integrated Centralized Control Web.
These preparations are not required when configuring all settings using only the LCD.

Carry out preparations using the following procedure.

Use Initial Setting Tool Not use Initial Setting Tool
In order to use the Initial Setting Tool, connect to the Internet,
| NET Framework installation | and instal! the .NET Framewc?rk.
(See section 10-1-1 “Installation procedures of .NET
Framework”.)
V
| Initial Setting Tool installation | Install Initial Setting Tool.
(See section 10-1-2 “Installation procedures of the Initial
Setting Tool”.)
N4 Vv
| PC’s IP address setting Set the IP address of the PC.
(See section 10-1-3 “Setting the PC’s IP address”.)
Not use Integrated Centralized Use Integrated Centralized
Control Web Control Web
Web browser settings Configure Web browser settings to use the Integrated
Centralized Control Web.
(See section 10-1-4 “Setting the Web Browser”.)
Use Integrated
Centralized Control
Web
A4
Login to the Integrated Centralized \?Vhebck that you can log into the Integrated Centralized Control
Control Web €n. . . .
(See section 4-1 “Logging in to the Integrated Centralized
Control Web”.)
N4
Completed
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10-1-1. Installation procedures of .NET Framework

If NET Framework 4.8 or later is not already installed, download the .NET Framework 4.8 installer from the URL

shown below, and then install it.

If the .NET Framework version is earlier than the required version, the installation process of the Initial Setting Tool
will be canceled and a message will appear indicating that the installation of the .NET Framework is necessary.

https://dotnet.microsoft.com/en-us/download/dotnet-framework/net48
* Other language can also be selected from this website.

10-1-2. Installation procedures of the Initial Setting Tool

(1) Execute the install file for the Initial Setting Tool.

* The install file name is “SetuplSToolA_V***” for AE-200A/AE-50A/EW-50A.
The install file name is “SetuplSToolE_V***” for AE-200E/AE-50E/EW-50E.
(“V***” indicates version number. “V120” indicates Ver. 1.20.)

(2) If the “Security Warning” message appears, click [Run].

(3) When the “Setup Wizard” screen appears, click [Next].

(4) The “License Agreement” screen will appear. Select [| Agree] and
click [Next].

(5) The “Select Installation Folder” screen will appear. Select the save

destination folder and click [Next].
Note: To allow all users who can login the PC to have access to the Initial
Setting Tool, check that the [Everyone] checkbox is selected and
then click [Next].

(6) When the “Confirm Installation” screen appears, click [Next].

WT07627X17 179

48] AE-200 Initial Setting Tool [E=REES)
Welcome to the AE-200 Initial Setting Tool Setup [l
Wizard P=- ) )

The installer will guide you thrauah the steps requited ta install AE 200 Initial Setting Tool on your
computer.

WARNING: This computer program is protected by copyriaht la and intemational teaties.
Unavthorized dupication or cistrbution of this pragram, or anp parfion of . may resul in severe civil
o criminal penalties, and wil be prosecuted to the maxinum extent possible under the law:

) AE-200 Initial Setting Tool =R

License Agreement [N

Please take @ moment ta read the license agreement now. |f you aceept the tems below, elick "1
Agree'!, then "Next". Othernise dlick "Cancel”

SOFTWARE USER LICENSE AGREEMENT

(™

IThese terms and conditions stipulate the conditions of use of the
[MITSUBISHI Air Conditioning Control System - Initial Setting Tool]
(hereinafter referred to as the "Software") provided by Mitsubishi
Electric Corporation (hereinafter referred to as the "Company”) for the _

5 1 Do Not Agies @ I Agies
Cacel | [ cBak | [ Ne> ]
%) AE-200 Initial Setting Tool e =
Select Installation Folder [N
algdy

The installer vl install AE-200 Iilial Setting Tool to the following folder.

Ta installin this folder. clisk “Newt”. To install to 3 different folder, enter it below or click ‘Browse”

Folder

C¥Program Files¥MITSUBISHI ELEGTRIC CORPORATIONEAE-! Browse.

Install AE-200 Initis| Settine Toal for yourse . or for anyone wha uses: this computer

© Evenyone

© Just me

Cacel | [ cBaok | [ We> ]
] AE-200 Initial Setting Tool [E=EE==)|
Confirm Installation .

The installer is ready to install AE-200 Initial S etting Tool on pour computer,

Click "Next" to stat the installation.

Cancel | [ cBack | [ HWews




(7) The Initial Setting Tool will be installed. [ =

Installing AE-200 Initial Setting Tool (=
=)
AE-200 Iniial Selting Tool is being installed.
Please wail
[ ook ) [ wer
1) AE-200 Initial Setting Tool =

(8) Once installation is completed, click [Close].

Installation Complete

o

AE-200 Initial Setting Tool has been successhully installed.

Click "Clase" to exi

Please use Windows Update to check for any critical updates to the NET Framework.

o ) oo ]

Note: An Initial Setting Tool shortcut icon will be created on the desktop.
To launch the software, double-click the icon.
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10-1-3. Setting the PC’s IP address
Set the PC’s IP address so that settings data can be sent from the Initial Setting Tool to the AE-200/AE-50/EW-50.
When setting the PC’s IP address, set a network address in the same system as the IP address for the
AE-200/AE-50/EW-50.
(Example: AE-200 IP address: 192.168.1.1; PC IP address: 192.168.1.101)

[1] For Windows 8.1

(1) Click the [Desktop] icon on the Start screen.

()

@)
(4)
®)
(6)
(7)
(8)
©)

Double-click the [My Computer] icon on the desktop.

Click [Open Control Panel] in the tool bar.

Click the [Network and Sharing Center] icon.

Click [Change adapter settings].

Double-click the [Ethernet] icon.

In the “Ethernet Status” window, click [Properties].

Click [Internet Protocol Version 4 (TCP/IPv4)] to select it, and click [Properties].

In the [Internet Protocol Version 4 (TCP/IPv4) Properties] window, check the radio button next to [Use the
following IP address]

(10) Enter the PC’s IP address (e.g., [192.168.1.101]) in the “IP address” field.

(11) Enter the subnet mask [255.255.255.0] (unless otherwise specified) in the “Subnet mask” field.

(12) In the “Default gateway” field, enter the gateway address as necessary.

Important
e Consult the system administrator to decide the IP, subnet mask, and gateway addresses.

(13) Keep clicking [OK] or [Close] to close all windows.
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[2] For Windows 10 or Windows 11

(1) Search for the control panel using the search box. The Control
Panel will open.

(2) Click the [Network and Sharing Center] icon.

(3) Click [Charge adapter settings].

(4) Double-click the [Ethernet] icon.

(5) In the [Ethernet status] window, click [Properties].

(6) Click [Internet Protocol Version 4 (TCP/IPv4)] to select it, and click
[Properties].
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S Network and Sharing Conter - o x
« T8 Nevodandinter » Nevorkand Sarng Cemer v © »
View your basic network information and set up connections
Control e Homne
Yiewyour
Hetwork Accontyps  Nonstworksccess
Pubic network Connections. § Exharnat

Change your netwerking settings.

40 56100 8 e connecion e natwork

This connection uses the following tems:

/B QoS Packet Scheduler "
[ -& Microsoft Network Adapter Multiplexor Protocol

& Microsoft LLOP Protocol Driver

i Link-Layer Topology Discovery Mapper 1/0 Driver

& Link-Layer Topology Discovery Responder

= Intes Protocol Version g

- PN Intemet Protocol Version 4 (TCP/IPv4) l W
< >
Install... Uningtall Properties

Description
Transmission Control Protocol/Intemet Protocol. The defautt

wide area network protocol that provides communication
across diverse interconnected networks.

OK Cancel

@ Ethernet Status X
General
Connection
IPv4 Connectivity: No network access
IPv6 Connectivity: No network access
Media State: Enabled
Duration: 00:00:00
Speed: 100.0 Mbps
Details...
Activity
Sent —— %! ——  Received
e
Bytes: 0 | 0
E;Propemes G Disable Diagnose
Close
g Ethernet Properties
Netwarking
Connect using:
o
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(7) In the [Internet Protocol Version 4 (TCP/IPv4) Properties] window,
check the radio button next to [Use the following IP address].

(8) Enter the PC’s IP address (e.g., [192.168.1.101]) in the “IP
address” field.

(9) Enter the subnet mask [255.255.255.0] in the “Subnet mask” field.

(10) In the “Default gateway” field, enter the gateway address as

Internet Protocol Version 4 (TCP/IPv4) Properties

General

You can get IP settings assigned automatically if your network supports
this capability. Otherwise, you need to ask your network administrator
for the appropriate IP settings.

(0 Obtain an IP address automatically

@) Use the following IP address:

IP address: 192,168 . 1 . 101

Subnet mask: 255.255.255. 0

Default gateway: . . .
Obtain DNS server address automatically

(@ Use the following DNS server addresses:

necessa ry Preferred DNS server: . . .
Alternate DNS server:
[ validate settings upon exit el
Important

e Consult the system administrator to decide the IP, subnet mask, and gateway addresses.

(11) Keep clicking [OK] or [Close] to close all windows.
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10-1-4. Setting the Web Browser

Web browser setting varies with the Internet connection type. See the sections below for how to make Web browser
settings for different types of Internet connection.

Note: To prevent unauthorized access, always use a security device such as a VPN router when connecting the
AE-200/AE-50/EW-50 to the Internet.

Note: Vulnerability in a network system creates a risk of denial-of-service attack, data breach, or data falsification by malicious
users. The following measures are recommended to protect your network system against cyber-attacks.
- Install anti-virus software on all computers that are accessible to AE-200/AE-50/EW-50.
- Only allow the access from reliable networks and hosts to AE-200/AE-50/EW-50.

[1] No Internet connection

To monitor and operate the air conditioning units from a PC with no Internet connection, follow the instructions
below to set the environment for the Web browser.

(1) Open the Internet Options as follows.
Windows® 8.1
Start screen>[Desktop]>[My computer]>[Control panel]>[Network
and Sharing center]>[Internet Options]
Windows® 10 or 11
Search for the control panel using the search box, and click [Network
and Sharing center]>[Internet Options].

(2) In the [Internet Options] window, click the [Connections] tab. [‘nternet Options =

[ General [ security [ Privacy | Content | Connections | programs | Advanced |

.30 To setup an Internet connection, dick
Setup.

. . . . . Dial-up and Virtual Private Network settings
(3) Check the radio buttqn next to [Never dial a. connection] in the middle T -
of the window, and click [OK] to close the window. m—

Chiooee Settings F youneed to afgure 3 proey
server for a connection.

@ Never dial a connection
© Dial whenever a network connection is not present
© Always dial my default connection

Set default

Local Area Network (LAN) settings

LAN Settings do not apply to dial-up connections. LAN settings
Choose Settings above for dial-up settings.

o ][ conce J[ momv |
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[2] Connecting to the Internet via proxy server using an existing LAN
To monitor and operate the air conditioning units from a PC that connects to the Internet through a proxy server
by connecting to an existing LAN, such as a LAN within your company, follow the instructions below to set the

environment for the Web browser.

(1) Open the Internet Options as follows.
Windows® 8.1
Start screen>[Desktop]>[My computer]>[Control panel]>[Network
and Sharing center]>[Internet Options]
Windows® 10 or 11

Search for the control panel using the search box, and click [Network

and Sharing center]>[Internet Options].

(2) In the [Internet Options] window, click the [Connections] tab.

(38) Check the radio button next to [Never dial a connection] in the middle
of the window.

(4) Click [LAN settings] under [Local Area Network (LAN) settings].

(5) Inthe [Local Area Network (LAN) Settings] window, check [Bypass
proxy server for local addresses], and click [Advanced].

(6) In the [Proxy Settings] window, enter the AE-200/AE-50/EW-50’s
IP address (e.g., 192.168.1.1) in the [Exceptions] field. Then, keep
clicking [OK] or [Close] to close all windows.

If connecting multiple AE-200/AE-50/EW-50 units, enter their

addresses (e.g., [192.168.1.1; 192.168.1.2]). It is also possible to use
an asterisk as a wildcard (e.g., [192.168.1.7]).
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rlntemet Options m
[ General [ security [ Privacy | Content | Connections | programs | Advanced |
.:,0 To set up an Internet connection, click

Setup.

Dial-up and Virtual Private Network settings

&5 Dial-up Connection Add...

Choose Settings if you need to configure a proxy

server for a connection.

@ Never dial a connection
© Dial whenever a network connection is not present
© Always dial my default connection

Set default

Local Area Network (LAN) settings

LAN Settings do not apply to dial-up connections.

Choose Settings above for dial-up settings.

(o J[ conce J[ ooy |

-
Local Area Network (LAN) Settings =

it

Automatic configuration

Automatic configuration may override manual settings. To ensure the
use of manual settings, disable automatic configuration.

[] Automatically detect settings
[] use automatic configuration script
Address

Proxy server

Use a proxy server for your LAN (These settings will not apply to
dial-up or VPN connections).

Address:  192.168.1.254  Port: |8080

Bypass proxy server for local addresses

|
r
Proxy Settings ==
Servers
& Type Proxy address to use Port
SE|
HTTP: 192.168.1.254 i 8080
Secure: 192.168.1.254 : (8080
ETP: 192.168.1.254 . [s080
Socks:

Use the same proxy server for all protocols

Exceptions
W2 Donotuse proxy server for addresses beginning with:
S

[

192.168.1.1

Use semicolons ( ; ) to separate entries.

Lo ) (o )




11.Explanation of terms

This explains terms used in this manual.

* AE-200 system
This indicates one AE-200 connected to 0 to 4 AE-50/EW-50 expansion controllers.
System configurations are as follows.

m AE-200 (independent)

A system that does not use an expansion controller.
Use this configuration when not using the apportioned electricity billing function, with up to 50 units managed,
and controlled from the LCD.

(]

M-NET [Jm_l

i

AE-200

m AE-200

A system that uses 1 to 3 expansion controllers.
Use this configuration when not using the apportioned electricity billing function, with 50 or more units
managed.

LAN M-NET )Eﬂ_

]

|"|_M-NET 'y |
£ m
AE-200

AE-50/EW-50

m AE-200 (No M-NET)

A system that uses 1 to 4 expansion controllers.

Use this configuration when not using the apportioned electricity billing function, with 50 or more units
managed, and with the management room far from the indoor units, with electric power not reaching from the
AE-200 to the indoor units.

LAN

l 1 M-NET

M-NET >< =
] - b
= : m
. m

AE-200 I

,—
man

AE-50/EW-50
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= AE-200 (Billing)

A system that uses 1 to 4 expansion controllers.
Use this configuration when using the apportioned electricity billing function.

- — LAN : M-NET =
. 1
: = il
| M-NET =
| - b S—
= >( i
AE-200 il I

m—_
|

]

m—
|

| ]
—

AE-50/EW-50

* EW-50 system

This indicates a single EW-50 unit.
Use this configuration when not using the apportioned electricity billing function, with up to 50 units managed,
not using the LCD, and controlled from the Integrated Centralized Control Web.

M-NET =

N
]

+ BACnet® Setting Tool
The BACnet® Setting Tool is used for configuring BACnet® functions from a PC.
This allows separate configuration of single AE-200/AE-50/EW-50 units.
For how to use the BACnet® Setting Tool, refer to the Instruction Book (BACnet® Setting Tool).
*BACnet®is a registered trademark of ASHRAE (American Society of Heating, Refrigerating and Air-Conditioning Engineers, INC.).

» Group
Groups are the smallest operational units. The same operation as with local remote controllers.
Control 1 to 16 units together.

* Block (Operation block)
Blocks are multiple groups grouped together.
It is possible to create blocks by partition or room, for batch monitoring and operation.
Control 1 to 50 groups together. However, blocks that cover AE-200/AE-50/EW-50 cannot be configured.

* Energy management block
An energy management block combines multiple operation blocks and OA Processing units (FU).
This is the unit at which AE-50/EW-50 are together managed, and using the apportioned electricity billing function,
at which the electric energy and billing calculation results are displayed and output.
Create energy management blocks by units such as tenant or floor, enabling batch monitoring, control, and
management of electric energy and billing.
Control 1 to 200 operations groups together. However, energy management blocks that cover AE-200/EW-50
systems cannot be configured.
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* Main and Sub system controllers

Each group can be controlled by a Main system controller or a Sub system controller.
AE-200/AE-50 is exclusively for use as a Main system controller and cannot be used as a Sub system controller.

Main system controller
Main system controller refers to a system controller that controls all other system controllers including the units

they control. If a given system has only one system controller, that controller becomes a Main system controller.
Group settings and interlock settings can be made only from a Main system controller.

Sub system controller
Sub system controller refers to a system controller that is controlled by a Main system controller.

Main system controller's
(AE-200/AE-50's) control range

Sub system controller's
control range

Group | | Group |

The system cannot be configured as shown in the examples below.

e Groups that are not under the control of a Main system controller cannot be controlled from a Sub system controller.

Main system
controller

Sub system
controller

e Each group cannot be placed under the control of two or more Main system controllers.

Main system
controller 1

Main system
controller 2

e Sub system controllers cannot be placed under the control of two or more Main system controllers.

Main system Sub system Main system

controller 1 controller controller 2
* License

A license may be required for AE-200/AE-50/EW-50 depending on the functions used.

Licenses required will differ depending on the functions used. Please contact your dealer as regards license types
and purchasing.

Refer to section 4-5 “License registration for optional functions” for license registration method.
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Error code list

Error codes that can be detected with AE-200/AE-50 (EW-50) and their definitions are shown below.
Refer to [3] “Errors on other related equipment” for errors on DIDO controller or AHC.

For other error codes, refer to the manual of the equipment of the error source address.

If an error occurs, note the error code and consult your dealer.

[1] M-NET errors

6600  Communication error - Address duplicate

6601 Communication error - Polarity unsettled

6602  Communication error - Transmission processor hardware error

6603  Communication error - Transmission line busy

6604  Communication error - No ACK (06H) (communication circuit error)
6605  Communication error - No response frame

6606  Communication error - Transmission processor communication error
6607  Communication error - No ACK return

6608  Communication error - No return of response frame

[2] AE-200 and AE-50 (EW-50) errors

0092  Version combination error

0093  System configuration change warning

0094  “Charge” license not registered

0095  Warning - possibility of damaged metering device

0096  Air conditioning charges file automatic output abnormality
0097  Apportioned calculation data collection error

6920  Communication error - No response error

6922  Communication error - Receiving frame ID error

7106  System abnormality - Attribute setting error

7109  System abnormality - Connection setting error

7130  System abnormality - Different unit model error

7901  System abnormality - Excessive number of connected units
7902  System abnormality - Connection lock error

7903  System abnormality - Unit information error

7904  System abnormality - System setting error

7905  System abnormality - Version error/Different unit model error

[3] Errors on other related equipment

0100  Equipment abnormality
01*0 Equipment abnormality (PAC-YG66DCA) in system *
01** Equipment abnormality in system **

(When these errors occur on the DIDO controller (PAC-YG66DCA), the error code will not appear, but the error status display
LED on the DIDO controller of the system in error will light up.)
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Appendix 1: Air-conditioner ON/OFF trial run

After the centralized controllers are installed, a check sheet can be output to be used for air-conditioner ON/OFF
trial runs.
Click [Option] > [Output - Check sheet for air-conditioner ON/OFF trial run] in the tool bar of the Initial Setting Tool to
output the check sheet for each AE-200 system.

Note: When the PC with Initial Setting Tool installed and the centralized controller are connected via a LAN, the license registration
status can be output in the check sheet.

[1] Centralized controller
Output this check sheet for each AE-200 system.

Check sheet for air-conditioner ON/OFF trial run | Site name | Output date: 2016/04/04 13:58 Da
Initial Sefting (1 ) (2)
Tool SIW Ver
120
~
Centralized Centralized
IP address Name unitiD SERIAL No. S/W Ver Charge TenantPersonal Web Maintenance Tool
controller No. controller
Status Period Status Period Status Period
1 AE-200 192.168.11 AE-200 000001 00000-001 740 Not available o Available Unlimited Not available 0
Expansion
11 ontroller 192.168.1.211 AE-50-1 000002 00000-002 740 Not available o Available Unlimited Not available 0
Expansion
1-2 ontroller 192.168.1.212 AE-50-2 000003 00000-003 7.40 Not available o Available Unlimited Not available 0
Expansion i
1-3 controller 192.168.1.213 AE-50-3 000004 00000-004 740 Not available 0 Available Unlimited Not available o
[ Date oftrial run | ] _Person in charge Operated by Approved by
Optional function usage stafus
Maintenance Tool Advanced PLC for General Equipments Energy Management License Pack Interlock control Super User Outdoor Unit Status Monitor BACnet connection Inte
Slatus Period Slatus Period Status. Period Status. Period Status Period Stalus. Period Status Period
Not available 0 Not available 0 Not available 0 Not available 0 Not available 0 Not available 0 Not available 0
Not available 0 Not available 0 Notavailable 0 Not available 0 Not available 0 Not available 0 Not available 0
Not available 0 Not available 0 Notavailable 0 Not available 0 Not available 0 Not available 0 Not available 0
Not available 0 Not available 0 Not available 0 Not available o Not available 0 Not available o Not available 0

)

Integrated Centralized Control Web

| staws Period
Available Unlimited
Available Unlimited
Available Unlimited
Available Unlimited

(1) Checking the connection configuration

Check for proper IP addresses and software versions.

(2) Checking the license

Check that all required licenses are registered.

Note: To check the license registration status, output the check sheet when the PC with Initial Setting Tool installed and the
centralized controller are connected via a LAN.
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[2] Unit - Controller
Output this check sheet for each AE-200/AE-50/EW-50.

Check sheet for air-conditioner ON/OFF trial run I Site name: I Output date: 2016/04/04 1358
Floor information Unitinformation Group information
Centralized Outdoor unit Remote controller| _ Interlocked
Floor No. Floor name contoler N, aderess Outdoor unit model name | Indoor unit address|  Indoor unit model name unittype address LOSSNAY address No, Name
1 Floorl 11 51 PUHY-P250YKB-AT 1 PLFY-P1SVFM-E Air-conditioner 101 1 TenantA
1 Floor1 1-1 51 PUHY-P250YKB-A1 2 PLFY-P16VFM-E Air-conditioner 102 2 TenantB
2 Floor2 1-1 52 PUHY-P250YKB-A1 3 PLFY-P18VFM-E Air-conditioner 103 3 TenantC
2 Floor2 1-1 52 PUHY-P250YKB-A1 4 PLFY-P18VFM-E Air-conditioner 104 4 TenantD
2 Floor2 1-1 52 PUHY-P250YKB-A1 5 PLFY-P1SVFM-E Air-conditioner 105 5 TenantE
1 Floor1 1-1 6 LGH-50RVX-E LOSSNAY 106 6 Communal area
.
[ Date oftrial run [Person in charge] |

:

.

:

:

A\Y4
Energy management block Centralized controller > Air- Local remote controller >
Block information
information conditioner operation check | [Centralized controller display chect
Error display Error display
N N; N N Individual Individual
0. ame 0. ame ndividual group check ndividual group check
1 Tenant ARG 1 Tenant ABG
1 Tenant ABC 1 Tenant ABC
1 Tenant ABC 1 Tenant ABC
2 Tenant DE 2 Tenant DE
2 Tenant DE 2 Tenant DE
e

(1) Checking the group configuration

Check for proper group registration and unit information of the unit.

(2) Checking the block configuration

Check for proper block configuration of the unit.

(3) Checking the energy management block (EM block) configuration

Check for proper energy management block (EM block) configuration of the unit.

(4) Checking the floor configuration

Check for proper floor configuration of the unit.

(5) Checking the operation between centralized controllers and air conditioning units

Check the operation status of centralized controllers and air conditioning units by turning on/off the units or

generating an error, and check for proper settings and connections.

(6) Checking the operation between centralized controllers and local remote controllers

Check the display of centralized controllers and local remote controllers by turning on/off the units or generating

an error, and check for proper settings and connections.
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[3] General Equipment
Output this check sheet for each AE-200 system.

Check sheet for air-conditioner ONJOFF trial run | Site name Output date: 2016/04/04 13:58
Floor information Unit information Function settings Group information Block information En
Centralized
Floor No. Floor name entralize Address Ch. Allow Operations Monitor No. MName No. Name

controller No.

No operations
1 Floor1 11 41 1 Output stat 41 Ki dlock 1
~ (Monitor only) utput status eycard loc

No operations
2 Floor2 11 41 2 P QOutput status 42 Keycard lock 2
(Monitor only)

y
e

[ ate ortriat run | [ Person in charge | ]

©) ®)

. .

Energy block Check item
Operation display | Ermor display
check check

No. Name

(1) Checking the group configuration
Check for proper group registration and unit information for the general equipment contact.
(2) Checking the block configuration
Check for proper block configuration for the general equipment contact.
(3) Checking the energy management block (EM block) configuration
Check for proper energy management block (EM block) configuration for the general equipment contact.
(4) Checking the floor configuration
Check for proper floor configuration for the general equipment contact.
(5) Checking the operation between centralized controllers and air conditioning units

Check the operation status of centralized controllers and general equipment by turning on/off the general
equipment contact or generating an error, and check for proper settings and connections.
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[4] PI Controller
Output this check sheet for each AE-200 system.

Person in charge. ]

Check sheet for air-conditioner ONJOFF trial run Sile name | Output date: 2016/04/04 1358 Dale of tial run
Unit information Measurement Check ftem
Centralized Measurement
controler No Addrese ch, Name Unittype Pulse weight unit | ) Ceiay check
-1 48 1 WHM OU Outdoor unit 1 KD
=l 49 2 WHM U indoor unit 1 [0
\

(1) Checking the metering device
Check for proper type and settings for the metering device.

(2) Checking the operation of the metering device

Check for proper settings and connections between the centralized controllers and metering device by letting the

metering device count up.

[5] Al Controller
Output this check sheet for each AE-200 system.

Person in charge

Check sheet for air-conditioner ONIOFF trial run | Stz name. Output date: 2016104104 1358 [eeomamn
Unitinformation Alertseftings Y Checkitem A
Upper limit | Upper limit | Lower limit | Lower limit
Centralized Measurement | Measurement Measurement | Alertdisplay
comrotlrh | aeress o name | sersortpe | ot | avceapperimy | Ot | O | e | on | o |G| AR
o e up threshold) | thresnoid) | threshola) | threshoipf| "
1-1 50 1 Outdoor temp. Temperature -100.0 100.0 00
sensor
1 50 2 Outdoor humid. | Humidity sensor 00 1000 0o
|-

(1) Checking the sensors
Check for proper type and settings for the sensors.

(2) Checking the operation of the sensors

Check for proper settings and connections between the centralized controllers and sensors by operating the

Sensors.
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Appendix 2: Added functions

Version Menu item Added function Reference
. Sets the Peak Cut settings. “
LCD Peak Cutsettings | 500 is selectable for outdoor unit 5-2-1"Peak Cut (.E”eigy'
1 . save control function)
Ver. 7.2 capacity save amount.
Web Browser for Peak Cut settings | 50% is selectable for outdoor unit _
Initial Settings 1 capacity save amount.
Displays the detection of communication
Network settings | error on expansion controllers AE-50/ 5-1-5 “Network”
EW-50.
Energy Units under the control of AE-200, AE-50,
management and EW-50 can be placed in the same 5-1-10 “EM Blocks”
LCD block block.
Sets the display or non-display of
Ver. 7.3 Floor Layout gridlines and the distance of icon 5-1-11 “Floor Layout”
movement.
Ven.tllatlon Sets Night purge on OA processing units. | 5-4 “Ventilation setting”
settings
Initial Setting Tool . Sets the floor layout for AE-200/AE-50 p N
(Ver. 1.1) Floor settings and Integrated Centralized Control Web. 6-5 "Floor Settings
Web Browser for Ventilation . . .
Initial Settings seftings Sets Night purge on OA processing units. | —
. I Sets the display/non-display of room
LCD Alr. conqltlonlng temperature and set temperature on the | 5-1-4 “Unit Information”
unit settings .
[Floor] window.
Sets the display/non-display of room
Display settings temperature and set temperature on the | 6-3-2 “Basic System settings”
[Floor] window.
o . Copies the group settings to the block
Ver. 7.4 Initial Setting Tool Block settings settings when setting them to the same 6-4-4 “Block settings”
(Ver. 1.2) .
settings.
Energy Copies the block settlngs to the energy 6-4-5 “Energy management
management management block settings when setting o
. . block settings
block settings them to the same settings.
Web Browser for . _ Sets the display/non-display of room
o : Display settings temperature and set temperature on the | —
Initial Settings .
[Floor] window.
Group settings Sets the chiller units to groups. 5-1-6 “Groups”
HW Supply Sets the HWHP (QAHV) units to groups. | 5-1-7 “HW Supply”
LCD settings
. I Enables the display of both the room
Air conditioning o Ini P—
. . temperature and the set temperature on | 5-1-4 “Unit Information
unit settings .
the [Floor] window.
Enables the display of both the room
Display settings temperature and the set temperature on | 6-3-2 “Basic System settings”
- . the [Floor] window.
Ver. 7.5 132?18;;“”9 Tool Group settings Sets the chiller units to groups. 6-4-1 “Group settings”
Interlock Control Sets the Interlocking Control settings
. . for units under the control of different 6-7 “Interlock Control”
settings "2 .
expansion controllers.
Group settings Sets the chiller units to groups. -
Enables the display of both the room
Web Browser for Display settings temperature and the set temperature on | —
Initial Settings the [Floor] window.
Inter Iock*Control The setting function was deleted. -
settings "2
HW Supply HWHP (QAHV) units can be registered ey ”
Ver. 7.6 LCD settings to the AE-50 and EW-50. 5-1-7 "HW Supply
er. 7.
Initial Setting Tool | License Licenses can be registered from the 4-5 “License registration for
(Ver. 1.4) registration Initial Setting Tool. optional functions”
WT07627X17

195




Version Menu item Added function Reference
Ver. 7.68 | LCD Group settings Sets the MEHT-CH&HP unit to groups. 5-1-6 “Groups”
LCD Group settings Se.ts the outlet air temperature control 5-1-6 *Groups”
unit to groups.
Web Browser for . Sets the outlet air temperature control
o : Group settings : -
Initial Settings unit to groups.
IP Address Sets the IP address of AE-200/AE-50/ P N
seftings EW_50. 6-3-2 “Basic System settings
Group settings Se.ts the outlet air temperature control 6-4-1 *Group settings’
unit to groups.
. . Interlock Control Sets th? interlock control settlng§ for the 6-7 “Interlock Control”
Initial Setting Tool outlet air temperature control units.
(Ver. 1.6)
Energy . 6-8-1 “Energy Management
Management Sets the energy management settings. S,
) Settings
Settings
System-
changeover Sets the System-changeover settings. 6-8-2 “System-changeover”
Settings
Set to use the error notification e-mail
E-Mail function or the e-mail communication 7-1-1 “E-Mail”
Ver. 7.7 function.
Peak Cut Set the control contents for each Peak 7-1-2 “Peak Cut (Energy-
Cut method or demand level. save control function)”
Set Temperature Set to ;lmlththT setltable temperatlljlre 7-1-3 “Set Temperature
Range Limit range for the local remote controllers or Range Limit’
the Web Browser for User.
Night Mode Set to operate the outdoor units in a quiet | 7-1-5 “Night Mode (quiet
Integrated Schedule mode for the specified time period. operation) Schedule”
Centralized Control External Set to automatically adjust the set
Web temperature based on the temperature 7-1-4 “External Temperature
Temperature . »
difference between the set temperature Interlock
Interlock
and the outdoor temperature.
Set to perform cooling or heating
Night Setback operation automatlcally when the room 7-1-6 *Night Setback Control’
Control temperature goes outside of the specific
range during the night.
Set to draw cooler outside air into the
Night purge room to suppress temperature rises at 7-2-1 “Night purge”
night.
LCD Chiller units (EAHV-P1500/1800YB(-H) | 5-1-6 “Groups”
Ver. 7.8 — : Group settings (-N)(-BS) and EACV-P1500/1800YB(-N)
Initial Setting Tool (-BS)) can be connected. 6-4-1 “Group settings”
(Ver. 1.7)
Initial Setting Tool | Refrigerant . . 6-4-2 “Refrigerant System
Ver. 7.85 (Ver. 1.8) System settings Pump units can be registered. settings’
Initial Setting Tool | Al controller Set the e-mail alarm function for upper “ N
Ver. 7.90 (Ver. 1.9) settings and lower limit temperatures/humidities. 6-4-7 "Al controller settings
Integrated .
Ver. 7.93 | Centralized Control | E-Mail [SSL/TLS] was added to the e-mail 7-1-1 “E-Mail’
encryption method.
Web
[Send to
a selected
Initial Setting Tool | controller.] ([Send | It is possible to send only the changed 6-2-3 “List of tool bar
Ver. 7.96 ) . . . "
(Ver. 2.0) all settings], settings to the centralized controller. operations
[Only send the
changes])
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Version Menu item Added function Reference
Displays the model name, serial number,
and software version on the login window
Integrated Integrated of the Integrated Centralized Control 4-1 “Logging in to the
. Centralized Web .
Centralized Control . e Integrated Centralized
Web Control Web login — - Control Web”
e window The default building manager login ontrol Vve
password for AE-200A/EW-50A can be
changed here.
Ver. 7.98 The default maint ;
Login window on ¢ detault maintenance user 5-1-1 “Logging in to the Initial
LCD the LCD building manager login passwords for Settinas menu”
AE-200A/AE-50A can be changed here. 9

Windows® 11 compatible

A computer with Windows® 11 is
compatible for use.

3-3 “PC requirements”

.NET Framework 4.8 compatible

Supports the use of .NET Framework 4.8

3-3 “PC requirements”

*1 “Saving Energy Control (Peak Cut)” license is required to use the function.

*2 “Interlock control” license is required to use the function.
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This product is designed and intended for use in the residential,
commercial and light-industrial environment.

The product at hand is based on the following EU regulations:
* Low Voltage Directive 2014/35/EU
* Electromagnetic Compatibility Directive 2014/30/EU

Please be sure to put the contact address/telephone number
on this manual before handing it to the customer.

MITSUBISHI ELECTRIC CORPORATION

HEAD OFFICE: TOKYO BLDG., 2-7-3, MARUNOUCH]I, CHIYODA-KU, TOKYO 100-8310, JAPAN
MANUFACTURER: MITSUBISHI ELECTRIC CORPORATION Air-conditioning & Refrigeration Systems Works
5-66, Tebira 6 Chome, Wakayama-city, 640-8686, Japan WT07627X17
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